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Unleash your imagination with the power of the Raspberry Pi… 

The Raspberry Pi is a remarkable little computer. You’ll find that the Raspberry Pi is a
superb, and cheap, desktop computer, retro gaming system, media centre, and even a TV
set-top box. All these projects use the Pi and code. With code, you can create amazing
things and have your Pi do what you want it to do. We’ve got a section on coding with
Python that will take you from the core foundations through to advanced concepts and
code. There’s also a section on learning Linux, the operating system of the Raspberry Pi.
By learning how Linux works, you’ll be able to take command of the Pi and expand your
project ideas.

There’s something for everyone in this book. From beginners to more experienced Pi
users. We’ve got projects, code, guides and tutorials that will help you unlock the full
power of your Raspberry Pi.

GuideBook

The Complete 

RaspberryPi
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New to Pi? Where to Buy?

https://thepihut.com/collections/raspberry-pi https://cpc.farnell.com/c/maker-circuit-development/single-board-

https://www.okdo.com/product-category/raspberry-pi/ https://shop.pimoroni.com/products/raspberry-pi-4?src=raspberrypi

New to Pi? Where to Buy?
If you’re starting out with the Raspberry Pi, it helps to know where to get hold of one. There 
are four main Raspberry Pi approved resellers throughout Europe, and hundreds more 
internationally. Let’s look at the top four Pi sellers. 

THE PI HUT
Open a browser and navigate to https://

thepihut.com/collections/raspberry-pi. The Pi 

Hut is one of the most popular online shops for all things Raspberry 

Pi, including the Pi itself, cases, HATs, kits and bundles, cables, 

addons and much more. Prices vary depending on what you’re 

looking for, but they’re some of the best around. 

CPC On its release in 2012 CPC Farnell was one of the original 

resellers of the Raspberry Pi. Therefore, not only does CPC 

stock a huge amount of Pi-related goodies, but it’s also one of the 

premier global online electronics stores. Browse the Pi section at: 

https://cpc.farnell.com/c/maker-circuit-development/single-board-

computers-microcontrollers/raspberry-pi.

OKDO With its huge range of Raspberry Pi products, including 

all manner of maker accessories, kits, parts and 

addons, OKdo is one of the top go-to stores for all the tinkerers 

out there. You’ll find the Pi section of the shop at https://www.

okdo.com/product-category/raspberry-pi/, so hunt around and 

see what’s available.  

PIMORONI Founded in 2012, and the makers of the excellent 

Pibow case for the original Raspberry Pi, 

Pimoroni is a superb resource for tinkerers, makers and Pi fans 

everywhere. Found at https://shop.pimoroni.com/products/

raspberry-pi-4?src=raspberrypi, Pimoroni stocks everything you’ll 

need for your Pi, among other great technologies.

Naturally, you don’t have to go through any of these recommended stores. Look around the Internet and you’ll find plenty of other 
places to get hold of a Pi. Both Amazon and eBay are firm favourites for international customers. 

MORE PI
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A Slice of 
Raspberry Pi
Do you already own a Raspberry Pi 

but don’t know what to do with it, or 

are you on the verge of purchasing 

your first Pi? This section of the book 
will help you build the foundations 

required to get the most from this 

amazing, tiny computer. 

7www.bdmpublications.com 7www.bdmpublications.com

A Slice of Raspberry Pi INDEX
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Let’s take a look at the best-selling British computer ever: the Raspberry Pi! This bare-

bones machine just looks like any other piece of circuitry, until you realise it’s a full-

blown credit-card sized computer ideal for learning programming and home hacking.

Say Hello to 
Raspberry Pi
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A Slice of Raspberry Pi

Raspberry Pi 3 Model B+

The Raspberry Pi 3 Model B+ was launched on 14 March - 
International Pi day 2018. This is an improved version with a faster 
1.4GHz, 64-bit quad-core ARM Coretx-A53 processor, a dual-band 
802.11ac wireless LAN and Bluetooth 4.2 controller, faster Gigabit 
Ethernet, improved mass storage, USB booting, improved thermal 
management and Power-Over-Ethernet support. All other aspects 
of the new Raspberry Pi are the same as the previous Pi 3 and as 
such, all the previous content you come across is compatible. if 
you’re new to the wonderful world of the Raspberry Pi, this is the 
board we recommend you buy.    

Raspberry Pi 2 Model B

Raspberry Pi 1 Model B+

The older Raspberry Pi 2 model can still be found on sale. It has the 
same form factor as the Raspberry Pi 3 with 4 USB Ports, Ethernet 
connection and Micro USB. 

It may look the same but it has a slower 900 MHZ quad-core ARM 
Cortex-A7 CPU and 1GB RAM. This brings it close in line to many 
low-end desktop computers.

Complicating matters slightly is the existence of a Raspberry Pi Model 
1 B+, which is identical in layout to the Raspberry Pi Model 2 but with 
an even slower ARMv6 700MHz processor. If you are confused which 
type you own then type cat /proc/cpuinfo at the command line. If it 
lists four ARMv7 processors you are using a Raspberry Pi 2, if you see 
just one with ARMv6 then you have the older Raspberry Pi Model 1 B+.
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The Raspberry Pi is a British built low 
cost computer that enables everybody to 
learn computing, start programming and 
explore basic electronics. It’s the size of 
a credit card but capable of running a full 
operating system and doing everything a 
desktop does.

More importantly, with the Raspberry Pi 
you install your own operating system, 
connect all your devices and create your 
own programs using languages like Scratch 
and Python. There’s no case so you can hook 
up electronic circuits to the pins and control 
them to get input and output, so you can 
hack together electronic projects at home.

Setting up a Raspberry Pi is pretty simple, 
and throughout this book we’ll take you 
step-by-step from unboxing your Raspberry 
Pi to setting it up and getting started. 

There are many different models of 
Raspberry Pi available and each has slightly 
different features (see opposite).

The fundamentals of each Raspberry Pi are 

similar though. Each model is a lightweight 
computer on a single board that’s roughly 
the size of a credit card. Each Raspberry Pi 
board features a processor made by ARM, 
which is similar to the models you find in a 
mobile phone. The ARM processor is fast 
and lightweight but it runs a different set of 
software than you might be used to. There 
are many different operating systems (OS) 
available, but for most of this book we’ll 
focus on one called Raspbian JESSIE with 
PIXEL, which is the OS recommended by the 
Raspberry Pi Foundation. 

There’s no hard drive on the Raspberry Pi, 
instead the operating system is installed 
on an SD Card (the cards typically used in 
cameras). The operating system is installed 
onto the SD Card by copying the files to the 
SD Card using a computer. We’ll show you 
how to set up Raspbian JESSIE with PIXEL 
(and other OS’s) using a Mac, Windows or 
Linux computer.

Once you have an OS installed on the SD 
Card you can set up your Raspberry Pi. The 

Raspberry Pi is connected to a monitor via a 
HDMI socket whilst a keyboard and mouse 
is attached to the USB socket. A smaller 
Micro USB connection is used to provide 
power to the device. Most Raspberry Pi 
models feature an Ethernet connection, 
and an Ethernet cable is connected from 
your Raspberry Pi to a socket on your 
modem router. 

The Raspberry Pi 3 has built in wireless 
networking and Bluetooth, making it easy 
to get online. You can attach a USB Wi-Fi 
dongle or Ethernet adaptor to older models.

First it will help to know which Raspberry 
Pi you are using. This can be tricky as there 
have been several distinct models so far. The 
layouts opposite will help you determine 
which Raspberry Pi you have.

This book covers all the different models, 
and they offer largely similar features, 
although newer models offer additional 
extras. Once you know which Raspberry Pi 
you own, you can get it up and running.

Raspberry Pi Zero

The new Raspberry Pi Zero is a super small, super cheap computer 
that costs just £4. It’s half the size of the model A+ but has a 
surprising amount of power, including a 1Ghz single-core CPU and 
512MB RAM. It has the full 40-pin GPIO header but you’ll need to 
buy the pins separately and solder them in. It uses the same 
Micro-SD card as the other Raspberry Pi devices, so you can swap 
SD cards between them. Last but not least, it draws an incredibly 
low amount of power (Micro USB) making it ideal for small power 
devices. The ports are smaller than you’d find on the larger 
Raspberry Pi though, so you’ll need a mini-HDMI adaptor as well as 
a micro-USB adaptor to connect devices. A four-port USB Hub and 
Ethernet adaptor will come in handy too.

Raspberry Pi 4 Model B

Released on June 24th 2019, the Raspberry Pi 4 Model B 
introduced a new direction in the layout and hardware 
specification of the Pi. The Pi 4 Model B now comes in three 
different memory size versions: 1GB, 2Gb, and 4GB. Obviously, the 
4GB version is the most powerful of the three, and the Pi with the 
highest amount of on-board memory. Subsequently, it was sold 
out on the day of release and as such, has taken some time to get 
into the hand of the mainstream Pi users.

There’s also an improved CPU, dual-monitor support in the form of 
a pair of micro-HDMI ports, and improved connectivity. Overall, it’s 
certainly a more capable Pi.

Say Hello to Raspberry Pi
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A Slice of Raspberry Pi

While the Raspberry Pi 4 is the newest model, the Pi 3 models are the most popular among 

the community. They’re cheaper, more compatible with current hardware and software, and 

still pack a significant performance punch. Here’s what powers the fantastic Pi 3.

USB Power

A standard Micro USB power supply is 

used to provide power to the Raspberry 

Pi. You don’t get a power supply but can 

use any 5V 2000mA Micro USB power 

supply and compatible cable, or buy an 

official power supply separately.

ARM-Powered

At the heart of the Raspberry Pi 3 is a 

Broadcom BCM2837 System on Chip 

(SoC). It contains a powerful 1.2GHz 
64-bit quad-core ARM Cortex-A53 

CPU. This is 50-60 percent faster than 

the Raspberry Pi 2 and ten times as 

fast as the original Raspberry Pi.

40 GPIO Pins  

The GPIO (General Purpose Input Output) pins can be 
accessed directly on the Raspberry Pi. These are used 

in projects to connect the Raspberry Pi to electronic 

circuits and control electric devices. Some can be 

turned on and off while the Raspberry Pi is running.

DSI

The Display Interface (DSI) can be used to connect a 

display directly to the Raspberry Pi board.

SD Card Slot

Instead of a hard drive you use 

an SD Card with the Raspberry 

Pi. The Raspberry Pi 3 (pictured 
here) uses a Micro SD Card. 
Some older Raspberry Pi models 

use a regular SD Card.

Get to Know the 
Raspberry Pi
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USB ports

The Raspberry Pi USB Ports to connect 

standard computing accessories such 

as a keyboard, mouse and webcam. 

Raspberry Pi 2 and 3 boards contain 

four USB ports but you might need 

a USB Hub to get more ports on the 

Raspberry Pi A+ and Pi Zero.

Ethernet and Wi-Fi

Connect the Raspberry 

Pi 3 to a network or 

home modem router 

using an Ethernet cable 

and this connection. The 

Raspberry Pi 3 has built in 

wireless networking, but 

you must add a USB Wi-Fi 

adaptor to older models.

3.5mm Audio/Video jack

This 3.5mm audio jack is 

normally used to attach 

headphones or speakers. On 

the Raspberry Pi 2 and 3 it also 

carries composite video using a 

compatible cable.

 CSI (Camera Serial Interface)

You can attach the official Raspberry 

Pi Camera Module directly to the 

motherboard via this CSI connection.

HDMI

The HDMI connection enables you 

to hook up the Raspberry Pi to most 

modern monitors and digital televisions. 

It carries both video and audio.

Get to Know the Raspberry Pi
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A Slice of Raspberry Pi

Up Close with the 
Raspberry Pi 4 Model B
Released at the end of June 2019, the Raspberry Pi 4 Model B is a significant improvement 
in terms of hardware. Labelled the ‘Ultimate’ Raspberry Pi, this new generation offers true 
desktop computing power. 

FASTER AND CONNECTED

There’s a lot to like about the Raspberry Pi 4: Up to 4GB of on-board memory, a faster quad-core CPU, support for dual 4K displays 
via a pair of micro-HDMI ports, and more. Let’s take a look at the Pi 4 and see what its got under-the-hood.

Since the Raspberry Pi 4 now offers three different 
versions within the new model, it stands to reason that the 
pricing for it has changed slightly. The 1GB memory version 
of the Pi 4 is priced at around £34, depending on where 
you shop. The 2GB memory version is on sale for around 
£44, while the top-end, 4GB memory version will set you 
back in the region of £54. Together with the cost of the Pi 
itself, you will also need to factor in one or two micro-HDMI 
cables (depending on whether you want to connect one or 
two monitors), each costing roughly £5-plus.

PRICING

Dual Display  

In a shock move the team behind the Pi 4 decided 

to include a pair of micro-HDMI ports. This means 

you’re able to connect two monitors for dual-

screen displays.

Improved Processing 

The 1.5GHz, 64-bit quad-core ARM Cortex-A72 

CPU, is the driving force behind the Pi 4’s improved 

performance. Thanks to this CPU, you’re able to 

enjoy faster apps and content.

Improved GPU 

With a VideoCore 6 GPU, the Pi 4 is capable of 

4K resolutions at 60FPS (Frames per Second), 
and thanks to some tweaks to the video codes in 

both Raspbian and the version of VLC packaged 

with Raspbian, the Pi 4 is now a pretty decent 

media device.

b0317180-1dbc-4fe7-b445-0fab5a6a6c7ab0317180-1dbc-4fe7-b445-0fab5a6a6c7a
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Up Close with the Raspberry Pi 4 Model B

• 1.5GHz 64-bit quad-core ARM 
Cortex-A72 CPU (ARM v8, BCM2837)

• 1GB, 2GB or 4GB RAM (LPDDR4)

• On-board wireless LAN - dual-band 
802.11 b/g/n/ac

• On-board Bluetooth 5.0, low-energy 
(BLE)

• 2x USB 3.0 ports, 2x USB 2.0 ports

• Gigabit ethernet

• Power-over-Ethernet  (requires the 
Raspberry Pi POE HAT)

• 40-pin GPIO header

• 2× micro-HDMI ports 

(up to 4Kp60 supported)

• H.265 (4Kp60 decode)

• H.264 (1080p60 decode, 
1080p30 encode)

• OpenGL ES, 3.0 graphics

• DSI display port, CSI camera port

• Combined 3.5mm analogue audio 

and composite video jack

• Micro-SD card slot

• USB-C power

PI 4 SPEC SHEET

Connectivity  

Now with Bluetooth 5.0, 

alongside 802.11 b/g/n/

ac wireless, and a gigabit 

Ethernet port, the Pi 4 is 

certainly well connected.

USB 3.0  

The inclusion of a couple 

of USB 3.0 ports is an 

excellent choice. The 

faster data bandwidth of 

USB 3.0 will, for example, 

enable the Pi to read and 

write that data, both to 

and from an external 

drive, far quicker than 

ever before.

Memory  

The RPi4 now comes 

with a choice of 

memory: 1GB, 2GB, 

or a 4GB model. The 

more memory means 

you’re able to have 

more applications open, 

without degrading the 

overall performance of 

the Pi.
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A Slice of Raspberry Pi

Raspbian: The Complete 
Operating System
The main Raspberry Pi operating system is Raspbian, which is a Linux-based OS. While 
the Pi is primarily an educational and project board, with Raspbian, it does become a fully-
functional desktop computer.  

POWERING THE PI

The Raspbian OS has been powering the Raspberry Pi since its release 
back in 2013. At its core, Raspbian is a Linux operating system, based on 
the hugely popular Debian flavour of Linux.

Mike Thompson and Peter Green created Raspbian in 2012, to work on 
the low-performance ARM CPUs found in the early Pi models. Toward 
the end of 2014, Raspbian was further improved to work on the then 
new model Pi, the Raspberry Pi 2; utilising the 3.18 Linux kernel while 
still having Debian 7 (codenamed Wheezy) as the base.

Mid-way through 2015, Raspbian started using Debian 
8 (Jessie) as the base, with kernels 4.1, 4.4, and 4.9. 
Kernel 4.9 was also used from 2017’s Raspbian 
release, which has since used Debian 9 
(Stretch) as the foundation distribution.

More recently, from November 2018, 
the Raspberry Pi Foundation has split 
the Raspbian OS project into three 
separate distributions. Although these 
are essentially the same core operating 
system, those available now are a Lite, 
Minimal and Full desktop set of images.

One of the primary reasons for the three-
way split is due to the overall size of the 
continually improving Raspbian. In its early 
years, the Raspbian desktop image size 
was a little under 1GB. This image contained 
everything the Pi user of the time needed to get 
their projects up and running, as well as enjoying 
third-party applications such as LibreOffice. Slowly, 
as the Pi itself evolved, the Raspbian image increased. These 
days the image weighs in at around 1.8GB and it’s likely to continue 
to expand over the coming years as new software is improved on and 
added, alongside changing hardware. However, the three-way split 
addresses the issue of an ever-expanding OS image, while still enabling 
the user to get the most from their Raspberry Pi.    

The Lite version image comes in at roughly 350MB in size. While 
it may seem like a logical choice to opt for the Lite version, it’s not 
recommended for every user. The Lite version basically installs without 
any of the software you expect from the previous versions of Raspbian; 
it doesn’t even come with the graphical desktop. This makes it an 
incredibly streamlined and efficient version of the OS that’s ideal for 
those who run headless Pi servers (a Pi without a monitor, keyboard or 
mouse attached, that the user remotely connects to in order to input 

commands). You will need to know your Linux commands in order to 
get the most from the Lite version, so for most beginners it’s not a 
good place to start. The more advanced users will, however, be able 
to setup their Pi projects without the unnecessary baggage of all the 
other applications clogging up the Pi’s precious system resources. It’s 
worth noting that the Lite edition can be made up to a fully functional 
desktop version by installing all the relevant software manually.

The Minimal edition is now the default version 
recommended for most new Raspberry Pi users. 

This version is around 1GB in size and includes 
the PIXEL desktop, Chromium web browser, 

new hardware accelerated VLC player and 
Python. It does not include LibreOffice, 
Scratch, Sonic Pi and many of the other 

tools, programs and applications that 
previous versions of Raspbian included. 
It’s a perfect start for most users and 
those who are more familiar with 
the workings of Raspbian and Linux 
can easily add more apps later, as 
they require.

The Full desktop version is 1.8GB in size 
(at the time of writing) and as you imagine, 

contains pretty much everything you can 
squeeze into Raspbian. You get the PIXEL 

desktop, LibreOffice, VLC, browser, games, 
programming resources and much more. 

So, which version should you download and use on your 
Pi? Normally, as recommended by the Raspberry Pi Foundation, 

most new Pi users are best opting for the Minimal desktop; but that 
depends greatly on what your plans are for using your Raspberry Pi. 
We recommend new users begin with the Full desktop version, as this 
is the version that gives you the complete Pi experience along with all 
the associated software; even if you only use a small percentage of it. 
In fact, this entire book was written using the Full desktop version on a 
Raspberry Pi 3 Model B+.

As you learn more about the Raspberry Pi, Raspbian and Linux and 
begin to form your Pi into a working project, you can easily downgrade 
the version of Raspbian to reflect your use. One day, you may even opt 
for the Lite, command line only version, occasionally connecting to it 
remotely and issuing a few commands. As with most things Pi-related, 
it’s purely up to you.
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We recommend beginners try the Full desktop 
version first, then downgrade when they know 
more about the Pi and its OS. 

The Full desktop version 
contains all the software you’ll 
need for a complete OS.

The Lite version doesn’t even 
have a graphical desktop; it’s 
command line only.

The Minimal installation is the 
newly recommended version 
for Pi users. 

Raspbian: The Complete Operating System
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A Slice of Raspberry Pi

Which Pi is Right for Me?
With several models of Raspberry Pi available to purchase, you can be forgiven for any 
confusion over which model you should buy. So, to help save you time and money, let’s see 
which Pi is best for your needs.  

THE POWER OF PI

With many different versions, across four generations of models, the Raspberry Pi is certainly a busy little board. However, while each Pi 
offers something slightly different, for the newcomer it’s a confusing medley of hardware specifications and model numbers. Which Pi, then, 
is best for you?

Naturally, that question depends greatly on what it is you want to do with your Raspberry Pi. If you have a particular project in mind, such as 
a home media centre server, then you’d probably opt for the more powerful and hardware-capable model of Raspberry Pi. If you want to set 
up a wireless security camera project, using the Raspberry Pi as the core hardware, then perhaps the Pi Zero W would be a better fit. To begin 
with, let’s have a brief look at the models available.

FIRST GENERATION:

Although now quite old, in computing terms, the first generation 
Raspberry Pi models are still available to purchase. These are the 
Raspberry Pi 1 Model A+ and Pi 1 Model B+. 

The Pi 1 Model A+ was released in November 2014 and replaced the 
original Model A. It features the now standard 40-pin GPIO, Micro SD 
Card, lower power consumption, and better audio circuitry. It’s also a 
smaller package than the original Pi, while having a 700MHz processor 
and 512MB of memory.

While a worthy Pi, it does lack the built-in networking of its newer 
model counterparts; both Ethernet and Wi-Fi. The processor is 
somewhat lacking in the performance department, which can be an 
important factor if you are thinking of using this model for any serious 
CPU-related projects. In short, it’s probably worth avoiding the 

Pi 1 Model A+.

The Pi 1 Model B+ is a far more capable design than its sibling 
Model A+. Released in July 2014, the Pi 1 Model B+ boasts 
built-in 100Mb Ethernet and four USB 2.0 ports. 
It does, however, still feature the same 
lacklustre processor as the Pi 1 Model 
A+, but its extra USB and Ethernet 
ports help make up for any lack in 
available hardware.

The first generation models are 
decent enough, providing 
you’re undertaking a 
relatively low-level 
project. Fundamentally, 
although you can pick 
them up from a variety 
of online stores 
slightly cheaper than 
the current models, 

they probably aren’t 
worth the savings. 

SECOND GENERATION:

There are two, Pi 2, second generation models available: the 
Model B and the Model B version 1.2. Although you may be hard 
pressed to find an original Pi 2 Model B (without the 1.2 version), 
so we will  be referring solely to the Pi 2 Model B as the 1.2 
version that was released mid-2016.

The Pi 2 Model B offered the user a more powerful Pi experience. 
With 1GB of memory, an upgraded 900MHz quad-core ARM 
Cortex-A7 processor, and an improved HDMI port. As with the 
previous first generation Model B, this version also comes with a 
built-in 100Mb Ethernet port and four 2.0 USB port hub. 

Overall, this is a superior choice of Raspberry Pi over the first 
generation models. The extra processing power, even though it’s 
only 200MHz, does make a difference, alongside the extra 512MB 
of memory. If you find one that’s significantly cheaper than a 
more recent Pi, then it’s worth considering. 
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THIRD GENERATION:

The third generation Pi models are 
significantly more capable than the previous, 
but they may cost slightly more than the 
second generation model. However, you do 
get more Pi for your money.

The first third generation model to be released 
was the Pi 3 Model B, in February 2016. A 
newer quad core 1.2GHz Broadcom BCM2837 
64-Bit processor, 1GB of memory, and a 4-pole 
stereo output and composite video port meant 
that this was the power-Pi to have. It’s still a 
very good model to use, and can accomplish 
most of the tasks its younger sibling, the Pi 3 
Model B+, can do.

The second of the third generation models 
released was the upgrade to the Model B, the 
Pi 3 Model B+, released in March 2018. With an 
impressive 1.4GHz quad core processor, 1GB 
of faster LPDDR2 memory, dual frequency 
built-in Wi-Fi and a gigabit Ethernet port, the Pi 
3 Model B+ is the most powerful Raspberry Pi 
to date, and is therefore capable of running all 
your projects without any problems. 

The newest member of the third generation 
Pi models is the replacement for the second 
generation A+. Released in November 2018, 
the Pi 3 Model A+ enjoys the same processor 
as the more powerful Pi 3 Model B+, but has 
half the available memory, at 512MB. It also 
loses the Ethernet port and three of the USB 
ports, but it does boast dual band Wi-Fi and a 
far smaller footprint than previous models.

Out of the third generation models, the ones 
to look out for are the Model B+ and Model 
A+. The B+ will give you a more powerful Pi 
experience, but it costs slightly more, whereas 
the Model A+ is much smaller, but lacks the 
extra memory and additional USB ports. 

FOURTH GENERATION:

Introduced on 24th June 2019, the 

Raspberry Pi 4 Model B is a significant 
leap in terms of Pi performance and 
hardware specifications. It was also one 
of the quickest models, aside from the 
original Pi, to sell out.

With a new 1.5GHz, 64-bit, quad-core 
ARM Cortex-A72 processor, and a 
choice of 1GB, 2GB, or 4GB memory 
versions, the Pi 4 is one-step closer to 
becoming a true desktop computer. 
In addition, the Pi 4 was launched 
with the startling decision to include 
dual-monitor support, in the form of 
two micro-HDMI ports. You’ll also find 
a pair of USB 3.0 ports, Bluetooth 5.0, 
and a GPU that’s capable of handing 
4K resolutions and OpenGL ES 
3.0 graphics.

In short, the Pi 4 is the most powerful 
of the current Raspberry Pi models. 
However, the different memory 
versions have an increased cost. The 
1GB version costs £34, 2GB is £44, and 
the 4GB version will set you back £54. 
Remember to also factor in one or two 
micro-HDMI cables with your order.

ZEROS:

In between the first and second generation 
Raspberry Pi models, the foundation launched 
the Pi Zero and Zero W. 

The Raspberry Pi Zero was a significant 
release, as the extremely popular Pi was now 
even smaller. Measuring at just 65 x 30 x 5mm, 
the Zero still managed to pack in a single 
core 1GHz processor, 512MB of memory, a 
mini-HDMI port, micro USB port, 40-pin GPIO 
and a micro-SD card slot. However, it lacked 
wireless and other networking capabilities, 
so you would need to factor in a USB hub and 
network hardware.

The Raspberry Pi Zero W, on the other hand, is 
a far better choice. The processor and memory 
are the same, as are the other hardware items, 
but, as the W indicates, this model comes with 
wireless networking built-in. With a 2.4GHz 
single-band Wi-Fi module, as well as Bluetooth 
4.1, the Pi Zero W is an impressive, slim bit 
of hardware.

While the Pi Zeros may sound like a logical 
choice, considering their far smaller footprint, 
they do lack the performance power of 
the newer third generation models. We’d 
recommend you opt for a Pi Zero W over the 
older Pi Zero, as networking is available out of 
the box. 

In conclusion, the Pi 4 Model B is the main 
Raspberry Pi worth considering if you want 
the full Pi experience; use it for programming, 
gaming, projects, connectivity and so on. The 
Pi 3 Model A+ can be used for projects that 
require more power, but where a smaller size is 
needed, and the Pi Zero W for projects where 
a much smaller footprint and lower power 
draw are needed, and CPU performance isn’t 
too important.

Which Pi is Right for Me?

Of the Pi models available, 
we’d recommend the Pi 4 
Model B, Pi 3 Model B+ 
and Pi Zero W.

The Raspberry Pi 3 Model 
B+ is one of the best Pi 
models available.

The Raspberry Pi Zero W, with 
built-in Wi-Fi and Bluetooth, is 
a great project Pi.

The Pi 3 Model A+ 
was released in 
November 2018 and 
greatly improves over 
the previous Model A.
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There are There are 
overover

2,5002,500
Raspberry Raspberry 

Pi Pi 
Certified Certified 
EducatorsEducators

It was It was 
originally going originally going 
to be called to be called 
Raspberry Py, Raspberry Py, 
as it was only as it was only 
designed to run designed to run 

PythonPython

It is estimated It is estimated 
that there are over that there are over 
50,000 code clubs 50,000 code clubs 
across the world across the world 

using the Raspberry using the Raspberry 
PiPi

The Pi 4 is The Pi 4 is 
between three between three 
to four times to four times 
more powerful more powerful 
than the Pi 3 than the Pi 3 

Model B+Model B+

It’s estimated It’s estimated 
that over that over 

250,000250,000
young people young people 
every week every week 
are learning are learning 
how to code how to code 
with a Piwith a Pi

There’s a There’s a 
Raspberry Raspberry 

in in 
Antarctica, Antarctica, 
where it’s where it’s 
as cold as as cold as 
-42C (-45F)-42C (-45F)

During the During the 
eruption of eruption of 
the Kilauea the Kilauea 
volcano in volcano in 

Hawaii in 2018, Hawaii in 2018, 
a Raspberry Pi a Raspberry Pi 
was used as a was used as a 
seismometerseismometer

Raspberry Pi in Numbers

3.14159265358979...

The Raspberry Pi is one of the most successfully 
launched computers in decades. With the perfect mix 
of hardware, cost, connectivity, and development, 
plus a good, stable Linux OS to back it up, the Pi 
has proved itself to be a near-perfect educational 
platform. Here’s some facts and figures for our 
favourite flavour of Pi.

Sources: The Raspberry Pi Foundation, The Guardian, readwrite.com, Popular Mechanics, CNN, BBC.
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February 2019 February 2019 
marked the marked the 

point where thepoint where the

25 25 

millionthmillionth
Raspberry PiRaspberry Pi 
was soldwas sold

The two most The two most 
used Pi used Pi 

projects are projects are 
retro emulation retro emulation 
and as a media and as a media 

centrecentre

The The 
Pi 4 is Pi 4 is 
powerful powerful 
enough enough 
to run to run 
Windows Windows 
10 as 10 as 
a Thin a Thin 
ClientClient

It is estimated It is estimated 
that there are that there are 
over 50,000 code over 50,000 code 
clubs across the clubs across the 
world using the world using the 
Raspberry Pi.Raspberry Pi.

It was It was 
originally originally 
designed designed 
for school for school 
children children 
to learn to learn 

electronics electronics 
and codingand coding

There are There are 
several several 
Raspberry Raspberry 
Pi’s in Pi’s in 
Borneo’s Borneo’s 

Rainforests, Rainforests, 
monitoring monitoring 
biodiversitybiodiversity

Stacked end Stacked end 
to end, to end, 
all the all the 
Raspberry Raspberry 
Pi’s would Pi’s would 
be taller be taller 
than the than the 

Empire State Empire State 
BuildingBuilding

In 2017 two In 2017 two 
Pi’s went Pi’s went 
onboard the onboard the 
ISS and ISS and 
ran code ran code 
developed developed 
by school by school 
childrenchildren

Pi Zeros are Pi Zeros are 
used as small used as small 

cameras, cameras, 
placed on the placed on the 
backs of Green backs of Green 
Sea Turtles, Sea Turtles, 
to monitor to monitor 
habitationhabitation

Raspberry Pi in Numbers
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STEP 1
The most important thing you need is an SD Card. 

These are the storage cards commonly found in digital 

cameras. All modern Raspberry Pi boards, including the Raspberry Pi 3 

and Pi Zero, use Micro SD cards but the older boards may use a larger 

SD Card.

Kit You’ll Need 
and How to Set it Up
The Raspberry Pi is as bare bones as a computer can get. You get a motherboard, but not 
much else. So you’ll need a few extras to get it up and running but they’re things you’re likely 
to have or at least find it easy to get your hands on.

STEP 2
The SD Card plugs into the SD Card socket. On the 

Raspberry Pi 4, 3, and Pi Zero, you push the card in 

and pull it out. On some older models, you push the SD Card in again 

to eject it. All SD Cards have a notch on one corner that ensures it 

only goes in one way round. Unless you bought a card with NOOBS 

preinstalled, you’ll need to install the software on it first.

STEP 3  You’ll need a HDMI cable to connect your 

Raspberry Pi to a monitor or television set; these 

cables are used with modern televisions and video game 

consoles, so you shouldn’t find it too hard to pick up a spare. If 
you own a Pi Zero, or you’ve got a Pi 4, you’ll need a micro-HDMI 

cable in order to connect to a monitor or TV.

STEP 4
You’ll want to connect your Raspberry Pi to the 

Internet. The Raspberry Pi 4 and Pi 3 Model B+, have 

built in wireless networking and Ethernet. The Model A+ and 

Raspberry Pi 2 include an Ethernet socket, but the Pi Zero and older 

boards will require either an Ethernet adaptor or a Wi-Fi dongle to 

get online.

ASK AROUND

The kit list required to set up a Raspberry Pi is pretty basic: keyboard, mouse, HDMI monitor, SD Card and an optional case. Many of these 
items you’ll already have, but don’t rush out and buy those you don’t. Ask around to see if anybody you know has spares.
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STEP 5
Both the Pi 4 and 3 come with four USB sockets but if 

you own a Pi Zero, you may need to purchase a USB 

Hub. These connect into the USB socket, and provide four (or more) 
USB connections. Typically, you need to connect a keyboard and a 

mouse, so at least two USB ports are required.

STEP 6
Two things that should be easy to find are a USB 
Keyboard and USB Mouse. We routinely prefer USB 

devices that plug directly into the Raspberry Pi, but devices with 

wireless dongles generally work just as well. Only the Raspberry Pi 4 

and 3 Model B+ come with Bluetooth as standard, so you’re best bet 

is to opt for USB, if possible.

STEP 1
Connect your Raspberry Pi to the monitor using the 
HDMI cable. Now attach the keyboard and mouse 

to separate USB ports. If your Raspberry Pi only has one USB port, 
connect the mouse and keyboard to the USB hub and attach it. 

STEP 2
Now, if required, connect the Ethernet cable to the 
Raspberry Pi. Connect the other end of the cable 

directly into your modem/router or into a network socket. 

STEP 3
Finally connect a Micro USB cable to the power 
supply and attach the other end to a 5V USB power 

adapter. This is the type used to power most modern smartphones, 
so you should be able to source a spare. Press the On button to 
power up your Raspberry Pi.  

STEP 4
Consider a case to hold your Raspberry Pi 
together. Raspberry now makes an official case 

that you can use to hold all the components and protect it from 
knocks and drops. 

Now that you’ve got all the basics you’ll need to get everything 
set up. If you haven’t installed the NOOBS files on your SD Card, 
then it’s best to do that first (see the next few pages). 

You can also choose to house your 
Raspberry Pi in one of many enclosures 
like the official one pictured here.

GETTING EVERYTHING CONNECTED

Kit You’ll Need and How to Set it Up
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Set Up Raspberry Pi 
Using a Mac

GETTING TO KNOW NOOBS

The easiest way to get up and running is to use NOOBS, a software program created by the Raspberry Pi Foundation. You can buy a NOOBS 
SD Card from Raspberry Pi but it’s easy to make your own with an old unused SD Card (8GB recommended).

You should install NOOBS (New Out Of Box Software) on your SD Card before you go 
any further. This feature looks at how to format an SD Card and copy the software 
using an Apple Mac computer.

STEP 1
We’re going to use a utility called SD Card Formatter 5 

to erase the SD Card with correct formatting. You can 

download this app from https://www.sdcard.org/downloads/

formatter_4/. Click Download SD Formatter for Mac and Accept. Click 

the SDFormatter.pkg file in your Downloads folder and follow the 
instructions to install the app.

STEP 3
Make sure the card is present in the Select Card area; 

you should only have one SD Card inserted into your 

Mac. Open SDFormatter and choose the Overwrite Format option to 

ensure that all the old data is removed from the card. Enter a name for 

the card in the Name field to help you identify it; although this isn’t 
necessary for the installation process. 

STEP 2
Use an SD Card of at least 8GB capacity to install the 

operating system on your Raspberry Pi. The card 

needs to be formatted, which will erase all the data on it, so make 

sure you have copied any files from it you want to save. Insert the 
SD Card into your Mac, either directly into the SD Card slot or with 

an SD Card adaptor.

STEP 4
Click the Format button when you are ready to wipe 

the card. There are other ways to format SD Cards in 

macOS (in particular Disk Utility) but the advantage of SD Card 
formatter is that it wipes SD Cards with the correct FAT32 format and 

doesn’t affect the protected partition. It can take a while to format the 
SD Card, but the progress bar will show you how the process is going.
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COPY THE SOFTWARE

Transfer the NOOBS files to your SD Card to continue the setup process.

STEP 5
When SD Card formatter has finished formatting the 
SD Card it will be mounted so you can access it. By 

default mounted volumes appear as an icon on the desktop. If not 

open a new Finder window and check for it under Devices. Check that 

the SD Card is accessible and click Close in SDFormatter.

STEP 6
Now it’s time to download the NOOBS software from 

the Raspberry Pi website. Open Safari and enter 

www.raspberrypi.org/downloads/ into the Smart Search Field. Scroll 

down to find the NOOBS section (not NOOBS LITE) and click 
Download Zip. A zip file containing the NOOBS files will be placed in 
your Downloads folder.

STEP 3
Wait for all of the files to be copied from your 
Downloads folder to the SD Card. After the files have 

finished copying open the SD Card and check that all of the files are in 
the root. You should see “bootcode.bin” and “BUILD-DATA” files, and a 
“defaults” folder among other files.

STEP 4
Make sure you eject the SD Card properly. Do not just 

remove it from the Mac. Instead, drag the SD Card 

icon to the Trash to eject it from your system. Or open a new Finder 

window and locate the SD Card under Devices, click the small Eject 

icon next to it. Now remove the SD Card from your Mac. It is ready to 

be inserted into your Raspberry Pi.

STEP 1
Open the Downloads folder and click on the NOOBS 

zip file to unzip it. A NOOBS folder should appear in 
your downloads; it will be marked with the version number you 

downloaded from the Raspberry Pi Downloads page. Click on the 

folder to open it and view all the files contained inside.

STEP 2
Press Command-A to select all the files inside the 
NOOBS folder. Now drag and drop all the files from 

the NOOBS folder to the SD Card. This will copy all of these files to the 
root (the base) of the SD Card. Make sure you copy the files and not 
the NOOBS folder containing them.

Set Up Raspberry Pi Using a Mac
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Set Up Raspberry Pi Using 
a Windows PC

SETTING UP WITH NOOBS

NOOBS (New Out Of Box Software) is a program used to make setting up a Raspberry Pi simple. You can buy SD Cards with NOOBS 
preinstalled, but here we’ll look at how to format your SD Card and install NOOBS using a Windows computer.

It’s easy to set up your Raspberry Pi with a Windows PC by downloading and copying 
NOOBS. This installs a selection of OS’s onto the Raspberry Pi. So let’s format your SD Card 
and install NOOBS using a Windows PC. 

STEP 1
We’re going to use a utility called SD Card Formatter 

to erase the SD Card with correct formatting. You can 

download this app from https://www.sdcard.org/downloads/

formatter/eula_windows/index.html. Click the Accept button to start 

the download of the latest version of the software. Extract the 

software, and double-click the executable to install and run the app.

STEP 3
The Drive letter will be automatically assigned 

depending on the drive(s) in your PC. Click Refresh if it 
can’t find your SD Card. Ensure the Quick Format option is selected. 
Enter a name in the Volume Label field to make it easier to identify the 
card (we used “SD Card”).  

STEP 2
We’re going to use an 8GB SD Card to install the 

operating system on our Raspberry Pi. The card needs to 

be formatted, which will erase all the data on it, so make sure you have 

copied any files from it you want to save. Insert the SD Card into your PC, 
either directly into the SD Card slot or using an SD Card adaptor.

STEP 4
Click the Format button and Yes when you are ready to 

wipe the card. There are other ways to format SD 

Cards in Windows, but the advantage of SD Card formatter is that it 

wipes SD Cards with the correct FAT32 format, and doesn’t affect the 
protected partition. Click OK again, when the format is complete.  
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STEP 5 Click Exit to close down the SDFormatter program. 

Click Start > File Explorer and choose the SD Card 

in the sidebar. The drive should be empty, but we will copy the 

files to it in the next steps. For now just make sure that you can 
access the empty root of the SD Card. 

STEP 6 Now it’s time to download the NOOBS software from the 

Raspberry Pi website. Open a web browser and enter 

https://www.raspberrypi.org/downloads/noobs/ into the URL field. 
Scroll down to find the NOOBS section (not NOOBS LITE) and click 
Download Zip and Save. A zip file containing the NOOBS files is copied to 
your Downloads folder. Click Open Folder when it is done. 

STEP 1 A NOOBS folder should appear in your downloads. It 
will be marked with the version number that you 

downloaded from the Raspberry Pi Downloads web site. Double-
click the NOOBS zip file in your Downloads folder to view the 
contents. These are the files you need to copy to the root (base) of 
your SD Card.   

STEP 3 Wait for all of the files to be copied from your 
Downloads folder to the SD Card. The files that are 

copied will install an operating system of your choice on the Raspberry 
Pi when you first boot it up. It is important that the files are copied to 
the root (base) of the SD Card and are not inside another folder such 
as the NOOBS folder.

STEP 4 Click Start > File Explorer and choose “SD CARD (F:)” in 
the sidebar to display the contents. It should now 

contain all the files NOOBS needs to setup an operating system on 
your Raspberry Pi. Check that you can see a Defaults folder, bootcode 
and BUILD-DATA files along with the other files shown here. Remove 
the SD Card from your Windows PC. It’s now ready to be inserted into 
the Raspberry Pi.

STEP 2 Click Extract All to expand the zipped file and extract 
its contents. Click Browse in the Select a Destination 

and Extract Files folder and choose “SD Card(F:)” in the Select a 
Destination window. Click Select Folder and Extract. The files will now 
be copied directly from the zip file to your SD Card.

Continue making your SD card by copying the files across.

Set Up Raspberry Pi Using a Windows PC

COPY THE SOFTWARE
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The Raspberry Pi Desktop (x86 version) allows you to view the 
same desktop and pre-installed software as the Full Desktop 
version available for the Raspberry Pi. You can install it on any 
decent PC, or laptop, one that’s at least six or seven years old 
would be perfect and as a PC that age usually struggles with 
the latest version of Windows 10, you can now install Raspbian 
instead of boxing that old kit and resigning it to a life of 
gathering dust in the loft.

The Raspberry Pi Desktop: 
What You Will Need

In 2016, the Raspberry Pi Foundation started work on an x86 

version of its popular Raspbian operating system. By the end of 

the following year, there was a link on the Downloads page and 

non-Pi owners could now install and use Raspbian in almost the 

exact same way as if they were in front of a Raspberry Pi.

Since then, the Raspberry Pi Desktop, or as it’s correctly called: 

Debian Stretch with Raspberry Pi Desktop, has followed the same 

release path as its Pi-based sibling. However, there are some 

differences you need to be aware of prior to throwing your Pi 
away and opting for this version instead.

The major difference is that this version has been compiled to run 
on x86 processors, that’s Intel and AMD PC processors. Whereas, 
the version of Raspbian that you will find on a Raspberry Pi has been 
compiled and created exclusively for ARM processors; the type of 
CPU a Raspberry Pi uses. These CPUs use a different architecture 
to that of an Intel or AMD CPU, so the software required to run on 
one won’t run on the other unless the developer has specifically 
made either an x86 or ARM version. In short, if you’ve found a piece 
of software that you enjoy using on your Raspberry Pi, you won’t 
be able to use it on the Raspberry Pi Desktop x86 version – UNLESS, 
there’s a dedicated x86 version of the software.

Another caveat worth mentioning is that you won’t have access to 
the 40-pin GPIO that the Raspberry Pi features, as this isn’t a standard 
piece of hardware on a normal PC. There is, however, a way around 
this. If you own a Raspberry Pi Zero (either with or without the W), 
then you’re able to connect the Zero to a spare USB port on the PC, 
via the Zero’s micro USB port and the Raspberry Pi Desktop OS will 
recognise the Zero as extended hardware and allow you access to the 
Zero’s 40-pin GPIO, which, you have to admit, is pretty clever stuff.

Did you know that there is a way in which you can run the full Raspbian OS desktop without 
even needing a Raspberry Pi? The Raspberry Pi Desktop edition is a fully working, Debian-
based installation of Raspbian that can run on a standard PC.  
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USB STICK The best method of transferring the ISO to a PC for 

installation is to use a combination of a tool such as 

Rufus (found at: https://rufus.ie/en_IE.html), which is a piece of 
software that can create a bootable USB driver from an ISO file and, at 
least, an 8GB USB stick.

RASPBERRY PI ZERO Although not strictly a necessity, a 

spare Raspberry Pi Zero will allow you 

to access the 40-pin GPIO from within the Raspberry Pi Desktop OS. If, 

however, you don’t have a spare Zero, it’s not a problem as there’s still 

plenty you can do with Raspbian on a PC. 

THE OS Naturally you’ll need the Raspberry Pi Desktop OS, just 

as you would with Raspbian or the Pi. Open a browser 

and download the ISO file that contains the OS from: https://www.

raspberrypi.org/downloads/raspberry-pi-desktop/.

A COMPUTER An older desktop PC or laptop is an ideal 

candidate for running the Raspberry Pi Desktop 

OS. While you can easily use the latest PC/laptop, it’s a bit overkill for 

this particular operating system.
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The Raspberry Pi Desktop: What You Will Need

WHAT YOU WILL NEED 

Here’s a list of items needed if you want to test out the latest version of the Debian Stretch with Raspberry Pi Desktop OS on your PC.

Setting up the Raspberry Pi Desktop version on a PC or 

laptop is very simple, and follows roughly the same method 

as the previous Mac and Windows setups for the Pi. Begin by 

downloading the ISO image from https://www.raspberrypi.

org/downloads/raspberry-pi-desktop/, then download Rufus 

from https://rufus.ie/en_IE.html. Insert an 8GB USB stick 

and run Rufus, then follow the on-screen instructions to 

locate the downloaded Desktop ISO. Once the image has 

transferred to the USB stick, remove it from the computer 

and insert it in the spare laptop/PC. Select Boot from USB 

from your system’s BIOS/UEFI then follow the instructions to 

use and install the Raspberry Pi Desktop OS.

HOW TO SET UP THE 

RASPBERRY PI DESKTOP 
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A Slice of Raspberry Pi

Debian Stretch with 
Raspberry Pi Desktop

10 THINGS TO DO WITH X86 RASPBIAN

You can do just as much with this version of Raspbian as with the dedicated Pi version and to demonstrate here’s ten great projects to do 
with Debian Stretch with Raspberry Pi Desktop.

You can be forgiven for thinking that a version of Raspbian that isn’t on a Raspberry Pi is 
somehow lacking and therefore a bit pointless in its use. However, there’s a lot that you can 
do with the Debian Stretch with Raspberry Pi Desktop version. 

CODING  This version of Raspbian apes the Full Desktop version 

for the Raspberry Pi, meaning it comes with all the 

necessary programming languages out of the box. Learn Python, C++, 

use the HAT emulator and even learn JAVA. It’s all there under the 

Programming menu option.

FULL DESKTOP As the x86 version of Raspbian follows the Full 

Desktop Pi version, there’s an entire office 
suite pre-installed, allowing you to use that old laptop or PC as a fully 

functional desktop replacement for Windows or macOS. LibreOffice is 
also Microsoft Office compatible.  

HARDWARE Hook up a Pi Zero without an SD installed, select 

GPIO Expansion Board from the options and you 

will be able to talk to the Zero’s 40-pin GPIO via the likes of Python or 

Scratch. By doing so, you’ll have all the benefits of a Raspberry Pi, with 
the power of your laptop.  

WEB BROWSING As with most modern operating systems, 

you can browse the Internet exactly as you 

would with Windows 10, the latest macOS or similar and because this 

is a Linux-based OS, there’s an added element of security, as it won’t 

be affected by Windows-targeted viruses.  
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Debian Stretch with Raspberry Pi Desktop

LINUX X86-BASED SOFTWARE As this is a Debian based 

version of Linux, you can 

naturally install any of the tens of millions of Linux x86-based software 

currently available. Remember though, only software that has both an 

ARM and an x86 version will work on both the Pi version and this 

version of Raspbian.    

MINECRAFT  Neither the Raspberry Pi 4 or the Pi 3 Model B+ 

are the most powerful computing devices 

available. Your older laptop is probably significantly more powerful 
but even so, you will be able to play games like Minecraft without too 

much trouble at all.

RECOMMENDED SOFTWARE The Recommended 

Software option is also 

available with this version of Raspbian. This tool allows you to pick and 

choose which of the Pi-favoured software you add or remove. Simply 

tick the box next to the name of the app. 

RETRO GAMING If retro gaming is more to your taste, then 

Debian has a huge number of retro 

emulators available, covering both consoles and home computers. You 

will need legal ROMs, however, to play the games, but these are 

widely available from reputable sites.  

GAMING Of course, there’s an equally large selection of modern 

gaming available for Debian; most of which will run 

perfectly well under Raspbian in an x86 environment. You will need to 

Google what’s available and try out a few examples as the list is simply 

too big to mention. 

SSH It’s easy to use SSH from within the Raspberry Pi 

Configuration tool. Select the Enabled option and then use a 
client, such as PuTTY, to SSH into the OS. Here we’ve enabled SSH and 

connected from another Windows PC, using PuTTY as the SSH client.  
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A Slice of Raspberry Pi

Debian Stretch – 
Virtual Desktop

GOING VIRTUAL

You’ll need a copy of VirtualBox to download and install, which you can find at https://www.virtualbox.org/wiki/Downloads. Windows 
users click on Windows Hosts, macOS click OS X Hosts.

Don’t have a spare PC handy for Debian Stretch with the Pi Desktop? Then consider a virtual 
machine. Within a virtual machine, you can run the Pi desktop without ever affecting your 
Windows or Mac setup. Here’s a quick how to.  

STEP 1
Install the downloaded VirtualBox for your system by 

following the on-screen instructions. Next, download 

the Raspberry Pi Desktop ISO from https://www.raspberrypi.org/

downloads/raspberry-pi-desktop/. Start VirtualBox and, from the 

menu, click Machine – New. Edit the Type to Linux, version to Debian 

(64-bit), and name it Raspbian. Click Next and follow the default options.

STEP 3
When asked “Install the GRYB boot loader to the 

master boot record?” Select Yes, and choose /dev/sda; 

after a brief time select yes to installing a GRUB boot loader followed 

by the sda drive identification (not the Manual option). Once installed, 
click Continue to reboot and you’ll see the Raspbian desktop load up. 

STEP 2
Start the newly created machine and then locate the 

downloaded Raspberry Pi Desktop ISO. In the menu 

titles ‘Debian GNU/Linux Installer Boot Menu’, use the arrow keys and 

select Graphical Install. Press Enter and follow the on-screen installation 

instructions. Use the Guided – Entire Disk option when asked, then Write 

Changes to Disk.  

STEP 4
Drop into a Terminal, click the fourth icon along the top 

menu bar, and enter:

sudo apt install build-essential module-assistant dkms

sudo m-a prepare

 Answer yes to install packages. Click on Devices in VirtualBox, 

followed by Insert Guest Additions CD. In the Terminal, enter:

sudo sh /media/cdrom/VBoxLinuxAdditions.run

sudo reboot 

You can now adjust resolution via Menu > Preferences > 

Screen Configuration.
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Discovering 
Raspbian
The Raspbian operating system 

is a Linux distribution that comes 

pre-packed with a fantastic 

collection of programs and apps 

to help you get the most from 

your Pi. Raspbian enables the 

Raspberry Pi to become a fully 

functioning desktop computer 

and with it, you can code in the 

latest version of Python, Scratch 

and more. 
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Take a Tour of PIXEL
PIXEL is the desktop environment for your Raspberry Pi. It’s built on top of Raspbian, the core 
OS, which is itself designed around the Linux distribution - Debian, specifically, Debian Buster. 
PIXEL is fine-tuned to run on the Raspberry Pi, taking advantage of its unique hardware.  

PIXEL

PIXEL stands for “Pi Improved Xwindow Environment, Lightweight”. It’s a lightning fast and energy saving desktop that looks good too. It 
contains almost everything you’ll ever need to work with the Pi 4.

THE DESKTOP The PIXEL interface is a module that’s installed 

on top of the core OS. It has seen some 

improvements over the years, and with the release of the Pi 4 and 

Raspbian Buster, it now looks like this. 

PRODUCTIVITY  You’ll notice that within the Main menu, 

there’s a category named Office. In here, 
you’ll find a pre-installed suite of programs called LibreOffice, that are 
Microsoft Office compatible; there’s a word processor, database, 
drawing, presentation and spreadsheet program. 

THE PROGRAMS  The programs that come pre-installed with 

Raspbian are easily located by clicking on 

the Raspberry Pi logo in the upper left corner of the desktop. Once 

there, you can select from the sub-menu categories, followed by the 

program name.  

FILE MANAGER   To view the files stored on your Raspbian OS, 
click on the File Manager icon in the 

Application Launch Bar (the one that is shaped like a pair of files). This 
opens a window displaying all the files in your home directory. The 
Directory Tree gives quick access to common folders, such as Desktop 

and Documents.  
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CUSTOMISE THE DESKTOP

As with any other operating system desktop, you’re able to customise the Raspberry Pi’s PIXEL interface, making it more personal and more you. 

Take a Tour of PIXEL

MENU EDITOR  It is possible to remove and add items to the 

Application Menu using the Main Menu Editor. 

Choose Menu > Preferences > Main Menu Editor, then add or remove 

ticks next to programs and sections you want to include\exclude. Use 

Move Up and Move Down to rearrange items in the Menu.   

SHUTDOWN   It’s important that you switch off your Raspberry 
Pi safely. When you are finished with your 

Raspberry Pi session click Menu > Shutdown. Three options appear: 

Shutdown, Reboot, and Logout. Click Shutdown. Always wait for the 

screen to go blank before removing the USB power. 

YOUR PIXEL   Choose Menu > Preferences > Appearance 

Settings to open the Appearance Settings 

window. There are four sections: Desktop, Menu Bar, System, and 

Defaults. You can use these to adjust the various options for your 

system, such as colours, layout, and so on. 

DESKTOP WALLPAPER    The most common change is that of 

the desktop wallpaper, or desktop 

background. The default is called ‘Temple’, however, by clicking on 

temple.jpg in the Picture section of the Appearance Settings, you 

have other images available. Naturally, you can opt for your own. 

MENU BAR     The second tab in the Appearance Settings window 

allows you to adjust the menu bar that runs along 

the top of the desktop. You can change its size, colour, and even its 

location from the top to the bottom of the screen. 

FONTS      The System tab in the Appearance Settings window will 

enable you to change the core system font, as well as the 

mouse cursor size. There are numerous fonts to choose from and, if 

you want, you can even install your own. 

33www.bdmpublications.comb0317180-1dbc-4fe7-b445-0fab5a6a6c7ab0317180-1dbc-4fe7-b445-0fab5a6a6c7a



www.bdmpublications.com34

Discovering Raspbian

Exploring the 
Command Line

USING TERMINAL

Despite its graphical PIXEL interface, Raspbian is a Linux operating system and this means you’ll spend a lot of time working with text 
commands. Using the command line is an important part of learning to use a Raspberry Pi computer.

If you’ve grown up with Windows or the Mac OS then you might never have encountered the 
command line. This part of the operating system sits beneath the desktop and is used to control a 
computer using text commands. You’ll need to get familiar with it to use your Raspberry Pi.

STEP 1
By default the Raspberry Pi boots directly into the 

PIXEL interface. Here you use a visual metaphor, files, 
buttons and so on, to make changes to your computer. The command 

line is where you control a computer by entering text commands. Click 

Terminal in the Menu bar to view the console.

STEP 3
Another way to switch to a command line environment 

is to press Control+Alt and F2. This gets rid of the 

desktop completely and you see just a black screen with text. This is 

known as a virtual environment and you’re now in tty2 (“tty” is a 
throwback to teletext writers). You’ll need to enter your login name 
(“pi” by default) and password (“raspberry” by default). 

STEP 2
You can enter commands into the Terminal to make 

changes to the computer. This works alongside the 

PIXEL interface. Enter: mkdir Desktop/testfolder and press 

return. Notice a new folder appears below the Trash on the desktop. 

Drag it to trash to get rid of it. You can use the Terminal and PIXEL 

environments alongside each other.

STEP 4
There are six different virtual environments 
available. Press Control-Alt-F3 to switch to the third, 

and Control-Alt-F4 to go to the fourth, and so on. You’ll need to log 

on to each one in the first instance but can then jump back and forth 
between them.
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STEP 5
Press Control-Alt-F1 to return to the PIXEL interface. 

One thing to realise is that PIXEL is just a program 

running on top of the tty1 session. Open Terminal and enter: pkill 

lxsession. Ouch, there goes your desktop. Don’t worry, enter: 

startx to get it back again. Most of the time you just enter 

commands into the Terminal window on top of the PIXEL environment.

STEP 6
Some users prefer to use just the command line. 

Open Menu > Preferences > Raspberry Pi 

configuration and choose To CLI and click OK and Yes.  The 
Raspberry Pi will now boot into the command line interface. Enter: 

startx to get back to PIXEL, open Raspberry Pi Configuration and 
choose To Desktop to go back to normal.

STEP 1
One of the most important command line instructions 
to know is sudo. This command stands for “substitute 

user do”, sometimes incorrectly called “super user do” and allows you 
to run a command as another user. Typically this is the root user 
account, which has more access privileges than your user account.

STEP 3
The first time you enter sudo you’ll be given a warning 
message. Commands to make, edit and delete files 

prefaced with sudo can be used to change any file on the system. 
Sometimes with powerful, or disastrous, results. Be careful. Enter your 
password and press return.

STEP 4
Be especially careful of any set of commands that use 
sudo –i. This takes you to root mode, where every 

command is run as sudo. Your name (normally “pi”) is replaced with 
“”root”. Root mode is generally considered a bad place to be, so enter 
exit to get out of it as soon as possible.

STEP 2
When you start a command with sudo it is run as 
the root user and is often used when changing 

files outside of your user account, such as installing new 
programs. When you enter sudo you will be asked to enter your 
user password. Enter: sudo -v and press enter.

Exploring the Command Line

USING SUDO

Discovering the power of the super user.
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Setting Up a Static 
IP Address

DHCP RESERVATION

Now that you’ve set up your Raspberry Pi and connected it to the network, you should take time to fix its IP address. This will make it a lot 
easier for you to connect to the Raspberry Pi from a Mac or Windows computer and share files.

While this may sound complex, it’s pretty easy if you follow these steps. A static IP 
ensures other computers can always find your Raspberry Pi. You don’t have to do this, 
but it often comes in handy.

STEP 1
When you 

connect 

your Raspberry Pi to a 

network, the router (or 
modem/router) assigns it a 
number, known as its IP 

(Internet Protocol) address. 
This is a block of four digits 

and the first three are 
usually 192.168.0. After 

that is a digit for each 

electronic device.

STEP 3
To find out what number your Raspberry Pi is using 
click on the Terminal icon and enter: ifconfig and 

press Return. You should find it next to “inet addr:”. The challenge is 
that the router assigns this number using DHCP (Dynamic Host 
Configuration Protocol). When the Raspberry Pi is unplugged it 
reuses the number and your Raspberry Pi may get a different number 
next time.

STEP 2
The router typically takes the first address, so it is 
usually found at 192.168.0.1. That number is reserved 

for the router. Often you’ll find this number on your router marked 
“web address”. The router then assigns similar IP address numbers to 

the other devices you own as they are added to the network, so 

192.168.0.2 might be your computer, 192.168.0.3 your smartphone and 

so on.

STEP 4
It’s better all-round if you can get the Raspberry Pi to 

use the same IP address every time you connect it to 

the network. You do this using DHCP Reservation. This is where you 

tell your router to remember the Raspberry Pi address, and only use 

that address from now on. Start by opening the Chromium Browser 

and entering 192.168.0.1 to connect to your router’s web interface.
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MANAGING YOUR DHCP DEVICES

Now that you have set up a DHCP Reservation, you need to understand how to manage the different devices that may need to use it and 
connect to the IP. 

STEP 5
We’re using a Virgin Broadband router but the 

process is similar on most routers. Google the name 

of your router and “DHCP Reservation” to find the router you’re 
looking for. Enter your admin password (our default password was 
listed on the back of the router). Click Advanced Settings > DHCP 
Reservation. In the DHCP Settings section you will find all of the 
devices connected to your network. Scroll down and find the one with 
the same IP Address listed in Step 3.

STEP 6
Select the device using the check box on the right and 

scroll down to the Add Reservation section. It should 

have filled in the Device Name, MAC Address and IP Address fields. If 
the Device name is “unknown” change it to “raspberry-pi”. Click Add 

Reservation to ensure it always uses that IP Address. Click Apply to 

enforce the changes.

STEP 1
Now that you have set up your Raspberry Pi with a 

DHCP Reservation it will always connect to the router 

using that IP Address. You can check this at any time by entering: 

ifconfig into terminal. The router always knows that it is your 

Raspberry Pi by checking its MAC address. This is the set of six 

hexadecimal numbers next to “HWaddr” in ifconfig.

STEP 3
Your Raspberry Pi will still have the same IP Address 

but it isn’t guaranteed to keep it. Restart your 

Raspberry Pi by entering: sudo shutdown -r now into a Terminal 

window. When it has restarted enter: ifconfig and you’ll find you still 
use the same IP Address. Over time the router will use other slots for 

new devices until it reaches its maximum (255 by default). Then it will 
recycle disconnected devices.

STEP 4
Setting up DHCP Reservation is good practice because 

it ensures you Raspberry Pi is always going to use the 

same IP Address. It’s also a good idea to write it down or use a label 

printer to create a label for the Raspberry Pi. You will need this 

number to connect to the Raspberry Pi via SSH, VPN or FPT 

(techniques we will use throughout this book).

STEP 2
If you decide to free up that IP Address so other 

devices can use it, you can remove it from the router. 

Open the router web interface (192.178.0.1) and click Advanced 
Settings > DHCP Reservation. Scroll down to the IP Lease Table to find 
the Raspberry Pi. Select the check-box next to it and click Apply 

and Yes.

Setting Up a Static IP Address
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Connecting to the 
Pi Remotely

REMOTE CONTROL

The Raspberry Pi is easy to set up and use in projects around the home and, surprisingly, many of these projects don’t need a keyboard, 
mouse or a monitor; these are known as Headless devices. VNC lets you control a Headless Pi from another computer. 

VNC (Virtual Network Computing) is a connection protocol technology that’s used 
to remotely control one computer from another. With VNC set up, you can use your 
Raspberry Pi from your Mac or PC.

STEP 1
You will first need to ensure that your Pi is connected 
to a keyboard, mouse and monitor, and is connected 

to your Wi-Fi router, before you attempt to connect to it remotely. 

Start by clicking on the Raspberry Pi menu, then scroll down to 

Preferences > Raspberry Pi Configuration.

STEP 3
In the upper right corner of the menu bar you’ll notice 

a VNC icon (next to the Bluetooth icon). This is the 
built-in VNC server, click the icon in the menu bar once to open the 

VNC Server window.

STEP 2
With the Raspberry Pi Configuration window open, 
click on the Interfaces tab, and ensure that the VNC 

option is Enabled. Click on the radio button next to Enabled to 

activate, then click on the OK button to close the window. 

STEP 4
Make a note of the IP Address of the Raspberry Pi as 

detailed in the left-hand section of the VNC Server 

window; our example is 192.168.1.244. Now click on the three 

horizontal lines in the top right of the VNC Server window. From the 

sub-menu that appears, click on the Options entry. This will open a 

new window pop-up. 
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REMOTE VIEWING

The Pi-side of things has now been set up. Just remember the Pi’s IP address, and get to your PC or Mac for this next part.  

STEP 5
With the Security option highlighted on the left, 

ensure that the Encryption option, to the right, is set 

to Prefer On, and that Authentication is VNC Password. This may ask 

you to enter a password, which you will use when connecting 

remotely from another computer. Enter a password you’ll remember. 

STEP 6
While still in the Options window, click on 

Connections in the left hand pane. In the right hand 

pane, ensure that the Allow Direct VNC Connections Over TCP is 

ticked, and that the Port is set to 5900. It usually is, but sometimes it 

can be unticked if an update to software has been applied.

STEP 1
Reboot the Pi, then disconnect the keyboard, mouse 

and monitor; but keep the power connected. From 

your PC or Mac, open a browser and navigate to: https://www.realvnc.

com/en/connect/download/viewer/. Choose your operating system 

and click the Download VNC Viewer app.

STEP 3
In the new pop-up window, enter the password you 

created through the Raspberry Pi’s VNC Server 

options page. You can choose to Remember Password if you want, but 

if the computer you’re using is shared, you can always opt to leave the 

option unticked. Click OK when ready.  

STEP 4
You may be asked to confirm connection to a remote 
computer, click Continue to make the connection. You 

are now connected remotely to your Raspberry Pi. As long as the Pi is 

powered up, and has access to the Wi-Fi signal of the router, then you 

can place it anywhere and get access without using a mouse, 

keyboard, or monitor. 

STEP 2
Follow the on-screen instruction to install VNC Viewer 

on your system, when it’s finished, launch the app and 
choose whether you want to send anonymous data. In the main VNC 

Viewer window, enter the IP Address of the Raspberry Pi; ours was 

192.168.1.244. Hit Enter when you’ve typed in the IP address.

Connecting to the Pi Remotely
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Using APT to Install 
and Remove Programs

ADVANCED PACKAGING TOOL

Add / Remove Software is great for finding and installing software but most of the time you manage apps on a Raspberry Pi using a program 
called APT (Advanced Packaging Tool) using the apt command.

When you start to get serious with your Raspberry Pi, you’ll need to install software that is available 
for Linux, but not part of the Pi Store. These programs are installed from the command line using a 
service called APT. Learning how to use APT is a vital part of using your Pi.

STEP 1
To manage the apps on your Raspberry Pi you’ll need 

to use a tool included with Raspbian called APT 

(Advanced Packaging Tool). APT is a command line tool so you need to 
either start your Raspberry Pi in the command line or click on the 

Terminal icon. 

STEP 3
The command used to add new software to your 

Raspberry Pi is apt install followed by the name 

of the package you want. However, because apt adds (or removes) 
files outside of your home directory you need to preface apt with the 
word sudo. Almost all of the time you will need to type sudo apt 

when using this tool.

STEP 2
The command used to control packages in Raspbian is 

apt Type apt into the terminal and press Return to 

get a description of what the app does. The instructions tell us that 

the “most frequently used commands are update and install”. You may 

also hear about “apt-get” which is an older version of the same tool. It 

works in much the same way.

STEP 4
Beginning a command with “sudo” runs the command 

as a super user, “super” meaning the one above your 

Pi account, rather than one with super-hero properties. However, if it 

helps you to think of it that way that’s fine. So to install a new program 
you type: sudo apt install followed by the name of the app 

you want.
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MORE APT COMMANDS

The apt command is also used to list, and delete, any apps you have installed. 

STEP 5
You’re going to install a chess game called 

Dreamchess. Enter: sudo apt install 

dreamchess and press Return. Descriptive text will run up the screen. 

You may see “Do you want to continue [Y/n]?” Enter: y and press 

Return to install the application. You’ll find it by choosing: 
Menu > Games > Dreamchess.

STEP 6
You can use apt-cache to search for apps you can 

install and remove. Enter: apt-cache pkgnames to 

view all the packages available. Typing apt-cache pkgnames | 
less enables you to view a page at a time (press any key to scroll). 
You can use apt-cache search to find packages, enter: apt-cache 
search pong to view a list of Pong games you can install.

STEP 1
Sometimes you will try to install an app only to get an 

error that the file cannot be found. In this case you 
need to update apt so it has the latest links. Enter: sudo apt 

update. This doesn’t update the apps you’ve installed, it just gets a 

newer listing of apps. To update your apps to the latest versions enter: 

sudo apt upgrade. You’ll often find both commands rolled into 
one: sudo apt update && sudo apt upgrade.

STEP 3
Packages are uninstalled from your Raspberry Pi 

using the remove command. Enter: sudo apt 

remove dreamchess to start deleting the chess game that you 

installed. An alert saying “Do you want to continue [Y/n]?| appears, 

enter: y and press Return to delete the program.

STEP 4
Uninstalled packages using apt doesn’t remove all 

of the files. Some are left in case you decide to 
reinstall the program later. To completely remove a package from 

your Raspberry Pi use the purge command. Enter: sudo apt 

purge dreamchess to remove all of the supporting files. You 
can also use sudo apt clean to tidy up your packages and free 

up some drive space.

STEP 2
To view the packages you’ve installed you use a 

different command called dpkg. Enter: dpkg 
--get-selections | grep -v deinstall to view all of the 

packages on your Raspberry Pi. Place | less after it to view one 

page at a time. Or dpkg --get-selections | grep -v 
deinstall > ~/Desktop/packages.txt to save the list as a 

text file on your desktop.

Using APT to Install and Remove Programs
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Get More from the 
Terminal App

CUSTOM TERMINAL

The Terminal, or command line, is a powerful environment for accessing the system. Careful, here be dragons.

Terminal is an app in Raspbian that enables you to access the command line and issue text 
commands to your Pi. You’ll spend a lot of time in Terminal, so it’s a great idea to get to know 
the app and set it up to work your way.

STEP 1
Start Terminal by clicking the Terminal icon in the 

Application Launch Bar. You can also start Terminal 

by pressing Control-Alt-T or choosing Menu > Accessories > 

Terminal. Terminal emulates the old style video terminals from 

before desktop interfaces; so by default it displays bright (mostly 
green) on a black background.

STEP 3
Naming tabs makes them much easier to recognise. 

Choose Tabs > Name Tab and enter a name for the tab 

such as “Home” or “Downloads”. Click OK to set the name. You can 

quickly switch between tabs using Control-Page Up and Control-Page 

Down and rearrange them using the Tabs Move Tab Left / Move Tab 

Right options.

STEP 2
The first thing most people overlook is the ability 
to run multiple terminals at once in different tabs. 

Choose File > New Tab (Shift-Control-T) to create a new tab. 
Navigating multiple directories simultaneously can be a challenge 

in Terminal and tabs makes it that much easier.

STEP 4
Choose Edit > Preferences to personalise the look and 

feel of LXTerminal. One of the best tricks is to click 

Background and drag the Opacity slider to the half-way point. This 

enables you to view through the terminal background and see the 

windows below. You can also personalise the colour of the background.
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CONNECT USING SSH

Use a different computer to control your Raspberry Pi.

STEP 5
While still in Preferences click the Display tab. Here you 

can adjust the Tab panel positions, placing them on the 

Left makes them more prominent. You can also adjust the scroll-back 

line count. This is the number of lines you can scroll up with using the 

mouse, not the history accessed by the Up and Down arrows.

STEP 6
If you prefer a more minimalist approach try moving the 

Tabs to the bottom and selecting the Hide scroll bar, 

Hide menu bar and Hide Close button options. When combined with a 

low opacity background this makes for a subtle terminal window. You 

can still access menu settings using a right-click on the mouse.

STEP 1
If you have your Raspberry Pi on the same network 

as a Mac or Linux-based computer, you can control it 

using the Terminal program on that computer. We’re going to use 

Terminal in macOS here but the process is the same on a Linux 

machine. Open the Terminal app on your computer.

STEP 3
Switch back to Terminal on your Mac or Linux 

machine and enter: ssh pi@192.168.0.178 

(using your own IP address). The “pi” bit is the name of the default 
user account, so if you have changed that it needs to match your 

user account on the Raspberry Pi. You’ll be asked for a password. 

This is the password that you use to log in to the Raspberry Pi (not 
your Mac or Linux computer).

STEP 4
You are now logged in to your Raspberry Pi and 

can enter commands directly into the Terminal on 

your Mac or Linux computer. Unlike remote networking you 

don’t see the commands being entered on the screen of the 

Raspberry Pi, you are accessing the computer from behind the 

scenes. Many people prefer to set up the Raspberry Pi so they 

can control it from a more powerful computer. Enter: exit to 

close the connection.

STEP 2
Enter: ifconfig into the Terminal app on your 

Raspberry Pi. This will let you know which IP address 

it is using. Look for the four blocks of digits following “inet addr:’. 

They should begin with 192.168.0 followed by a three-digit number. 

Ours is 192.168.0.179. You need to use that number in Terminal on 

your Mac to connect.

Get More from the Terminal App
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Using the File Manager

VIEWING AND MOVING FILES

You can move, manage and delete files using the Command Line but like all modern operating systems Raspbian has a program to help you 
manage your files. Discover how to use the File Manager app.

Because you’ll be creating programs on your Raspberry Pi, you’ll need to know more about 
the file system than you would on other computers. One vital tool to become familiar with is 
the File Manager. This is used to find, move and remove files from your Raspberry Pi.

STEP 1
Raspbian includes a great file management program 
called “File Manager PCManFM” or just “File Manager” 

for short. Click on the FileManager PCManFM icon in the Launch Bar or 

choose Menu > Accessories > File Manager.

STEP 3
In the left-hand part of the File Manager sits the Side 

Pane. By default this displays the Directory Tree, 

which is another way of navigating the folders on your hard drive. 

Alternatively click the Side Pane menu and choose Places. Now the 

Side Pane displays common locations such as Home Folder, Desktop, 

Rubbish Bin (also known as the Wastebasket), Applications and your 
SD Card.

STEP 2
File Manager displays the folders in your Home folder 

(this should match your user name, ‘Pi’ by default). By 
default you should have Desktop, Documents, Downloads, Music, 

Pictures, Public, python_games, Scratch and folders. Double-click any 
folder to open it and view its contents. Click the Parent Folder icon or 

press Alt-Up Arrow to head back up.

STEP 4
You can create a new folder in the current location by 

choosing File > Create New > Folder or press 

Shift-Control-N. Enter a name for the folder and click OK. Files and 

folders can be dragged on top of one another to move them around. 

You can also drag files to the folders in the Side Pane, which is an easy 
way to move them back up the folder tree.

b0317180-1dbc-4fe7-b445-0fab5a6a6c7ab0317180-1dbc-4fe7-b445-0fab5a6a6c7a



45www.bdmpublications.com

STEP 5
Double-click a file in File Manager to open it with the 
default app. You can also right-click a file to view 

compatible applications in Raspbian. Pick an application from the list 

provided to open it. Click Properties and use the Open with menu to 

automatically open that type of file with that app in future.

STEP 6
Drag items you no longer want to the Wastebasket 

to delete them or right-click and choose Move to 

Trash. To empty the wastebasket and permanently delete the 

unwanted files double click Wastebasket to open it. Now right-click 
the black space in File Manager and choose Empty Rubbish Bin. Click 

Yes in the alert window and the files will be removed.

STEP 1
As you start to move files around you will find 
navigating between the same folders tiresome. It is 

possible to open locations in File Manager as tabs, so you can quickly 
jump back and forth. Click the Create new tab for this folder icon, just 
below the File menu, and the current folder opens as a tab. Click the 
tabs to jump between locations.

STEP 3
It’s worth taking time to explore the View menu in File 
Manager. Here you’ll find a Show Hidden option, which 

enables you to view hidden files, as well as Sort Files. You can also 
adjust the Folder View Mode as well as Toolbar, Path Bar, Side Pane 
and Status Bar.

STEP 4
There are times when you will want to move files but 
find you can’t because you don’t have root (sudo) 

access in File Manager. If you want to open File Manager with root 
mode choose Menu > Run and enter: gksu pcmanfm. File Manager 
will open and display root and boot() folders. Be careful when running 
File Manager in root mode, and close it when you are finished.

STEP 2
To view the properties of a file right-click and choose 
Properties. Here you can view information about the 

File Type and the Open With application. More importantly, if you 
click Permissions you can view the permissions associated with that 
file. The concept of file permissions, especially the ‘Execute’ setting, 
becomes increasingly important as you become more advanced in 
using your Raspberry Pi.

Using File the Manager

ADVANCED FILE MANAGER TRICKS

These handy tricks and tips make File Manager more powerful.

b0317180-1dbc-4fe7-b445-0fab5a6a6c7ab0317180-1dbc-4fe7-b445-0fab5a6a6c7a



www.bdmpublications.com46

Discovering Raspbian

Edit Images with GIMP

GET TO KNOW GIMP

Your Raspberry Pi can display images with its built-in Image View app but for any image editing you’ll need GIMP (GNU Image Manipulation 
Program). GIMP is a powerful software package for photo editing and is a great tool to install on your Raspberry Pi.

The name may be funny, but this image editing app is incredibly serious. The Raspberry Pi is 
perfectly adept at photo editing, and you can use GIMP to create icons, images and works of 
art for your programs.

STEP 1
Open terminal and enter: sudo apt install gimp 
to download and install the GIMP package. An alert 

will appear saying: “after this operation, 117 MB of additional disk 

space will be used. Do you want to continue [Y/n]?” Enter: y and press 

Return. GIMP will now be installed in Raspbian. GIMP is a lot larger 

than most programs you’ll install, so the installation takes longer.                                

STEP 3
Images can be opened in GIMP using File > Open or by 

right-clicking on files in File Manager and choosing 
GNU Image Manipulation Program. You can open multiple images at 

once in GIMP but each opens inside a different window. Choose 
Window > Single Window Mode to gather them together. Click on the 

tabs at the top of the screen to switch from one image to another.

STEP 2
When the installation has completed you will find 
GIMP under Menu > Graphics > GNU Image 

Manipulation Program. It has a more detailed interface than many 

Linux programs with two boxes, Tool Options and Brushes offering a 
range of image editing options. Users of software like Adobe 

Photoshop will feel right at home and it’s ideal for image editing.

STEP 4
You can perform powerful edits in GIMP but we 

don’t have space to go over them all. Probably the 

most useful you’ll find is Colours > Levels. This window enables you 
to adjust the tonal range and colour balance of an image. Drag the 

left and right handles in slightly and slide the centre handle to the 

right to improve the contrast of an image.
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EXPORTING IMAGES 

Save your images for use in a website.

STEP 5
To crop an image click the Rectangle Select Tool and 

drag a square on the image. Choose Image > Crop 

To Selection to remove the unwanted parts of the image. Use the 

Image > Scale Image and Image > Canvas Size options to adjust the 

image to specific sizes. Cropping and resizing images is a vital 
technique to know when working on websites.

STEP 6
There are a huge range of image effects and filters 
you can add to images using GIMP. Far more than 

we have room to cover here. Try Filters > Artistic > Cartoon to give 

your image a black outline or Filters > Artistic > Oilify to simulate a 

painted artwork. Take a look at www.gimp.org/tutorials for 

creative inspiration.

STEP 1
Images are saved using File > Save As in the xcf format 

(Experimental Computing Facility). This is GIMP’s 
native format so should only be used to save files you want to view 
and work on in GIMP.

STEP 3
The Export Image as JPEG window appears, displaying 

a Quality slider. The Quality range is from 0 (very 
poor) to 100 (perfect). While you might be tempted to set the quality 
at 100, reducing it slightly will create much smaller files. Smaller files 
ensure that your web page loads much more quickly. You can typically 

reduce the Quality to 80 and get a much smaller file with little 
discernible difference.

STEP 4
Right-click a JPEG image in the File Manager and 

choose Open With. Expand Internet and choose 

Chromium Web Browser and OK. This enables you to see how it will 

appear when you add it to your website. You can also view images 

more quickly by right clicking and choosing Image Viewer. You can use 

Save File As in Image Viewer to quickly change the image format.

STEP 2
If you want to save files for use in projects, such as 
websites, use File > Export. Click the File Type option 

and choose a file type; typically you will use JPEG for web images. 
Choose a Name and location and click Export.

Edit Images with GIMP
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More Apps

ADD/REMOVE

You can use the Add/Remove Software feature both on the Pi version of Raspbian as well as the Raspberry Pi Desktop version – whether it’s 
installed on a PC or in a virtual machine.   

While installing apps, or rather packages, is perfectly fine through the Terminal and the Apt 
command, there is an easier, graphical way. For most users, the Add/Remove software 
feature is better than the command line and here’s how it works.  

STEP 1
Begin by powering up Raspbian and getting to the 

desktop. From the menu, select Preferences > Add/

Remove Software. This will open a new window with various 

categories down the side of the screen. 

STEP 3
Now click on the OK button, located to the bottom 

right of the Add/Remove Software window. This will 

begin the installation of the selected package – note, it’ll also 

auto-select any other required packages in order to make the 

software work. 

STEP 2
These categories down the side of the Add/

Remove Software window denote the type of 

software package through which you want to search. For example, 

click on the Games category, then scroll down the list of available 

packages and tick the box next to ‘Side-scrolling game named 

Abe’s Amazing Adventure’.

STEP 4
Once the packages have been installed, you can find 
the software within the Pi Menu items. In this case, 

Abe’s Amazing Adventure is in the Games section of the menu. Click 

on the icon for the game, and it’ll load. To remove the newly 

installed software, simply re-open Add/Remove Software, un-tick 

the box and click OK again. 
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Learning 
Linux
In this section you will discover how the 

OS works, how the filesystem is built, 
and how you can list, move, create and 

delete files and folders. To truly be able 
to hack and master the Raspberry Pi, 

you will need to be familiar with the OS 

and its inner workings.
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What is Linux?
The Raspberry Pi operating system is Raspbian, which is a Linux operating system; but what 
exactly is Linux? Where did it come from and what does it do? In a world where Windows 
and macOS have supremacy of the desktop, it’s easy to overlook it, but there’s more to Linux 
than you might imagine.  

Linux is a surprisingly powerful, fast, secure and capable 
operating system. It’s used as the OS of choice for the 
Raspberry Pi, in the form of Raspbian OS, as well as in some 
of the most unlikely places.

Despite only enjoying a 1.96% share (according to 
netmarketshare.com) of the total desktop operating system 
market, Linux has a dedicated following of enthusiasts, 
users and contributors. It was created in 1991 by University 
of Helsinki student, Linus Torvalds, who had become 
frustrated with the limitations and licensing of the popular 
educational system Minix, a miniature version of the Unix 
operating system, in use at the time.

Unix itself was released in the early ‘70s, as a multi-tasking, 
modular-designed operating system originally developed 
for programmers who needed a stable platform to code 
on. However, its performance, power and portability meant 

that it soon became the system of choice for companies 
and universities where high-end computing tasks 
were needed.

Torvalds needed a system that could mirror Unix’s 
performance and features, without the licensing cost. Thus 
was born Linux, the Unix-like operating system which used 
freely available code from the GNU project. This enabled 
users around the world to utilise the power of the Unix-like 
system, completely free of charge, an ethos that still holds 
today: Linux is free to download, install and use.

Linux is much like any other operating system, such as 
Windows or macOS in that it manages the computer 
hardware, provides an interface for the user to access 
that hardware and comes with programs for productivity, 
communications, gaming, science, education and more. Linux 
can be broken up into a number of significant elements:

BOOTLOADER 
The bootloader is the software that initialises and boots 
up your computer. It loads up the various modules the OS 
uses to begin to access the hardware in the system.

KERNEL
The kernel is the core of the system and the single 
element that is actually called Linux. The Linux kernel 
manages the computer processor, memory, storage and 
any peripherals you have attached to your computer.

DAEMONS
Daemons are background services that start as the 
operating system is booting. These can enable printing, 
sound, networking and so on.

SHELL
The Linux shell is a command line interface environment, 
which a Linux user can use to enter commands to the OS 
that directly affect it. Within the shell you can add new 
users, reboot the system, create and delete files and 
folders plus much more. BASH (Bourne-Again Shell) is 
the most popular shell used in Linux, although others are 
available. The shell is also known as the Terminal and it’s 
where we’re going to work from through this section of 
the book.

GRAPHICAL SERVER
This is a module within Linux that provides a graphical 
output to your monitor. It’s referred to as the X server or 
simply X.

PROGRAMS/APPLICATIONS
As Linux is a free, open source operating system, it 
also makes good use of the tens of thousands of freely 
available applications. The likes of LibreOffice, GIMP and 
Python are just the tip of the iceberg.

DESKTOP ENVIRONMENT
The Desktop Environment, or DE, is the main Graphical 
User Interface (GUI) that users interact with. It’s the 
desktop and includes Internet browsers, productivity, 
games and whatever program or app you’re using. There 
are countless DEs available, however Raspbian uses PIXEL.
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What is Linux?

Linux is used throughout the world, in a number of basic and 
quite unique uses. While it may look radically different from one 
environment to the next, the actual Linux kernel, can be found 
in modern smart TVs, in-car entertainment systems and GPS, 

supercomputers, IoT devices and the Raspberry Pi. It’s used by 
NASA, both in the command centre and on-board the ISS. Linux 
servers power the backbone of the Internet, along with most 
of the websites you visit daily. Android utilises components 
of the Linux kernel, as do set top boxes, games consoles and 

even your fridge, freezer, oven and washing machine.

Linux isn’t just a free to use operating system. It’s stable, powerful and 
fast, easily customised and requires very little maintenance. However, it’s 
more than just performance stats; Linux means freedom from the walled 
garden approach of other operating systems. It’s a lively community of 
like-minded individuals who want more from their computers without the 
shackles of price or conformity. Linux means choice.

Tux, the Linux mascot 
(Linus likes penguins).

Linus Torvalds, the creator 
of the Linux kernel.

Raspbian on the 
Raspberry Pi, is the 
Linux distribution 
of choice. 

A Desktop Environment can be as 
complex or as simple as the user desires.
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Using the Filesystem

GETTING AROUND

To drop into the Terminal, click on the fourth icon from the left along the top of the Raspberry Pi desktop, the one with a right-facing arrow 
and an underscore. This is the shell, or Terminal.  

To master Linux, it’s important to understand how the filesystem works. What’s more, 
it’s also important to become familiar with the Terminal, or shell. This command line 
environment may appear daunting at first, but with practise, it soon becomes easy to use.

STEP 1
First, you’re going to look at directories and the 

directory path. A directory is the same thing as a 

folder, however in Linux it’s always called a directory. These are 

placed inside each other using a “/” character. So when you see /

home/pi it means the pi directory is inside the home directory. 

Enter: clear and press return to clean the screen. Now enter: pwd. 

This stands for Print Working Directory and displays /home/pi.

STEP 3
Enter: ls to view the contents of the current 

directory. You should see Desktop, Documents, and 

Downloads and Scratch in Blue. You may also see other items 

depending on how much you have used your Raspberry Pi. The colour 

code is worth knowing: directories are blue while most files are white. 
As you go on you’ll see other colours: executable files (programs) are 
bright green, archived files are red and so on. Blue and white are the 
two you need to know to get started.

STEP 2
When you log in to your Raspberry Pi, you don’t 

start at the base of the hard drive, known as the 

‘root’ (also known as the topmost directory). Instead you begin 
inside your user directory, which is named ‘pi’ by default and is 

itself in a directory called ‘home’. Directories are indicated by the ‘/’ 

symbol. So, “‘/home/pi’” tells you that in the root is a directory 

called home, and the next “‘/’” says that inside “home” is a directory 

called “pi”. That’s where you start.

STEP 4
Now you’re going to move from the pi directory into 

the Documents directory. Enter: cd Documents. 

Note the capital “D”. Linux is case sensitive, which means you have to 

enter the exact name including correct capitalisation. The cd 

command stands for change directory. Now enter: pwd again to view 

the directory path. It will display /home/pi/ Documents. Enter: ls to 

view the files inside the Documents directory.
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ABSOLUTE VS RELATIVE PATHS

It is important to know the difference between the working directory, root directory and home. There are also two types of path: Absolute 
and Relative. These are easier to understand than they sound. Let’s take a look…

STEP 5
How do you get back up to the pi directory? By using 

a command “cd ..”. In Linux two dots means the 

directory above, also known as the parent directory. Incidentally, a 

single dot “.” is used for the same directory. You never use “cd .” to 

switch to the same directory but it’s worth knowing because some 

commands need you to specify the current directory.   

STEP 6
The “ls” and “cd” commands can also be used with 

more complex paths. Enter: ls Documents/

Pictures to view the contents of a Pictures directory inside your 

Documents directory. You can switch to this directory using cd 

Documents/Pictures; use cd ../.. to move back up two 

parent directories.

STEP 1
By default, commands like “ls” use the working 

directory. This is the current directory that you’re 

looking at and is set to your home directory by default (/users/pi). 
Using “pwd” (Print Working Directory) lets you know what the working 
directory is, and using “cd” changes the working directory.

STEP 3
The second command (“ls /Documents/Pictures”) 
attempts to list the content of Pictures in a directory 

called Documents inside the root directory (because the path started 
with ‘/’, which is root). There is typically no Documents directory in 
root, so you will get a “No such file or directory” error. Starting a path 
with ‘/’ is known as an “absolute path”, while starting without the ‘/’ is 

known as a “relative path” because it is relative to your 

working directory.

STEP 4
There is also an absolute path shortcut to your user 

directory, and that is the tilde “~” character. Entering: 

ls ~ always lists the contents of your home directory, while “cd ~” 

moves straight to your home directory, no matter what your working 

directory is. You can also use this shortcut wherever you are: enter: ls 

~/Documents/Pictures to display the contents of the Pictures.

STEP 2
The root directory is always ‘/’. Entering: ls / lists the 

contents of root, and entering: cd / switches to the 

root directory. This is important because there is a difference between 
“ls Documents/Pictures” and “ls /Documents/Pictures”. The first 
command lists the contents of the Pictures directory in Documents 

inside the working directory (which, if you are in the home directory, 
will work). 

Using the Filesystem
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Listing and Moving Files

LOOKING AT FILES     

Operating systems are built on files and folders, or directories if you prefer. While you’re used to viewing your own files, most operating 
systems keep other files out of sight. In Raspbian, you have access to every file in the system.  

Admittedly, using the desktop GUI to list and move files is much easier than using the 
Terminal and keyboard. However, it’s an important skill that you will appreciate as you 
advance with the Raspberry Pi and Linux.   

STEP 1
We’ve already looked at “ls”, which lists the files in 
the working directory, but you are more likely to use 

a command like “ls –l”. The bit after the command (the ‘-lah’) is 
known as the argument. This is an option that modifies the 
behaviour of the command. 

STEP 3
After the permission letters come a single number. 

This is the number of files in the item. If it’s a file then 
it’ll be 1, but if it’s a directory it’ll be at least 2. This is because each 

directory contains two hidden files; one with a single dot (.) and one 
with two dots (..). Directories containing files or other directories will 
have a higher number.

STEP 2
The “-l” argument lists files and directories in long 
format. Each file and directory is now on a single line, 

and before each file is a lot of text. First you’ll see lots of letters and 
dashes, like ‘drwxr-xr-x’. Don’t worry about these for now; they are 

known as ‘permissions’ and we’ll come to those later.

STEP 4
Next you’ll see the word “pi” listed twice on each 

line. This refers to the user rather than the name of 

your computer (your default username is “pi”). The first is the owner 
of the file, and the second is the group. Typically these will both be 
the same and you’ll see either ‘pi’ or ‘root’. You can enter: ls -l / 

to view the files and directories in the root directory that belong to 
the root account.
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STEP 5 The next number relates to the size of the file, in bytes. 
In Linux each text file is made up of letters and each 

letter takes up a byte, so our names.txt file has 37 bytes and 37 
characters in the document. Files and directories can be extremely 

large and hard to determine, so use “ls – lh”. The “h” argument 

humanises the number, making it easier to read.

STEP 6 Finally, you should be aware that there are many 

hidden files in Linux. These are listed using the “-a” 
argument. Hidden files and directories begin with a dot (.), so you 
should never start a file or directory with a dot, unless you want to 
hide it. Typically, you can combine all three arguments together into 

the command ‘”s –lah”.

STEP 1 Enter: ls -lah / to view all of the files and 
directories, including the hidden items, in the root 

directory of your hard drive. Here you will see all the items that make 
up your Raspbian OS (which is a version of Linux). It’s worth taking the 
time to know some of them.

STEP 3 Entering: ls /home displays the contents of your 
home directory, which contains pi; the directory 

that you start in. So, entering: ls/home/pi is the same as just “ls” 
from the default home directory. This is where you are expected 
to place most of the documents you create. Don’t confuse home 
with “usr”; the /usr directory is where find you find program tools 
and libraries.

STEP 4 Lib is a directory that contains libraries of code that 
are referred to by other programs (different programs 

share files in Lib). “Var” is short for various, which is mostly files used 
by the system, but you may need to work with items here. Finally there 
is a directory called “tmp”, which is for temporary files; files placed 
here are on your system for the short term and can be deleted from 
the system.

STEP 2 Bin is a directory that stores binaries. This is the Linux 
way of saying programs or applications. Sbin is for 

system binaries, which are the programs that make up your system. 
Dev contains references to your devices: hard drive, keyboard, mouse 
and so on. Etc contains your system configuration files.

Listing and Moving Files

SOME COMMON DIRECTORIES

Now that you know how to view the contents of your hard drive you’ll start to notice a lot of directories with names like bin, sbin, var and 
dev. These are the files and directories that you are kept away from on a Mac, and won’t encounter on a Windows PC. 
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Creating and Deleting Files

CREATING FILES

Once you learn to recognise the files and directories that make up Raspbian OS, it’s time to discover how to make your own. Knowing how to 
make, edit and delete files and directories is essential if you want to make your own projects.

Being able to create and delete a file is an everyday computing skill. However, when using the 
Linux Terminal, there’s an element of care required, chiefly because any deleted files aren’t 
placed in the system recycle bin. 

STEP 1
We’re going to create a file using a command called 
Touch. Touch is an interesting command that reaches 

out to a file, or directory, and updates it (this changes the system time 
as if you’d just opened the file). You can see Touch in access using “ls 
–l” and checking the time next to a directory (such as Scratch).

STEP 3
If you try to touch a file that doesn’t exist, you create a 
blank file with that name. Try it now. Type touch 

testfile and ls –l to view the files. You’ll now have a new file in 
your home directory called “testfile”. Notice that the size of the file is 
0, because it has nothing in it.

STEP 2
Now enter: touch Scratch and ls –l again and 

notice that the time has changed. It now matches the 

current time. You might be wondering what this has to do with 

creating files or directories. Touch has a second, more popular, use, 
which is to create files.

STEP 4
A quick word about file names: remember that Linux is 
case sensitive, so if you now enter: touch Testfile 

(with a capital T), it doesn’t update ‘testfile’; instead, it creates a 
second file called ‘Testfile’. Enter: ls –l to see both files. This is 
confusing, so most people stick with using lowercase letters at 

all times. 
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REMOVING FILES

We’ve created some files that we don’t want, so how do we go about removing them? It turns out that deleting files in your Raspberry Pi is 
really easy, which may be a problem, so be careful.

STEP 5
Another important thing to know is never to use a 

space in your file names. If you try to enter: touch 
test file, you create a document called “test” and another called 

“file”. Technically there are ways to create files containing a space but 
you should always use an underscore character (“_”) instead of a 
space, such as “touch test_file”.

STEP 6
Here are some other files names to avoid: 
#%&{}\<>*?/$!’”:@+`|=. The full stop (.) is used to 

create an extension to a file; usually used to indicate a file type, such 
as textfile.txt or compressedfile.zip, and starting a file with a full stop 
makes it invisible. Don’t use a full stop in place of a space though; stick 

to underscores.

STEP 1
Enter: ls –l to view the files in your home directory. 
If you’ve followed the steps before then you should 

have three files: “test”, “testfile”, and “Testfile”. We’re going to get rid 
of these items because they were created as an example.

STEP 3
We’re going to use a wildcard (*) to delete our next 
two files, but again this is something you really need 

to do with care. First use “ls” to list the files and make sure it’s the one 
you want to delete. Enter: ls test* to view files that match the 
word “test” and any other characters. The “*” character is called a 

“wildcard” and it means any characters here.

STEP 4
We see that “ls test*” matches two files: “test” and 
“testfile”, but not the file called “file”. That’s because 

it didn’t match the “test” part of “test*”. Check carefully over groups 

of files you want to remove (remember you can’t recover them) and 
replace the “ls” with “rm”. Enter: rm test* to remove both files. 
Finally enter: rm file to get rid of the confusing file.

STEP 2
To get rid of files you use the “rm” command. Enter: 
rm Testfile to delete the file called “Testfile” (with 

the uppercase “t”). Enter: ls –l and you’ll find it’s gone. Where is 
it? It’s not in the Trash or Recycle Bin, like on a Mac or Windows PC. 
It’s deleted completely and cannot be recovered. Bear this in mind 
and always think before deleting files. 

Creating and Deleting Files
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Create and Remove 
Directories

MANAGING FILES AND DIRECTORIES

Now that you know how to create files, you’ll want to learn how to make directories, which are the same thing as folders, as well as move 
items around. If you are more used to working with a desktop interface, this can take a bit of getting used to.

Creating, moving and deleting directories isn’t as easy in the Terminal as it is within a 
desktop interface. You need to tell Linux to move the directories inside other directories, a 
process known as recursion. Sounds complex but you should quickly get the hang of it.  

STEP 1
Enter: ls to quickly view all the directories currently in 

in the home location. Directories are created using the 

“mkdir” command (make directory). Enter: mkdir testdir to create 

a new directory in your home directory. Enter: ls again to see it. 

STEP 3
Like touch, you can create multiple directories at once 

with the mkdir command. Enter: mkdir testdir2 

testdir3 and enter: ls. You’ll now find several directories called 
testdir. Also, like files, you should know this means you can’t (and 
really shouldn’t) create directories with spaces. As with files, use an 
underscore (“_”) character instead of a space.

STEP 2
The “mkdir” command is different to touch, in that it 
doesn’t update the timestamp if you use it with a 

directory that already exists. Enter: mkdir testdir again and you’ll 

get the error “mkdir: cannot create directory ‘testdir: File exists”. 

STEP 4
You can create directories inside of each other using 

the directory path. Enter: mkdir Documents/

photos to create a new directory called “photos” inside your 

documents directory. The directory has to already exist, though, try to 

enter: mkdir articles/reports and you’ll get an error because 

there is no articles directory.
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GETTING RID OF DIRECTORIES

Deleting directories is pretty easy in Linux, along with files, and this can be a problem. It’s too easy to delete entire directories containing 
files and these are instantly removed, not sent to a trash directory. Tread carefully.

STEP 5
To create a directory path you need to pass in the “p” 

option to mkdir (which stands for “parents”). Options, 
if you remember, come after the command and start with a ‘-’. So 

enter: mkdir -p articles/reports. Enter: ls to view the articles 

directory, or “ls articles” to view the reports directory sitting inside.

STEP 6
Now you’re starting to get a bit more advanced, we’re 

going to just reiterate something. In Linux the 

command structure is always: command, option and argument, in that 

order. The command is the function, next are the options (typically 
single letters starting with “-”) and finally the argument (often a file, or 
directory structure). It’s always command, option then argument.

STEP 1
We’re going to remove one of the directories we 

created earlier using the “rmdir” command. Enter: ls 

to view the files and directories in the current directory. We’ll start by 
getting rid of one of the test directories. Enter: rmdir testdir3 and 

ls again to confirm the directory has been removed.

STEP 3
To delete a directory containing files or other 
directories, you return to the “rm” command used to 

remove files, only now we need to use the “-R” option (which stands 
for “recursive”.) Using “rm –R” removes all the files and directories to 
whatever you point it at. Enter: rm -R articles to remove the 

articles directory. 

STEP 4
As with multiple files, you can delete multiple 
directories inside the same directory using the “rm” 

command with the wildcard character (*). This should be done with 
care though so use the -I option (which stands for “interactive”). This 
will prompt you before each deletion. Enter: rm -Ri test* and 

press Y and return to each prompt. It’s a good idea to use the -i 

option whenever using the rm command.

STEP 2
Now we’ll try to get rid of the articles directory 

(containing the reports directory). Enter: rmdir 
articles and press return. You’ll get an error saying “rmdir: failed to 

remove ‘articles’: Directory not empty”. This is a puzzler; the rmdir 

command only removes directories that having nothing in them (no 
files or other directories).

Create and Remove Directories
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Copying, Moving and 
Renaming Files

USING THE MOVE COMMAND

In Linux, renaming a file is simply moving it from one name to another and copying a file is moving it without deleting the original. Don’t 
panic, it’s quite easy to master. 

Taking command of the Terminal is essential when learning how your Raspberry Pi’s 
operating system works. The copying, moving and renaming of files is equally important, as 
you’ll be doing a lot of this throughout your Pi projects. 

STEP 1
Before we can move anything around, we need to 

have a few test items in our home directory. Enter: 

touch testfile and mkdir testdir to create a test file and test 
directory in your home directory. Enter: ls to check that they are 

both present.

STEP 3
Enter: mv testfile testdir and press return to 

move the testfile document into the testdir directory. 
Enter: ls to see that it’s no longer in the home directory, and ls 

testdir to see the testfile now sitting in the testdir directory. Now 
enter: mkdir newparent to create a new directory.

STEP 2
Files and directories are moved using the mv 

command. This is different to the commands we’ve 
looked at so far because it has two arguments (remember Linux 
command line is command, option, argument). The first argument is 
the source (the file or directory to be moved) and the second is 
the destination.

STEP 4
Directories with files are moved in the same way. 
Enter: mv testdir newparent to move the testdir 

directory inside the newparent directory. Let’s move into the directory 

to find the file. Enter: cd /newparent/testdir and enter: ls to 

view the testfile sitting inside the directory.
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The mv command isn’t used just to move files; it also serves the purpose of renaming files (effectively it moves it from its old name to a new 
name). Let’s see how to use mv to rename items.

STEP 5
Files and directories can be moved up using the 

double dot (“..”) as an argument. Enter: ls –la to 

view your testfile and the single and double dot files. The single dot is 
the current directory and the double dot is the parent directory. Enter: 

mv testfile .. to move the testfile up into the newparent 
directory. Enter: cd .. to move up to the parent directory.

STEP 6
You can also move files using longer paths. Enter: 
cd ~ to return to the home directory and 

mv newparent/testfile newparent/testdir/testfile to 

move the testfile from its current location back inside the testdir 
directory. Enter: ls newparent/testdir to view the file back in its 
current directory. 

STEP 1
Let’s start by making a new test file called “names”. 
Enter: touch testfile and then ls to make sure the 

testfile is present. We’re going to turn this into a file that contains the 
names of some people. So let’s call it something more appropriate, 
like “names”.

STEP 3
You can rename directories inside other directories 
using paths. Let’s rename the testdir directory, which 

is now inside the people directory. Enter: mv names/testdir 
names/friends. Now enter: mv names people/friends to move 

the names file inside the friends directory. 

STEP 4
It is easy to overwrite files using the mv command, 
so if you have files with the same name use the 

“-n” option, which stands for “no overwrite”. Enter: touch 
testfile to create a new file and mv -n testfile people/
friends. There’s no error report though, enter: ls and you’ll find 
testfile still there.

STEP 2
Enter: mv testfile names and ls. Now we can see 
the new “names” file in our directory. The mv 

command can also be used to rename directories. We should still have 
our newparent directory in our home directory. Enter: mv newparent 
people to rename the newparent directory. Enter: ls to view it.

Copying, Moving and Renaming Files

RENAMING FILES AND DIRECTORIES
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Using the Man Pages

HEY, MAN!
The man pages are one of the best features of Linux, and as a built-in tool it’s invaluable for both beginner and senior level Linux 
administrators. Let’s see how it works

Linux comes with man (manual) pages that explain each command and show you all the 
options you can use. Once you get the hang of reading the man pages, you’ll be able to find 
and do just about anything in Linux.  

STEP 1
Linux has a built-in manual, known as man for short. 

Using the man command you can obtain information 

on all the Linux commands we’ve talked about. Simply enter: man and 

the name of the command you want to learn more about. Start by 

entering: man ls in the command line.

STEP 3
Most commands are pretty easy to figure out how to 
use, so what you spend most of the time in the man 

pages is looking under the Description. Here you will see all the 

options and the letters used to activate them. Most man pages are 

longer than a single page, so press any key, such as the space bar, to 

move to the next page of content.

STEP 2
The man pages are a bit more detailed than you might 

be used to. First you have a name, which tells you 

what the command is called; in this case “list directory contents” and 

then the synopsis shows you how it works. In this case: “ls [OPTION].. 

[FILE..]”. So you enter: ls followed by options (such as -la) and the 
file or directory to list.

STEP 4
Press the H key while looking at a man page to view 

the commands you can use to control the view. This is 

called the Summary of Less Commands (the less command is 
something we’ll come to when we look at editing text). For now 
realise that you can move back and forward with Z and W. Press Q to 
quit this help screen and return to the man page. 
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USING MAN OPTIONS

Because man doesn’t change anything, like mv or mkdir, it is tempting not to see it as a command. But it is, and like all other commands it has 
options. These can be very handy to learn.

STEP 5
Scroll to the bottom of the man page to discover more 

information. Typically you will find the author’s name 
and information on reporting bugs, including web links that can be 

useful for more information. Press Q to exit the man page and return 
to the command line. 

STEP 6
The man command can be used for just about every 

command you use in Linux. You can even enter: man 

man to get information on using the man tool. From now on, 

whenever you come across a new command in this book, such as 

“nano” or “chmod”, take time to enter: man nano or man chmod and 

read the instructions.

STEP 1
Entering: man man enables you to view some of the 

options, but sometimes you’ll just want a quick 

overview. Fortunately man has a built-in help option that quickly lists 

the options. Press Q if you’re in a man page and enter: man –h at the 

command line.

STEP 3
One of the most powerful man options is the -k option, 

which is for “apropos”. This enables you to search a 

wider range of man pages than the exact command. Enter: man -k 

directory to view all of the man pages relating to directories “(man 
-k directory | less” to view one page at a time). Here you’ll find 
commands like “ls”, “mkdir” and “cd” along with their description.

STEP 4
Entering the man page for all the commands you 

come across can be a little long-winded, although 

ultimately productive. If you simply want to know what a command 

does you can read just the description using the “whatis” command. 

Enter: whatis pwd to read the description of the “pwd” command 

(“print name of current/working directory”).

STEP 2
If you’re fast you may have noticed the start of the 

text flew up off the page. This is because the “man –h” 
option doesn’t use the less command by default (less is what enables 
you to move down text one screen at a time). We’ll look into pipes (“|”) 
later on, but for now just use “man -h | less” to read long text one page 

at a time.

Using the Man Pages
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Editing Text Files

THE JOY OF TEXT

To be able to edit or create a text file, you need a good text editor. Linux has many but here are some in action on the Raspberry Pi. 

A text file in Linux can be anything from a simple set of instructions on how to use an app, to 
some complex Python, C++ or other programming language code. Text files can be used for 
scripting, automated executable files, as well as configuration files too.  

STEP 1
The first text editor for the Raspberry Pi is the default 
desktop environment app: Leafpad. To use, you can 

either double-click an existing text file or click the Raspberry Pi menu 
icon (in the top left of the desktop) and from the Accessories menu, 
choose Text Editor.

STEP 3
Vi is the original Unix command but in this case it 

launches VIM, the new Linux version of Vi. Although 

simple looking, Vi is considered, even by today’s standards, to be one 

of the most widely used text editors, There’s a lot you can do with it, 

so check out the man pages for more Vi information. 

STEP 2
From the Terminal there are even more options, 

although using the correct command, you can launch 

any of the desktop apps via the Terminal. One of the simplest, and a 

classic text editor that’s carried over from the Unix days, is vi. In the 

Terminal, enter: vi. 

STEP 4
Nano is another favourite, and simple, text editor 

available for Linux. Enter: nano into the Terminal to 

launch it. You can use Nano for editing code, creating scripts or writing 

your own help files. To exit Nano, press Ctrl + X, followed by Y to save 
the file or N to exit without saving.
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STEP 5
Emacs, or GNU Emacs, is an extensible and 

customisable, self-documenting, real-time display 

editor. It’s a fantastic text editor and one that’s worth getting used to 

as soon as you can. Sadly, it’s not installed on the Pi by default, so 

you’ll need to install it. In the Terminal, enter:  

sudo apt-get install emacs  

STEP 8
Emacs can offer an uncomplicated view of your text 
file or one with a plethora of information regarding 

the structure of the file in question; it’s up to you to work out your 
own preference. There’s also a hidden text adventure in Emacs, which 

we cover later in this book, why not see if you can find it without 
our help.

STEP 6
The previous command contacts the Debian (Raspbian 
is based on a Debian Linux distribution) repositories 

and pulls down the information needed to install Emacs. When the Pi 

asks to continue with the installation, press Y. This installs the latest 

version and when it’s done, you’ll be back to the command prompt.  

STEP 9
Gedit is another excellent text editor for Linux. Again, 

it’s not installed by default on the Raspberry Pi; 

however, by entering: sudo apt-get install gedit and 

accepting the installation, the program can be on the Pi in a matter of 

seconds. Once it’s installed, use gedit in the Terminal to launch it. 

Gedit is a great text editor for coding. 

STEP 10
Finally, Jed is an Emacs-like, cross-platform text editor 

that’s lightweight and comes with a wealth of 

features. To install it, enter: sudo apt-get install jed. Accept 

the installation and when it’s complete, use: jed to launch.  

STEP 7
Once the installation is complete, enter: emacs into 

the Terminal. The Emacs splash screen opens in a new 

window, offering a tutorial (which we recommend you run through) 
and a guided tour amongst other information.  

Editing Text Files
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Getting to Know Users

WHAT IS A USER?
An important part of using Linux is the concept of users and understanding which user you are and which group you belong to. Like all 
modern computers, you can have multiple user accounts with each having different levels of access.    

You might think you’re the only person using your Raspberry Pi but there are several different 
users and even groups of users. Your main account is normally called Pi and there is an 
account above it called root, which is more powerful. You can also create users and groups.   

STEP 1
The first thing you need to do is get a concept of 
which user you are. Enter: whoami into the command 

line and press return. It should say “pi” (unless you set up your account 
name differently during setup). The “whoami” command might seem a 
bit simplistic, but it comes in very handy sometimes.

STEP 3
To allow this, you need to use the sudo command. 

Sudo loosely stands for Substitute User Do; essentially 

it’s the highest level of access to the system and you’ve already 

installed text editors using sudo. You’ll come across sudo frequently in 

Linux, so let’s create a second account to get the hang of it. Enter: 

sudo useradd -m lucy (or pick your name). 

STEP 2
When you are working in Linux, from time to time a 

‘Permission denied’ error will occur, typically when you 

try to create, edit or execute (run) a file or directory outside of your 
area of privilege. If you want to see this, enter: mkdir /testdir. 

Attempting to create a new directory in your root directory 

isn’t allowed.

STEP 4
Now add a password for the new account. Enter: sudo 

passwd lucy and enter: a short password. Retype 

the same password and you’ll now have two accounts on your 

Raspberry Pi. Now enter: ls -l /home to view the home directories 

for both users. Notice that the lucy directory lists lucy as the owner 

and group; and pi directory is belongs to pi.
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We now have two accounts on our Raspberry Pi: lucy and pi. The lucy account can edit files in /home/lucy and the pi account can edit files in /
home/pi. But there’s also a third account, called “root”, that sits above both lucy and pi. It can edit files anywhere.

STEP 5
Let’s try switching to our new account. Enter: su 

lucy and enter the password you just created for that 

account. Notice that the command line now says “lucy@raspberrypi” 

but the working directory is “still /home/pi” (check this using “pwd”). 
Enter: whoami to confirm that you are now the new user.

STEP 6
We’ll look at permissions in the next tutorial, but for 

now try to create a file as before. Enter: touch 
testfile to create a file. It will say “touch: cannot touch ‘testfile’: 
Permission denied”. This is because your new user account doesn’t 

have the right to create files in the /home/pi directory. Enter: su pi 

to switch back to your pi account.

STEP 1
The root account is all-powerful. It is possible, but not 
recommended, to switch to the root account, although 

you’ll need to give it a password first (using “sudo passwd root”). Then 
just type “su” to switch to root. Please don’t do this though: 
knowledge is a good thing but it’s safer and wiser to use sudo instead.

STEP 3
It’s rare that you use sudo to substitute another user. If 
you don’t specify a user using the “-“u option with a 

username it defaults to the root account, as if you’d typed “sudo -u 
root”. Enter: sudo touch /home/lucy/anothertestfile to 

create a file in the lucy directory while still using the pi account. 

STEP 4
This step is optional. Only the pi user can use sudo. If 
we want to give the lucy account sudo privileges, it 

needs to be added to the sudoers file. Enter: sudo visudo to view 
the sudoers file. Add lucy ALL=(ALL) NOPASSWD: ALL to the last 

line and use Control+O to output the file. Remove the “.tmp” that is 
added to the file name as a security measure. Note that most accounts 
are not added to the sudoers file as a matter of course.STEP 2

Most people think sudo stands for “super user”, but it 
stands for “substitute user do”. It enables you to 

perform a command as another user. Enter: sudo -u lucy touch /
home/lucy/test to create a file inside the lucy home directory. You 
won’t get an error because the lucy user has permission to edit 
that directory.

Getting to Know Users

GETTING SUDO
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Ownership and 
Permissions

OWNER AND PRIVILEGE

Each user account in Linux is an owner of a section of the filesystem: their Home area. Within this area, they do what they like (within 
reason), as they have owner privileges. Elsewhere though, they usually just have read-only privileges.   

Once you’ve got the hang of users, you need to learn about ownership and permissions. 
Different users have different areas of ownership and can do different things with each file. 
Permissions in Linux can be quite complex but with careful thought it’s not too difficult.  

STEP 1
If you followed the previous tutorial you should now 

have two accounts on your Raspberry Pi. One called 

“pi” and the other with a name (Lucy in our case). An essential aspect 
of Linux is the idea of file and directory ownership; who owns, and has 
access, to what. You need a test file so enter: touch testfile.

STEP 3
The first letter in the permissions also indicates a 
directory or file. Notice that all the other files start 

with a ‘d’ and our textfile.txt file starts with a ‘-’. That’s what the first 
letter means. It’s either a ‘d’, in which case it’s a directory, or a ‘-’, in 

which case it’s not; it’s a file. Enter: ls -l testfile.txt to view the 

permissions for just this file.

STEP 2
Now enter: ls –l and let’s have a good look at the 

default permissions file. Our testfile.txt files starts 
with the text “-rw-r--r—“. Start with the first letter, which is a dash ‘-’. 
All the other items in our home directory are directories. You can tell 

because they are blue, and our testfile.txt file is white. 

STEP 4
The next nine letters of the permissions are known as 

“alpha notation” because they let you know the 

permissions using letters. Each permission is either on, in which case 

you see a letter, or it is off, in which case you see a dash. The letter 
doesn’t change for each place. So the first permission - the second 
letter after the directory one -  is either an ‘r’ or a ‘-’. It’s never any 

other letter.

b0317180-1dbc-4fe7-b445-0fab5a6a6c7ab0317180-1dbc-4fe7-b445-0fab5a6a6c7a



69www.bdmpublications.com

CHANGING PERMISSIONS

Now that you know how groups of permissions work, it’s time to look at how to change them.

STEP 5
The ‘r’ means that particular permission is read and it’s 

set to On. The nine letters here are divided into three 

groups of three letters: r, w, x. They stand for read, write and execute 

(run). Read means the file can be viewed (using cat or nano); w means 
the file can be edited or moved, and x means the file - typically a script 
or program - can be run. 

STEP 6
The presence of r, w, or x means that this aspect is 

possible, a dash means it isn’t. Our testfile.txt has no x 
letter; so if it were a script it wouldn’t run. So why are there so many 

letters? Why not just three; read, write and execute? The three blocks 

of three letters are for different sets of people: user, group and other. 

STEP 1
The first block of three is the most important. This is 
the user who owns the file (typically pi); the second is 

for other people in the same group as the user, and the third is for 

other people on the system. Permissions are changed using the 

chmod (change file mode bit) command. Enter: man chmod to look at 

the manual.

STEP 3
Turning everything on is probably overkill, so you need 

to target each group. Do this by putting commas 

between each mode option. Enter: chmod u=rwx,g=rw,o=r 
testfile.txt to give users read, write and execute privileges, user 

read and write and other just read. Enter: 

ls –l to see your handiwork.

STEP 4
Alpha notation is fine, but many Linux admins use 
octal notation instead. This is a three-digit number 

that represents permissions. This is the formula: read=4, write=2 and 

execute=1 and you add them up for each group, therefore if a group is 

read, write and execute it’s 7, if it’s read and write it’s 6 or if it’s just 

execute it’s 1. A popular option is 755. Enter: chmod 755 testfile.
txt to change the file using octal notation.

STEP 2
The chmod command is one of the trickier ones to 

understand. There are two ways you can adjust 

permissions; the first is using chmod with an option to target one of 
the three groups: owner, group, other. For these you use u, g or o 

followed by = and the letters or dashes you want. So enter: chmod 

ugo=rx testfile.txt to make all three groups read, write 

and execute.

Ownership and Permissions
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STEP 2

Remember that cat is 

used to list the 

contents of a text file, 
which is what cpuinfo 

is. There are other text 

files with system info 
available. Try “cat /

proc/meminfo” to get 

information about your 

memory, “cat /proc/

partitions” for 

information about your 

SD card, and “cat /proc/

version” shows which 

version of Raspberry Pi 

you are using.

Useful System and 
Disk Commands

LOTS OF LINUX

Linux is a huge and versatile command line language and there are hundreds of commands you can learn and use. Here are a few that can 
help you get more from your Raspberry Pi.    

Understanding these core Linux commands will enable you to not only master the inner 
workings of your Raspberry Pi but also to transfer those skills to other Linux distros, such as 
Ubuntu or Linux Mint.   

STEP 1
The Raspberry Pi is a great little computer, so let’s 

start by getting some information. Enter: cat /

proc/cpuinfo to view some details on your Raspberry Pi processors. 

If you have a Raspberry Pi 3 you will see four processors, along with 

the model name and other info.

STEP 3
Enter: uname to view the name of the operating 

system’s kernel, this is the element that sits between 

the interface and hardware. Just as you would suspect, the response 

from the command is Linux, as Raspbian is a Linux distro, which in 

itself is based on another Linux distro called Debian. While it may 

sound complicated, it actually demonstrates how versatile Linux is.

STEP 4
Enter: uname –a to view some more detailed 

information. Here you’ll see the kernel name, 

hostname and kernel version (3.18.7-v7 on ours). If you have a 
Raspberry Pi 2 you’ll see SMP (symmetric multiprocessing), 
followed by the system date, CPU architecture and operating 

system (GNU/Linux). 
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DISK COMMANDS

Learn the two commands that enable you to view your disk space and the files on it: df (disk free space) and du (disk usage). With these two 
commands you can view the file usage on your SD card.

STEP 5
Enter: vcgencmd measure_temp to view the current 

operating system temperature of your Raspberry Pi.  

Enter: vcgencmd get_mem arm to view the RAM available, and 

vcgencmd get_mem gpu to view the memory available to the 

graphics chip. Finally try ls usb to view a list of attached USB devices.

STEP 6
One command you might be wondering about is how 

to switch off or restart your Raspberry Pi from the 
command line. Don’t just hit the power switch. Enter: sudo 

showdown –h now to shut down the Raspberry Pi  (the “-h” option 
stands for “halt”), or enter: sudo shutdown –r now to restart your 

Raspberry Pi.

STEP 1
Start by entering: df in the command line. It returns a 

list of the volumes contained on your SD card. You 

might be wondering what a volume is. It’s best to think of your SD card 

as the drive. This contains partitions, which is where you split one drive 

to act like two or more drives. And each partition can contain volumes, 

which are storage spaces. 

STEP 3
Now enter: du. You should see lots of text fly up the 
screen. This is the disk usage for the files contained in 

your home directory and their sub-directories. As with df, it is better to 

use du with the “-h” option to humanise the output. If you want to 

slow down the output, you’ll also need to pipe it through less. Enter: 

df -h | less to view the files and their respective usage one page 
at a time.

STEP 4
You don’t typically enter: du on its own; most of the 

time you want to view the disk usage of a specific 
directory. Enter: du -h python_games to view how much space the 

python_games directory (installed alongside Raspbian) takes up. It 
should be 1.8M. If you want a more comprehensive breakdown of the 

files contained, use the “-a” option (all). Enter: du -ha python_
games to view all the files contained and their disk usage. 

STEP 2
Enter: df –h to get the list in human readable form. 

The first two lines should read “rootfs” and “/dev/
root” and have matching Size, Used, Avail and Use% listings. This is the 

main drive, and is an indication of how much space you have used, and 

have free, on your Raspbian OS. The other volumes are for booting 

and initialising devices (you can ignore these for now).

Useful System and Disk Commands
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Managing Programs 
and Processes

PROGRAMS AND PROCESSES

Linux has a trick up its sleeve when it comes to being able to manage programs and processes. When Windows closes a program, the 
allocated memory often isn’t freed up again. However, Linux is far more streamlined.    

Being able to effectively manage the active programs and processes on your Raspberry 
Pi allows you to change the way the systems work. If you have a project requiring more 
memory, you can kill a process to free up the available system resources.  

STEP 3
If you type in “ps” on its own you don’t see much. You 

should see two items: bash and ps. Bash (Bourne 
Again Shell) is the command line environment you are typing in, and ps 
is the command you just entered. If that seems a little light, that’s 

because it is. These are just the processes owned by the user and are 

running in the foreground.

STEP 2
You’re probably used to thinking in terms of programs 

and most OS’s tend to keep processes out of sight. In 

Linux on the other hand, you’re right in at the deep end. A process is 

like a program, only it’s a single task running on your computer. 

Programs as you know them, may be a single process, or multiple 

processes working together. In Linux, you should learn to manage 

processes. This is done using the “ps” (process status)  command.

STEP 4
If you want 

to see 

processes used by other 

users (including those 
started by root) enter: ps 
–a. The option stands for 

all users. This still isn’t 

everything though 

because it doesn’t include 

background processes. For 

this you can enter either 

“ps –A” or “ps –e”. This will 

show you every process on 

the system including the 

background processes. You 

may need to pipe it 

through less using 

“ps -e | less”.

STEP 1
As you get 

into Linux 

you’ll start to hear more 

about processes and 

another thing called the 

“kernel”. The kernel sits 

beneath the software and 

hardware. It passes 

instructions to the 

hardware running 

processes, which takes up 

memory, and when the 

process is finished it 
closes it and reclaims 

the   memory.
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VIEWING AND QUITTING PROCESSES
Now that you’ve got a handle on processes, you need to know what to do with them. You can view processes running in real-time, and quit 
ones that you no longer need, or those that are problematic. 

STEP 5
The ps 

command is 

one of the oldest known, and 

it has a lot of legacy. Because 

of this, it also has alternative 

options that can be used 

without the dash at the start. 

The most common way to 

use ps is to enter: ps aux. 

Piping this command 

through less is the best way 

to go about using ps. Enter: 

ps aux | less to view 

your processes.

STEP 6
The “ps aux” command displays the processes in 

columns. The first is the User followed by the Process 
ID (PID), then we see the percentage of CPU and memory.

STEP 1
While ps is a great tool for checking all the processes 

on your Raspberry Pi, sometimes you need to view 

them in real-time. In particular you may want to check the CPU and 

memory usage of processes and see if any process is hogging all your 

computer’s resources. Use “top” to do this. 

STEP 3
Now that you’ve got an idea of what processes are, 

how do you go about stopping them? Some processes 

run in the foreground until you quit them. Enter: ping www.google.
com and you’ll start a ping process continuously contacting Google. 

This sort of process runs until you press Control+C. 

STEP 4
Processes are stopped using the kill command. Enter: 

sleep 100 & to create a dummy process. Enter: 

pgrep sleep to find its PID number (on ours it is 2192). Now enter: 
kill 2192 and the sleep process will be stopped. You can also use 

pkill sleep if you’re sure you know the process name. 

STEP 2
Top fills the display with processes and it fits as many 
as it can on one screen. These run in real-time so as 

you watch, the display items will move up and down according to their 

usage. You can interact with top as it is running: use < and > to change 

the sort column. Press H to view a help page with all the commands 

you can use. 

Managing Programs and Processes
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Input, Output and Pipes

IN, OUT, LINUX ALL ABOUT
Everything on a computer is about input and output. You input things into the computer (press keys, move the mouse) and it makes 
calculations and outputs content (changes the display, makes a noise, for example). 

Most operating systems allow you to direct the output of something on the screen to, for 
example, a file. Linux, with its ancestral history of Unix-like command-based arguments, goes 
a step further and offers much more control.  

STEP 1
When you enter commands into Linux (in the 
command line), you are using standard input and 

output. This is so obvious that most people don’t even think about it. 

You enter commands using the keyboard (that’s input) and it responds 
to the screen (output). This is the regular way of doing it, which is why 
it’s “standard input and output” (often called “stdin” and “stdout” 
for short).

STEP 3
You can change the standard output to something 

else using the “>” character after your command. If we 

wanted to see all the items in the python_games directory we could 
use “ls -l python_games”. Using “ls -l python_games > games.txt” 
outputs the list of items to a new text file called “games.txt”.

STEP 2
As far as the computer is concerned, input and output 

can be to and from a whole range of different sources 
that you might never even think about. A program can get input from 

other programs, from files stored on the hard drive and a whole host 
of other areas. It outputs back to the display line, but also to files, 
other programs and even other commands.

STEP 4
The games.txt file now contains the output from the ls 
command. You can check it using “nano games.txt”. 

It’s an editable text file containing all the permissions, user and file 
size information and the names of the files. The output from the ls -l 
command, normally displayed on the screen, was instead sent to this 

file. Press Control+X to quit nano.
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STEP 5
So > enables you to output to files, but you can also 
get input from a file. Make a new directory called 

music (“mkdir music”) and switch to it (“cd music”). Enter: nano 
bands.txt to create a new text file. Enter some band names and 
press Control+O to output the file. Press Control+X to quit nano. 

STEP 6
We’re going to use this text file as input to the sort 
command. Enter: sort < bands.txt and the 

content from the text file is used as input to sort. Because the output 
isn’t specified, it uses the standard output (the screen) but you use 
input and output together. Enter: sort < bands.txt > bands_
sorted.txt to create a new file with the band names in order to 
switch back to your pi account.

STEP 1
As you start to get more advanced in Linux, you 
begin to create more powerful commands, and 

one way you do this is by using the pipe character (“|”). Take 
some time to find this character if you haven’t already: it usually 
sits above or to the left of the Return key on most keyboards. 

STEP 3
You can pipe commands multiple times. Enter: cat 
bands.txt | sort | grep The* to get the bands 

starting with “The” in alphabetical order. The output of the text from 
the bands.txt document is passed into sort, and the output from sort is 
passed into grep which filters out the bands starting with “The”. These 
bands form the output.

STEP 4
You can combine pipes with input and output to create 
complex expressions. You can also use >> to append 

outputted data to a file that already exists. Enter: cat bands.txt | 
wc >> bands.txt. This takes the output from the bands.txt file and 
pipes it into the wc (word count) function. The output from wc is 
appended to the end of the bands.txt file. Enter: cat bands.txt to 

view it.

STEP 2
We’ve used the pipe a few times in the book (“ps aux | 
less”), but you might not have understood what’s 

actually happening. Enter: cat bands.txt | wc. The output from 
the cat command (the text inside the document) isn’t displayed on the 
screen, instead it is piped into the wc (word count) function. This then 
tells us how many lines, words and characters are in the document.

Input, Output and Pipes

USING PIPES

As well as directing input and output to and from files, you can send the output from one command directly into another. This is known as 
piping, and uses the pipe character “|”.
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Fun Things to Do in 
the Terminal
Despite the seriousness of an operating system, the Linux community are certainly no 
strangers to a bit of fun. Over the years, the developers have created and inserted all manner 
of quirky and entertaining elements into the Terminal.  

TERMINAL FUN

All these commands are Linux-based, so not only can you use them on the Raspberry Pi but also on any of the Debian-based 
Linux distributions.   

STEP 1
The first command we’re going to use is sl, it’s not 

installed by default so enter: sudo apt-get 
install sl. The command can be run with sl and when executed 

displays a Steam Locomotive travelling across the screen (hence ‘sl’). 
Entering: LS (note the upper case) also works. 

STEP 3
If you’ve ever fancied having the computer read a 

random fortune out to you then you’re in luck. 

Raspbian requires you to install the Terminal app, Fortune, first. Enter: 
sudo apt-get install fortune, then simply enter: fortune, 

into the Terminal to see what comes up. 

STEP 2
Fans of Star Wars even get a fix when it comes to the 
Terminal. By linking to a remote server via the telnet 

command, you can watch Episode IV: A New Hope being played out, 

albeit in ASCII. To view this spectacle, enter: sudo apt-get 
install telnet, followed by: 

telnet towel.blinkenlights.nl

STEP 4
The rev command is certainly interesting, and at first 
what seems a quite useless addition to the OS can, 

however, be used to create some seemingly unbreakable passwords. 

Enter: rev and then type some text. Then press Enter and everything 

you typed in is reversed. Press Ctrl+C to exit.  
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Fun Things to Do in the Terminal

STEP 5
If you’re stuck trying to work out all the possible 

factors for any particular number, simply enter: 

factor followed by the number. For example, factor 7 doesn’t offer 
much output, whereas factor 60 displays more.   

STEP 8
If you really want to expand the whole cow thing, for 

whatever reason, then pipe the fortune command 

through it, with: fortune | cowsay; and for the graphical cow 

equivalent: fortune | xcowsay. Plus, there’s always cowthink. Try: 

cowthink ...This book is awesome. 

STEP 6
There’s a fine line between the rather cool and the 
really quite weird. Having an ASCII cow repeat text to 

you could potentially fall into the latter. Start by installing cowsay: 

sudo apt-get install cowsay, then enter: cowsay Raspberry 

Pi is Ace!. In fact, you can even output the ls command through 

the cow, by entering: ls | cowsay.  

STEP 9
Admittedly, the command ‘toilet’ doesn’t inspire much 

confidence. However, it’s not as bad as it first sounds. 
Start by installing it with: sudo apt-get install toilet, then 

when it’s installed, type something along the lines of: toilet David; 

or perhaps list the contents of the current folder through it, with: ls 

| toilet. 

STEP 10
Expanding the toilet command, you can actually 

generate some decent looking graphics through it. For 

example, try this: toilet -f mono12 -F metal David. You can 

enter: toilet --help, for a list of the command line arguments to 

expand further. 

STEP 7
To further the cow element, there’s even a graphical, 

i.e. non-Terminal, cow available. Install it with: sudo 

apt-get install xcowsay, then when it’s installed enter 

something similar to cowsay, such as: xcowsay BDM Publications 

are ace!. 
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More Fun Things to Do in 
the Terminal
If the previous list of bizarre, and fun things to do in the Terminal has you wanting more, 
you’re in luck. We’ve put together another batch of both useful, and not so useful, commands 
for you to try out.  

MORE FUN, YAY
Since the Terminal session is already open, and your keyboard digits are nicely warmed up, here are another two pages of 
Terminal nonsense.   

STEP 1
Remember the old ZX Spectrum days of computing, 

when you could type in 10 print “Hello”, 20 goto 10 

and Hello would list down the screen? Well, in Raspbian you can do the 

same. Simply enter: yes followed by some text, i.e. yes Raspberry 

Pi is ace. It keeps going until you press Ctrl+C.

STEP 3
Having a little white cat chase your mouse pointer 

around the desktop may sound like a terrible waste of 

time. Oddly though, it isn’t. Enter: sudo apt-get install oneko, 

then type: oneko to have the cat appear. Move your ‘mouse’ cursor 

around the screen and the cat chases it. Use Ctrl+C to exit the action. 

STEP 2
The Matrix was one of the most visually copied films 
ever released and there’s even a version of the Matrix 

code available for Linux. Install it with: sudo apt-get install 
cmatrix. When it’s done enter: cmatrix and follow the white rabbit, 

Neo. Unlike the real Matrix though, you can press Ctrl+C to exit.

STEP 4
This entry is a little more serious than the previous. 

Fork Bomb is a command that continually replicates 

itself until it has used up all the available system resources, eventually 

causing your computer to crash. You don’t have to try it, but it’s 

interesting nonetheless. Simply enter: :(){ :|:& }: and be 

prepared to reboot. 
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More Fun Things to Do in the Terminal

STEP 5
Stringing several commands and piping them through 

other commands is what makes scripting such a 

powerful element to an OS. For example, using the while command, 

together with toilet, can yield some impressive results. Enter:  while 

true; do echo “$(date ‘+%D %T’ | toilet -f term -F 
border --metal)”; sleep 1; done.  

STEP 8
Used as a music demo from the old Amiga and DOS 

days, the bb command evokes memories of three and 

a half inch floppies crammed with all manner of demo scene goodies. 
You’ve already installed bb from the previous step, so just enter: bb. 

Follow the onscreen instructions and turn up your volume.

STEP 6
Talking computers were the craze of the ‘80s. To 

re-live the fun enter: sudo apt-get install 
espeak, then: espeak “This is a Raspberry Pi” to have the 

computer repeat the text inside the quotes to you. Make sure your 

volume is turned up and try the following: ls > folders.txt && 

espeak -f folders.txt. This gets Raspbian to read back the 

contents of the ls command. 

STEP 9
This entry is in two parts. First you need to get hold of 

the necessary packages: sudo apt-get install libcurses-

perl. When that’s done enter: cd Downloads/ && wget http://
search.cpan.org/CPAN/authors/id/K/KB/KBAUCOM/
Term-Animation-2.4.tar.gz && tar -xf Term-Animation-
2.4.tar.gz && cd Term-Animation-2.4/. Followed by: perl 

Makefile.PL && make && make test && sudo make install.

STEP 10
With that little lot completed, onto the next part. 

Enter: cd .. && wget http://www.robobunny.
com/projects/asciiquarium/asciiquarium.tar.gz && tar 
-xf asciiquarium.tar.gz && cd asciiquarium_1.1/ && 
chmod +x asciiquarium. Providing all went well, enter: ./

asciiquarium and enjoy your very own ASCII-based aquarium. 

STEP 7
A roaring ASCII fire isn’t the most useful command to 
have at your disposal but it’s fun. Install it with: sudo 

apt-get install libaa-bin, then use: aafire. It’s not exactly 

warming but you get the idea. To expand the above, enter: sudo 

apt-get install bb caca-utils, then: cacafire.
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Linux Tips and Tricks
The Linux Terminal, you’ll no doubt agree, is an exceptional environment and with a few extra 
apps installed along with a smidgen of command knowledge, incredible and often quite 
strange things can be accomplished.  

TAKING COMMAND

There are countless Linux tips, secrets, hacks and tricks out there. Some are very old, originating from Linux’s Unix heritage, while 
others are recent additions to Linux lore. Here are our ten favourite tips and tricks.   

EASTER EGGS Emacs text editor, is a great piece of software 

but did you know it also contains a hidden 

Easter Egg? With Emacs installed (sudo apt-get install emacs24), drop 
to a Terminal session and enter:

emacs -batch -l dunnet

Dunnet is a text adventure written by Ron Schnell in 1982, and hidden 

in Emacs since 1994.

TERMINAL BROWSING Ever fancied being able to browse 

the Internet from the Terminal? 

While not particularly useful, it is a fascinating thing to behold. To do 

so, enter:

sudo apt-get install elinks 
Then:

elinks 

Enter the website you want to visit.   

MOON BUGGY  Based on the classic 1982 arcade game, Moon 

Patrol, Moon Buggy appeared on home 

computers in 1985 amid much praise. It’s a cracking Atari game 

available in the Linux Terminal by entering:

sudo apt-get install moon-buggy
Then:

moon-buggy
Enjoy.  

LET IT SNOW 
Snowing in the Terminal console isn’t something 

you come across every day. If you’re interested, 

however, enter:

wget
https://gist.githubusercontent.com/sontek/1505483/ra
w/7d024716ea57e69fb52632fee09f42753361c4a2/snowjob.
sh

chmod +x snowjob.sh
./snowjob.sh
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Linux Tips and Tricks

MEMORY HOGS If you need to see which apps are consuming 

the most memory on your Raspberry Pi, 

simply enter:

ps aux | sort -rnk 4
This sorts the output by system memory use. 

BBS  Back in the days of dial-up connections, the online world was 

made up of Bulletin Board Systems. These remote servers 

provided hangouts for users to chat, swap code, play games and more. 

Using telnet in Linux, we can still connect to some active BBSes. First, 

install Telnet with:

sudo apt-get install telnet
Then:

telnet amigacity.xyz
You will be connected to a BBS dedicated to the Commodore Amiga. 

There’s plenty more, which you can find at www.telnetbbsguide.com. 

SHREDDER When you delete a file, there’s still a chance of 
someone with the right software being able to 

retrieve it. However, files can be securely and permanently deleted 
using Shred:

shred -zvu NAMEOFFILE.txt 
Replace NAMEOFFILE with the name of the file to delete. 

DIRECTORY TREES   If you want to create an entire directory 

(or folder) tree with a single command, 
you can use:

mkdir -p New-Dir/{subfolder1,subfolder2,subfolder3,s

ubfolder4}  
This creates a New-Dir with four sub folders within.  

FORGOTTEN COMMANDS  It’s not easy trying to 

remember all the available 

Linux commands. Thankfully, you can use apropos to help. Simply use 

it with a description of the command:

apropos “copy files”  

apropos “rename files” 

ASCII ART  ASCII art can be quite striking when applied to some 

images. However, it’s often difficult to get just right. 
You can create some great ASCII art from the images you already have 

on the Raspberry Pi by using img2txt:

img2txt NAMEOFIMAGEFILE.png 
Replace NAMEOFIMAGEFILE with the actual name of the image file on 
your system. 
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Command Line 
Quick Reference
When you start using Linux full time, you will quickly realise that the graphical interfaces of 
Ubuntu, Mint, etc. are great for many tasks but not great for all tasks. Understanding how to 
use the command line not only builds your understanding of Linux but also improves your 
knowledge of coding and programming in general. Our command line quick reference guide 
is designed to help you master Linux quicker.

TOP 10 COMMANDS

These may not be the most common commands used by everyone but they will certainly feature frequently for many users of Linux 
and the command line.

cd

 

The ‘cd’ command is one of the commands you will 

use the most at the command line in Linux. It allows 

you to change your working directory. You use it 

to move around within the hierarchy of your file 
system. You can also use chdir. 

ls

 

The ‘ls’ command shows you the files in  
your current directory. Used with certain options, it 

lets you see file sizes, when files where created and 
file permissions. For example, ls ~ shows you the 

files that are in your home directory. 

cp

 

The ‘cp’ command is used to make copies of files and 
directories. For example, cp file sub makes an 

exact copy of the file whose name you entered and 
names the copy sub but the first file will still exist 
with its original  name. 

pwd

 

The ‘pwd’ command prints the full pathname of 

the current working directory (pwd stands for 
“print working directory”). Note that the GNOME 
terminal also displays this information in the title 

bar of its window.  

clear

 

The ‘clear’ command clears your screen if this 

is possible. It looks in the environment for the 

terminal type and then in the terminfo database 

to  figure out  how to clear the screen. This is 
equivalent to typing Control-L when using the 

bash shell. 

mv

 

The ‘mv’ command moves a file to a different 
location or renames a file. For example mv file 
sub renames the original file to sub. mv sub ~/
Desktop moves the file ‘sub’ to your desktop 
directory but does not rename it. You must specify a 

new filename to rename a file. 

chown

 

The ‘chown’ command changes the user and/or 

group ownership of each given file. If only an owner 
(a user name or numeric user ID) is given, that user 
is made the owner of each given file, and the files’ 
group is not changed. 

chmod

 

The ‘chmod’ command changes the permissions 

on the files listed. Permissions are based on a fairly 
simple model. You can set permissions for user, 

group and world and you can set whether each can 

read, write and or execute the file. 

rm

 

The ‘rm’ command removes (deletes) files or 
directories. The removal process unlinks a filename 
in a filesystem from data on the storage device 
and marks that space as usable by future writes. In 

other words, removing files increases the amount of 
available space on your disk. 

mkdir

 

Short for “make directory”, ‘mkdir’ is used to create 

directories on a file system, if the specified directory 
does not already exist. For example, mkdir work 

creates a work directory. More than one directory 

may be specified when calling mkdir.  
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USEFUL HELP/INFO COMMANDS
The following commands are useful for when 
you are trying to learn more about the system or 
program you are working with in Linux. You might 
not need them every day, but when you do, they 
will be invaluable. 

Command Line Quick Reference

free

 

The ‘free’ command displays the total amount 

of free and used physical and swap memory in 

the system. For example, free -m gives the 

information using megabytes. 

df

 

The ‘df’ command displays filesystem disk 
space usage for all partitions. The command 

df-h is probably the most useful (the -h 
means human-readable). 

top

 

The ‘top’ program provides a dynamic real-

time view of a running system. It can display 

system summary information, as well as a list 

of processes. 

uname

 

The ‘uname’ command with the -a option prints 

all system information, including machine name, 

kernel name, version and a few other details.

ps

 

The ‘ps’ command allows you to view all the 

processes running on the machine. Every operating 

system’s version of ps is slightly different but all do 
the same thing. 

grep

 

The ‘grep’ command allows you to search inside a 

number of files for a particular search pattern and 
then print matching lines. An example would be: 

grep blah file.

sed

 

The ‘sed’ command opens a stream editor. 

A stream editor is used to perform text 

transformations on an input stream: a file or input 
from a pipeline. 

adduser

 

The ‘adduser ‘command adds a new user to the 

system. Similarly, the addgroup command adds a 

new group to the  system.  

deluser

 

The ‘deluser’ command removes a user 

from the system. To remove the user’s files 
and home directory, you need to add the 

-remove-home option. 

delgroup

 

The ‘delgroup’ command removes a group from 

the system. You cannot remove a group that is the 

primary group of any users. 

man 
man

 

The ‘man man’ command brings up the manual 

entry for the man command, which is a great place 

to start when using it. 

man 
intro

 

The ‘man intro’ command is especially useful. It 

displays the Introduction to User Commands, 

which is a well written, fairly brief introduction to 

the Linux command line. 

~ $ .\Commonly_Used_Commands\
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A
adduser  Add a new user

arch   Print machine 

architecture

awk  Find and replace text 

within file(s)

B
bc  An arbitrary precision 

calculator languageC
cat  Concatenate files and 

print on the standard 

output

chdir  Change working 

directory

chgrp  Change the group 

ownership of files

chroot  Change root directory

cksum  Print CRC checksum and 

byte counts

cmp  Compare two files

comm  Compare two sorted files 
line by line

cp  Copy one or more files to 
another location

crontab  Schedule a command to 

run at a later time

csplit  Split a file into context- 
determined pieces

cut  Divide a file into several 
parts

D
date  Display or change the 

date & time

dc  Desk calculator

dd  Data Dump, convert and 

copy a file

diff  Display the differences 
between two files

dirname  Convert a full path name 

to just a path

du  Estimate file space usageE
echo  Display message on 

screen

ed  A line oriented text editor 

(edlin)

egrep  Search file(s) for lines 
that match an extended 

expression

env  Display, set or remove 

environment variables

expand  Convert tabs to spaces

expr  Evaluate expressions

F
factor  Print prime factors

fdisk  Partition table 

manipulator for Linux

fgrep  Search file(s) for lines 
that match a fixed string

find  Search for files that meet 
a desired criteria

fmt  Reformat paragraph 

text

fold  Wrap text to fit a 
specified width

format  Format disks or tapes

fsck  Filesystem consistency 

check and repairG
gawk  Find and Replace text 

within file(s)

grep  Search file(s) for lines that 
match a given pattern

groups  Print group names a user 

is in

gzip  Compress or decompress 

named file(s)

H
head  Output the first part of 

file(s)

hostname  Print or set system name

I
id  Print user and group ids

info  Help info

install  Copy files and set 
attributes

J
join  Join lines on a common 

fieldK
kill  Stop a process from 

running

L
less  Display output one 

screen at a time

ln  Make links between files

locate  Find files

logname  Print current login name

lpc  Line printer control 

program

lpr  Off line print

lprm  Remove jobs from the 

print queue

A-Z of Linux Commands
There are literally thousands of Linux commands, so while this is not a complete A-Z, it does 
contain many of the commands you will most likely need. You will probably find that you end 
up using a smaller set of commands over and over again but having an overall knowledge is 
still very useful.
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M
man  See Help manual

mkdir  Create new folder(s)

mkfifo  Make FIFOs (named 
pipes)

mknod  Make block or character 

special files

more  Display output one 

screen at a time

mount  Mount a file system

N
nice  Set the priority of a 

command or job

nl  Number lines and write 

files

nohup  Run a command immune 

to hangups

P
passwd  Modify a user password

paste  Merge lines of files

pathchk  Check file name 
portability

pr  Convert text files for 
printing

printcap  Printer capability 

database

printenv  Print environment 

variables

printf  Format and print data

Q
quota  Display disk usage and 

limits

quotacheck  Scan a file system for disk 
usage

quotactl  Set disk quotas

R
ram  Ram disk device

rcp  Copy files between two 
machines

rm  Remove files

rmdir  Remove folder(s)

rpm  Remote Package 

Manager

rsync  Remote file copy 
(synchronise file trees)

S
screen  Terminal window manager

sdiff  Merge two files interactively

select  Accept keyboard input

seq  Print numeric sequences

shutdown  Shutdown or restart 

Linux

sleep  Delay for a specified time

sort  Sort text files

split  Split a file into fixed-size 
pieces

su  Substitute user identity

sum  Print a checksum for a file

symlink  Make a new name for a file

sync  Synchronise data on disk 

with memory

T
tac  Concatenate and write 

files in reverse

tail  Output the last part of 

files

tar  Tape Archiver

tee  Redirect output to 

multiple files

test  Evaluate a conditional 

expression

time  Measure Program 

Resource Use

touch  Change file timestamps

top  List processes running on 

the system

traceroute  Trace Route to Host

tr  Translate, squeeze and or 
delete characters

tsort  Topological sortU
umount  Unmount a device

unexpand  Convert spaces to tabs

uniq  Uniquify files

units  Convert units from one 

scale to another

unshar  Unpack shell archive 

scripts

useradd  Create new user account

usermod  Modify user account

users  List users currently 

logged in

V
vdir  Verbosely list directory 

contents ( l̀s -l -b’)

W
watch  Execute or display a 

program periodically

wc  Print byte, word, and 
line counts

whereis  Report all known 
instances of a 
command

which  Locate a program file 
in the user’s path

who  Print all usernames 
currently logged in

whoami  Print the current user 
id and name

X
xargs  Execute utility, passing 

constructed argument 
list(s)

Y
yes  Print a string until 

interrupted

A-Z of Linux Commands
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1
lsblk  You will often find the need 
to list the available storage devices of your 

Linux system. The lsblk is one of the most used 

Linux commands for this purpose. This handy 

terminal command will present you with a tree 

structure of your storage devices.

2
Service  Service is the de-facto 
command to invoke system-wide services 
from the terminal. A powerful Linux terminal 

command for manipulating the system; you can 

leverage this command for running any script 

directly from the terminal window.

3
In  The ln command is a clever 

Linux instruction for creating symbolic links to a 

specific file. You can use this flexible command 
to produce multiple instances of a symbolic link 

to a file, or directory, on your disk space.

4
Alias  This is one of the most used 

Linux commands by system admins, as it 

allows them to replace a word by another 

string directly from the terminal. Among 

other functions, this is one of the best 

terminal commands through which you 

can customize the shell and manipulate 
environment variables.

5
Cal  The Cal command is one of 

those fun Linux commands, which shows you 

the current date as a calendar in an ASCII text 

format. Type this command, with parameters 

like month and year, to get specified 
information right into the terminal.

6
History  Want to check the history of 

your terminal command sessions? The History 

command lets you do precisely this. When 

typed without any parameters, this will print 

out the bash history of your terminal session. 

7
Wget  This is one of the best Linux 

commands for downloading files from the 
web directly from the terminal. It’s also one 
of those handy little terminal commands that 

can be used in scripts, and provides users with 

the ability to use the HTTP, HTTPS, and FTP 

Internet protocols.

8
Iptables  The Iptables command is a 

terminal utility that lets system admins control 

the incoming and outgoing Internet traffic on 
any machine. It is among the most used Linux 

commands to define authentic traffics and for 
blacklisting suspicious or untrusted network 

requests.

9
Curl  Curl, or rather cURL, is a very 

powerful network tool for transferring files 
over a network. This is one of those Linux 

commands designed to work without user 

interaction and is often employed in network 

related shell scripts.

10 
Sudo  Probably the most used Linux 

command. You’ve already used it throughout this 
book, and it’s one that you’ll keep coming back to 
as you progress with Linux. Basically, it lets non-
privileged users gain access to, and modify, files 
that only high-level users can access.

11
Exit  This can be used to exit 

from the Terminal session, or from the 

current user group to the last group. It’s 
also used when you need to exit from a 

remote connection inside the Terminal.

12
Head  This handy command 

will display the first ten lines of a file; 
extremely useful for when connecting to 

a remote system and trawling through 

multiple files.

13
Type  The Type command 

will display information regarding any 

of the current commands installed in 

the system. For example, it will display 

the location of any of the Terminal 

commands, so you know where to look 

for any lost packages.

14
Vi  Opens the Vi text 

editor in the Terminal. Vi is a traditional 

command, which first appeared in 1976 
– over 43 years ago, and is still one of 

the top, go-to text editors for seasoned 
system admins and users alike.

15
W  A simple enough 

command, although quite powerful. 

The W command will display exactly 

who is logged in to the system and what 

they’re doing. Used by system admins to 
see what’s going on in their systems, it’s 
something you’ll probably come to use as 
your Linux skills improve.

15 Essential Commands
In addition to the commands we’ve previously covered, here are fifteen extra, essential 
commands that you’ll find useful. As your Pi and Linux skills grow, these will also become 
more frequently used; covering networking, administration and more. 
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Python 
on the Pi
Being able to code is part 

of making not just the 

Raspberry Pi, but all the 

connected devices that 

can access the Internet, do 

what you want them to. The 

Raspberry Pi is a perfect 

coding base that comes 

pre-installed with the latest 

version of one of the world’s 

most popular programming 

languages: Python.
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STEP 1
With the Raspbian desktop loaded, click on the Menu 

button followed by Programming > Python 3 (IDLE). 
This will open the Python 3 Shell. Windows and Mac users can find the 
Python 3 IDLE Shell from within the Windows Start button menu and 

via Finder.

STEP 3
For example, in the Shell enter:  2+2

After pressing Enter, the next line will display the 

answer: 4. Basically, Python has taken the ‘code’ and produced the 

relevant output.

STEP 2
The Shell is where you can enter code and see the 

responses and output of code you’ve programmed 

into Python. This is a kind of sandbox, where you’re able to try out 

some simple code and processes. 

STEP 4
The Python Shell acts very much like a calculator, since 

code is basically a series of mathematical interactions 

with the system. Integers, which are the infinite sequence of whole 
numbers can easily be added, subtracted, multiplied and so on.

Starting Python for the 
First Time
If you’re using the new Raspberry Pi, together with its latest release of Raspbian, then you will 
need to manually install the Python IDLE. This is due to the Pi team removing the core Python 
IDLE in favour of replacing it with their own coding text editor. 

STARTING PYTHON

For those using the Pi 4 and new Raspbian, drop into a Terminal and enter: sudo apt-get install idle3. Older versions of Raspbian 
already have the official Python IDLE pre-installed.
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Starting Python for the First Time

STEP 5
While that’s very interesting, it’s not particularly 

exciting. Instead, try this:

print(“Hello everyone!”)

Just enter it into the IDLE as you’ve done in the previous steps.

STEP 7
You may have noticed the colour coding within the 

Python IDLE. The colours represent different 
elements of Python code. They are:

Black – Data and Variables 

Green – Strings 

Purple – Functions 

Orange – Commands

Blue – User Functions 

Dark Red – Comments 

Light Red – Error Messages

STEP 6
This is a little more like it, since you’ve just produced 

your first bit of code. The Print command is fairly 
self-explanatory, it prints things. Python 3 requires the brackets as 

well as quote marks in order to output content to the screen, in this 

case the Hello everyone! bit.

STEP 8
The Python IDLE is a configurable environment. If you 
don’t like the way the colours are represented, then 

you can always change them via Options > Configure IDLE and clicking 
on the Highlighting tab. However, we don’t recommend that as you 

won’t be seeing the same as our screenshots. 

STEP 10
The Python IDLE is a powerful interface, and one 

that’s actually been written in Python using one of 

the available GUI toolkits. If you want to know the many ins and outs 

for the Shell, we recommend you take a few moments to view www.

docs.python.org/3/library/idle.html, which details many of the 

IDLE’s features.

STEP 9
Just like most programs available, regardless of the 

operating system, there are numerous shortcut keys 

available. We don’t have room for them all here but within the Options 

> Configure IDLE and under the Keys tab, you can see a list of the 
current bindings. 
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STEP 1
If you’ve closed Python 3 IDLE, reopen it in whichever 

operating system version you prefer. In the Shell, 

enter the familiar following:

print(“Hello”)

STEP 3
You can see that instead of the number 4, the output 

is the 2+2 you asked to be printed to the screen. The 

quotation marks are defining what’s being outputted to the IDLE 
Shell; to print the total of 2+2 you need to remove the quotes:

print(2+2)

STEP 2
Just as predicted, the word Hello appears in the Shell 

as blue text, indicating output from a string. It’s fairly 

straightforward and doesn’t require too much explanation. Now try:

print(“2+2”)

STEP 4
You can continue as such, printing 2+2, 464+2343 and 

so on to the Shell. An easier way is to use a variable, 

which is something we will cover in more depth later. For now, enter:

a=2 

b=2 

Your First Code
Essentially, you’ve already written your first piece of code with the ‘print(“Hello everyone!”)’ 
function from the previous tutorial. However, let’s expand that and look at entering your code 
and playing around with some other Python examples.

PLAYING WITH PYTHON

With most languages, computer or human, it’s all about remembering and applying the right words to the right situation. You’re not born 
knowing these words, so you need to learn them.
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STEP 5
What you have done here is assign the letters a and b 

two values: 2 and 2. These are now variables, which 

can be called upon by Python to output, add, subtract, divide and so 

on for as long as their numbers stay the same. Try this:

print(a) 

print(b) 

STEP 7
You can play around with different kinds of variables 
and the Print function. For example, you could assign 

variables for someone’s name:

name=”David” 

print(name)

STEP 6
The output of the last step displays the current values 

of both a and b individually, as you’ve asked them to 

be printed separately. If you want to add them up, you can use the 

following:

print(a+b) 

This code simply takes the values of a and b, adds them together and 

outputs the result.

STEP 8
Now let’s add a surname:

surname=”Hayward” 

print(surname)

You now have two variables containing a first name and a surname 
and you can print them independently. 

STEP 10
In Python 3 you can separate the two variables with a 

space using a comma:

print(name, surname) 

Alternatively, you can add the space ourselves:

print(name+” “+surname)

The use of the comma is much neater, as you can see. Congratulations, 

you’ve just taken your first steps into the wide world of Python.

STEP 9
If we were to apply the same routine as before, using 

the + symbol, the name wouldn’t appear correctly in 

the output in the Shell. Try it:

print(name+surname) 

You need a space between the two, defining them as two separate 
values and not something you mathematically play around with.

Your First Code
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STEP 1
First, open the Python IDLE Shell and when it’s up, 

click on File > New File. This will open a new window 

with Untitled as its name. This is the Python IDLE Editor and within it 

you can enter the code needed to create your future programs.

STEP 3
You can see that the same colour coding is in place in 

the IDLE Editor as it is in the Shell, enabling you to 

better understand what’s going on with your code. However, to 

execute the code you need to first save it. Press F5 and you get a 
Save…Check box open.

STEP 2
The IDLE Editor is, for all intents and purposes, a 

simple text editor with Python features, colour coding 

and so on; much in the same vein as Sublime. You enter code as you 

would within the Shell, so taking an example from the previous 

tutorial, enter:

print(“Hello everyone!”)

STEP 4
Click on the OK button in the Save box and select a 

destination where you’ll save all your Python code. 

The destination can be a dedicated folder called Python or you can 

just dump it wherever you like. Remember to keep a tidy drive though, 

to help you out in the future.

Saving and Executing 
Your Code
While working in the IDLE Shell is perfectly fine for small code snippets, it’s not designed for 
entering longer program listings. In this section you’re going to be introduced to the IDLE 
Editor, where you will be working from now on.

EDITING CODE

You will eventually reach a point where you have to move on from inputting single lines of code into the Shell. Instead, the IDLE Editor will 
allow you to save and execute your Python code.
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STEP 5
Enter a name for your code, ‘print hello’ for example, 

and click on the Save button. Once  the Python code is 

saved it’s executed and the output will be detailed in the IDLE Shell. In 

this case, the words ‘Hello everyone!’.

STEP 7
If you open the file location of the saved Python code, 
you can see that it ends in a .py extension. This is the 

default Python file name. Any code you create will be whatever.py and 
any code downloaded from the many internet Python resource sites 

will be .py. Just ensure that the code is written for Python 3.

STEP 6
This is how the vast majority of your Python code will 

be conducted. Enter it into the Editor, hit F5, save the 

code and look at the output in the Shell. Sometimes things will differ, 
depending on whether you’ve requested a separate window, but 

essentially that’s the process. It’s the process we will use throughout 

this book, unless otherwise stated.

STEP 8
Let’s extend the code and enter a few examples from 

the previous tutorial:

a=2 

b=2 

name=”David” 

surname=”Hayward” 

print(name, surname) 

print (a+b)

If you press F5 now you’ll be asked to save the file, again, as it’s been 
modified from before.

STEP 10
Now create a new file. Close the Editor, and open a 
new instance (File > New File from the Shell). Enter 

the following and save it as hello.py:

a=”Python” 

b=”is” 

c=”cool!” 

print(a, b, c)

You will use this code in the next tutorial. 

STEP 9
If you click the OK button, the file will be overwritten 
with the new code entries, and executed, with the 

output in the Shell. It’s not a problem with just these few lines but if 

you were to edit a larger file, overwriting can become an issue. 
Instead, use File > Save As from within the Editor to create a backup.

Saving and Executing Your Code
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Executing Code from 
the Command Line
Although we’re working from the GUI IDLE throughout this book, it’s worth taking a look at 
Python’s command line handling. We already know there’s a command line version of Python 
but it’s also used to execute code.

COMMAND THE CODE

Using the code we created in the previous tutorial, the one we named hello.py, let’s see how you can run code that was made in the GUI at 
the command line level. 

STEP 1
Python, in Linux, comes with two possible ways of 

executing code via the command line. One of the ways 

is with Python 2, whilst the other uses the Python 3 libraries and so on. 

First though, drop into the command line or Terminal on your 

operating system.

STEP 3
Now you’re at the command line we can start Python. 

For Python 3 you need to enter the command python3 

and press Enter. This will put you into the command line version of the 

Shell, with the familiar three right-facing arrows as the cursor (>>>).

STEP 2
Just as before, 

we’re using a 

Raspberry Pi: Windows users 

will need to click the Start 

button and search for CMD, 

then click the Command Line 

returned search; and macOS 

users can get access to their 

command line by clicking Go > 

Utilities > Terminal.

STEP 4
From here you’re able to enter the code you’ve looked 

at previously, such as:

a=2 

print(a) 

You can see that it works exactly the same.
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Executing Code from the Command Line

STEP 5
Now enter: exit() to leave the command line 

Python session and return you back to the 

command prompt. Enter the folder where you saved the code 

from the previous tutorial and list the available files within; 
hopefully you should see the hello.py file.

STEP 7
Naturally, since this is Python 3 code, using the syntax 

and layout that’s unique to Python 3, it only works 

when you use the python3 command. If you like, try the same with 

Python 2 by entering:

python hello.py

STEP 6
From within the same folder as the code you’re going 

to run, enter the following into the command line:

python3 hello.py 

This will execute the code we created, which to remind you is:

a=”Python” 

b=”is” 

c=”cool!” 

print(a, b, c)

STEP 8
The result of running Python 3 code from the Python 

2 command line is quite obvious. Whilst it doesn’t 

error out in any way, due to the differences between the way Python 
3 handles the Print command over Python 2, the result isn’t as we 

expected. Using Sublime for the moment, open the hello.py file.

STEP 10
Save the hello.py file and drop back to the command 
line. Now execute the newly saved code with:

python3 hello.py 

The result will be the original Python is cool! statement, together with 

the added input command asking you for your name, and displaying it 

in the command window.

STEP 9
Since Sublime Text isn’t available for the Raspberry Pi, 

you’re going to temporarily leave the Pi for the 

moment and use Sublime as an example that you don’t necessarily 

need to use the Python IDLE. With the hello.py file open, alter it to 
include the following:

name=input(“What is your name? “) 

print(“Hello,”, name)
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Numbers and Expressions
We’ve seen some basic mathematical expressions with Python, simple addition and the like. 
Let’s expand on that now and see just how powerful Python is as a calculator. You can work 
within the IDLE Shell or in the Editor, whichever you like.

IT’S ALL MATHS, MAN
You can get some really impressive results with the mathematical powers of Python; as with most, if not all, programming languages, maths 
is the driving force behind the code. 

STEP 1  Open up the GUI version of Python 3, as mentioned 

you can use either the Shell or the Editor. For the 

time being, you’re going to use the Shell just to warm our maths 

muscle, which we believe is a small gland located at the back of the 

brain (or not).

STEP 3
You can use all the usual mathematical operations: 

divide, multiply, brackets and so on. Practise with a 

few, for example:

1/2 

6/2 

2+2*3 

(1+2)+(3*4)

STEP 2
In the Shell enter the following:

2+2 

54356+34553245 

99867344*27344484221 

You can see that Python can handle some quite large numbers.

STEP 4
You’ve no doubt noticed, division produces a decimal 

number. In Python these are called floats, or floating 
point arithmetic. However, if you need an integer as opposed to a 

decimal answer, then you can use a double slash:

1//2 

6//2

And so on. 
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Numbers and Expressions

STEP 5
You can also use an operation to see the remainder 

left over from division. For example: 10/3 

Will display 3.333333333, which is of course 3.3-recurring. 

If you now enter: 10%3

This will display 1, which is the remainder left over from dividing 10 

by 3.

STEP 7
Numbers and expressions don’t stop there. Python 

has numerous built-in functions to work out sets of 

numbers, absolute values, complex numbers and a host of 

mathematical expressions and Pythagorean tongue-twisters. For 

example, to convert a number to binary, use:

bin(3) 

STEP 6
Next up we have the power operator, or 

exponentiation if you want to be technical. To work 

out the power of something you can use a double multiplication 

symbol or double-star on the keyboard:

2**3 

10**10

Essentially, it’s 2x2x2 but we’re sure you already know the basics 

behind maths operators. This is how you would work it out in Python.

STEP 8
This will be displayed as ‘0b11’, converting the integer 

into binary and adding the prefix 0b to the front. If 
you want to remove the 0b prefix, then you can use:
format(3, ‘b’)

The Format command converts a value, the number 3, to a formatted 

representation as controlled by the format specification, the ‘b’ part.

STEP 10
Execute the code from Step 9, and you can see a series 

of True or False statements, depending on the result 

of the two defining values: 6 and 7. It’s an extension of what you’ve 
looked at, and an important part of programming.

STEP 9
A Boolean Expression is a logical statement that will 

either be true or false. We can use these to compare 

data and test to see if it’s equal to, less than or greater than. Try this in 

a New File:

a = 6 

b = 7 

print(1, a == 6) 

print(2, a == 7) 

print(3, a == 6 and b == 7) 

print(4, a == 7 and b == 7) 

print(5, not a == 7 and b == 7) 

print(6, a == 7 or b == 7) 

print(7, a == 7 or b == 6) 

print(8, not (a == 7 and b == 6)) 

print(9, not a == 7 and b == 6)
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#COMMENTS!

Programmers use a method of keeping their code readable by commenting on certain sections. If a variable is used, the programmer 
comments on what it’s supposed to do, for example. It’s just good practise.  

Using Comments
When writing your code, the flow, what each variable does, how the overall program will 
operate and so on is all inside your head. Another programmer could follow the code line by 
line but over time, it can become difficult to read.

STEP 1  Start by creating a new instance of the IDLE Editor 

(File > New File) and create a simple variable and print 
command:

a=10 

print(“The value of A is,”, a)

Save the file and execute the code.

STEP 3
Resave the code and execute it. You can see that the 

output in the IDLE Shell is still the same as before, 

despite the extra lines being added. Simply put, the hash symbol (#) 
denotes a line of text the programmer can insert to inform them, and 

others, of what’s going on without the user being aware.

STEP 2
Running the code will return the line: The value of A is, 

10 into the IDLE Shell window, which is what we 

expected. Now, add some of the types of comments you’d normally 

see within code:

# Set the start value of A to 10 

a=10 

# Print the current value of A 

print(“The value of A is,”, a)

STEP 4
Let’s assume that the variable A that we’ve created is 

the number of lives in a game. Every time the player 

dies, the value is decreased by 1. The programmer could insert a 

routine along the lines of:

a=a-1 

print(“You’ve just lost a life!”) 

print(“You now have”, a, “lives left!”)
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Using Comments

STEP 5
While we know that the variable A is lives, and that the 

player has just lost one, a casual viewer or someone 

checking the code may not know. Imagine for a moment that the code 

is twenty thousand lines long, instead of just our seven. You can see 

how handy comments are.

STEP 7
You can use comments in different ways. For example, 
Block Comments are a large section of text that 

details what’s going on in the code, such as telling the code reader 

what variables you’re planning on using:

# This is the best game ever, and has been developed 
by a crack squad of Python experts 

# who haven’t slept or washed in weeks. Despite 

being very smelly, the code at least 

# works really well. 

STEP 6
Essentially, the new code together with comments 

could look like:

# Set the start value of A to 10 

a=10 

# Print the current value of A 

print(“The value of A is,”, a) 

# Player lost a life! 

a=a-1 

# Inform player, and display current value of A 

(lives) 

print(“You’ve just lost a life!”) 

print(“You now have”, a, “lives left!”)

STEP 8
Inline comments are comments that follow a section 

of code. Take our examples from above, instead of 

inserting the code on a separate line, we could use:

a=10 # Set the start value of A to 10 

print(“The value of A is,”, a) # Print the current 

value of A 

a=a-1 # Player lost a life! 

print(“You’ve just lost a life!”) 

print(“You now have”, a, “lives left!”) # Inform 

player, and display current value of A (lives)

STEP 10
You also use three single quotes to comment out a 

Block Comment or multi-line section of comments. 

Place them before and after the areas you want to comment for them 

to work:

’’’ 

This is the best game ever, and has been developed 
by a crack squad of Python experts who haven’t slept 
or washed in weeks. Despite being very smelly, the 
code at least works really well.   

’’’

STEP 9
The comment, the hash symbol, can also be used to 

comment out sections of code you don’t want to be 

executed in your program. For instance, if you wanted to remove the 

first print statement, you would use:
# print(“The value of A is,”, a)
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VARIOUS VARIABLES

You’ll be working with the Python 3 IDLE Shell in this tutorial. If you haven’t already, open Python 3 or close down the previous IDLE Shell to 
clear up any old code.

Working with Variables
We’ve seen some examples of variables in our Python code already but it’s 
always worth going through the way they operate and how Python creates and 
assigns certain values to a variable.

STEP 1
In some programming languages you’re required to use 

a dollar sign to denote a string, which is a variable made 

up of multiple characters, such as a name of a person. In Python this 

isn’t necessary. For example, in the Shell enter: name=”David Hayward” 

(or use your own name, unless you’re also called David Hayward).

STEP 3
You’ve seen previously that variables can be 

concatenated using the plus symbol between the 

variable names. In our example we can use: print (name + “: “ + 

title). The middle part between the quotations allows us to add a 

colon and a space, as variables are connected without spaces, so we 

need to add them manually.

STEP 2
You can check the type of variable in use by  

issuing the type () command, placing the name of the 

variable inside the brackets. In our example, this would be:  

type (name). Add a new string variable: title=”Descended from 

Vikings”. 

STEP 4
You can also combine variables within another 

variable. For example, to combine both name and title 

variables into a new variable we use: 

character=name + “: “ + title

Then output the content of the new variable as:

print (character)

Numbers are stored as different variables:
age=44 

Type (age)
Which are integers, as we know.
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Working with Variables

STEP 5
However, you can’t combine both strings and integer 

type variables in the same command, as you would a set 

of similar variables. You need to either turn one into the other or vice 

versa. When you do try to combine both, you get an error message:

print (name + age) 

STEP 7
Another example of TypeCasting is when you ask for 

input from the user, such as a name. for example, enter:

age= input (“How old are you? “)
All data stored from the Input command is stored as a string variable.

STEP 6
This is a process known as TypeCasting. The Python 

code is:

print (character + “ is “ + str(age) + “ years 
old.”)

or you can use:

print (character, “is“, age, “years old.”)
Notice again that in the last example, you don’t need the spaces 

between the words in quotes as the commas treat each argument to 

print separately.  

STEP 8
This presents a bit of a problem when you want to 

work with a number that’s been inputted by the user, 

as age + 10 won’t work due to being a string variable and an integer. 

Instead, you need to enter:

int(age) + 10
This will TypeCast the age string into an integer that can be  

worked with.

STEP 10
When combining integers and floats Python usually 
converts the integer to a float, but should the reverse 

ever be applied it’s worth remembering that Python doesn’t return 

the exact value. When converting a float to an integer, Python will 
always round down to the nearest integer, called truncating; in our 

case instead of 19.99 it becomes 19.

STEP 9
The use of TypeCasting is also important when dealing 

with floating point arithmetic; remember: numbers 
that have a decimal point in them. For example, enter:

shirt=19.99

Now enter: type(shirt) and you’ll see that Python has allocated the 

number as a ‘float’, because the value contains a decimal point.
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USER FRIENDLY

The type of input you want from the user will depend greatly on the type of program you’re coding. For example, a game may ask for a 
character’s name, whereas a database can ask for personal details. 

User Input
We’ve seen some basic user interaction with the code from a few of the examples earlier, so 
now would be a good time to focus solely on how you would get information from the user 
then store and present it.

STEP 1
If it’s not already, open the Python 3 IDLE Shell, and 

start a New File in the Editor. Let’s begin with 

something really simple, enter:

print(“Hello”) 

firstname=input(“What is your first name? “) 

print(“Thanks.”) 

surname=input(“And what is your surname? “) 

STEP 3
Now that we have the user’s name stored in a couple 

of variables we can call them up whenever we want:

print(“Welcome”, firstname, surname, “. I hope you’re 
well today.”)

STEP 2
Save and execute the code, and as you already no 

doubt suspected, in the IDLE Shell the program will 

ask for your first name, storing it as the variable firstname, followed 
by your surname; also stored in its own variable (surname).  

STEP 4
Run the code and you can see a slight issue, the full 

stop after the surname follows a blank space. To 

eliminate that we can add a plus sign instead of the comma in 

the code:
print(“Welcome”, firstname, surname+“. I hope you’re 
well today.”)
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User Input

STEP 5
You don’t always have to include quoted text within 

the input command. For example, you can ask the user 

their name, and have the input in the line below:

print(“Hello. What’s your name?”) 

name=input() 

STEP 7
It’s a good start to a text adventure game, perhaps? 

Now you can expand on it and use the raw input from 

the user to flesh out the game a little:
if name==”David”: 

     print(“Welcome, good sir. You may pass.”) 

else: 

    print(“I know you not. Prepare for battle!”) 

STEP 6
The code from the previous step is often regarded as 

being a little neater than having a lengthy amount of 

text in the input command, but it’s not a rule that’s set in stone, so do 

as you like in these situations. Expanding on the code, try this:

print(“Halt! Who goes there?”) 

name=input() 

STEP 8
What you’ve created here is a condition, which we will 

cover soon. In short, we’re using the input from the 

user and measuring it against a condition. So, if the user enters David 

as their name, the guard will allow them to pass unhindered. Else, if 

they enter a name other than David, the guard challenges them to 

a fight.

STEP 10
To finalise the rate and distance code, we can add:
distance = float(input(“Distance: “)) 

print(“Time:”, (distance / rate))

Save and execute the code and enter some numbers. Using the 

float(input element, we’ve told Python that anything entered is a 
floating point number rather than a string.

STEP 9
Just as you learned previously, any input from a user is 

automatically a string, so you need to apply a 

TypeCast in order to turn it into something else.  This creates some 

interesting additions to the input command. For example:

# Code to calculate rate and distance 

print(“Input a rate and a distance”) 

rate = float(input(“Rate: “))
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FUNKY FUNCTIONS

A function is a command that you enter into Python to do something. It’s a little piece of self-contained code that takes data, works on it and 
then returns the result.  

Creating Functions
Now that you’ve mastered the use of variables and user input, the next step is to tackle 
functions. You’ve already used a few functions, such as the print command but Python 
enables you to define your own functions.

STEP 1
It’s not just data that a function works on. They can do 

all manner of useful things in Python, such as sort 

data, change items from one format to another and check the length 

or type of items. Basically, a function is a short word that’s followed by 

brackets. For example, len(), list() or type().

STEP 3
You can pass variables through functions in much the 

same manner. Let’s assume you want the number of 

letters in a person’s surname, you could use the following code (enter 
the text editor for this example):
name=input (“Enter your surname: “) 

count=len(name) 

print (“Your surname has“, count, “letters in it.”)

Press F5 and save the code to execute it.

STEP 2
A function takes data, usually a variable, works on it 

depending on what the function is programmed to do 

and returns the end value. The data being worked on goes inside the 

brackets, so if you wanted to know how many letters are in the word 

antidisestablishmentarianism, then you’d enter: len(“antidisesta

blishmentarianism”) and the number 28 would return.  

STEP 4
Python has tens of functions built into it, far too many 

to get into in the limited space available here. 

However, to view the list of built-in functions available to Python 3, 

navigate to www.docs.python.org/3/library/functions.html. These 

are the predefined functions, but since users have created many more, 
they’re not the only ones available.
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Creating Functions

STEP 1
Choose File > New File to enter the editor, let’s create a 

function called Hello, that greets a user. Enter:

def Hello(): 

       print (“Hello”)

Hello()

Press F5 to save and run the script. You can see Hello in the Shell, type 

in Hello() and it returns the new function. 

STEP 3
To modify it further, delete the Hello(“David”) line, the 
last line in the script and press Ctrl+S to save the new 

script. Close the Editor and create a new file (File > New File). Enter the 
following:

from Hello import Hello

Hello(“David”)

Press F5 to save and execute the code. 

STEP 4
What you’ve just done is import the Hello function from 

the saved Hello.py program and then used it to say hello 

to David. This is how modules and functions work: you import the 

module then use the function. Try this one, and modify it for extra credit:

def add(a, b):

   result = a + b 

   return result 

STEP 2
Let’s now expand the function to accept a  variable, the 

user’s name for example. Edit your script to read:

def Hello(name): 

       print (“Hello”, name)

Hello(“David”)

This will now accept the variable name, otherwise it prints Hello David. 

In the Shell, enter: name=(“Bob”), then: Hello(name). Your 

function can now pass variables through it.

FORGING FUNCTIONS

There are many different functions you can import, created by other Python programmers, and you will undoubtedly come across some 
excellent examples in the future; you can also create your own with the def command.

STEP 5
Additional functions can be added to Python through 

modules. Python has a vast range of modules 

available that can cover numerous programming duties. They add 

functions and can be imported as and when required. For example, to 

use advanced mathematics functions enter: 

import math 

Once entered, you have access to all the Math module functions.

STEP 6
To use a function from a module enter the name of 

the module followed by a full stop, then the name of 

the function. For instance, using the Math module, since you’ve just 

imported it into Python, you can utilise the square root function. To do 

so, enter:

math.sqrt(16)
You can see that the code is presented as module.function(data).
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TRUE CONDITIONS

Keeping conditions simple to begin with makes learning to program a more enjoyable experience. Let’s start then by checking if something 
is TRUE, then doing something else if it isn’t.

Conditions and Loops
Conditions and loops are what makes a program interesting; they can be simple or rather 
complex. How you use them depends greatly on what the program is trying to achieve; they 
could be the number of lives left in a game or just displaying a countdown.

STEP 1
Let’s create a new Python program that will ask the 

user to input a word, then check it to see if it’s a 

four-letter word or not. Start with File > New File, and begin with the 

input variable:

word=input(“Please enter a four-letter word: “)

STEP 3
Now you can use an if statement to check if the 

word_length variable is equal to four and print a 
friendly conformation if it applies to the rule:

word=input(“Please enter a four-letter word: “) 

word_length=len(word) 

if word_length == 4: 

       print (word, “is a four-letter word. Well done.”)

The double equal sign (==) means check if something is equal to 
something else. 

STEP 2
Now we can create a new variable, then use the len 

function and pass the word variable through it to get 

the total number of letters the user has just entered:

word=input(“Please enter a four-letter word: “) 

word_length=len(word) 

STEP 4
The colon at the end of IF tells Python that if this 

statement is true do everything after the colon that’s 

indented. Next, move the cursor back to the beginning of the Editor:

word=input(“Please enter a four-letter word: “) 

word_length=len(word) 

if word_length == 4: 

      print (word, “is a four-letter word. Well done.”) 

else: 

       print (word, “is not a four-letter word.”) 
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STEP 1
Let’s start with a simple While statement. Like IF, this 

will check to see if something is TRUE, then run the 

indented code:

x = 1 

while x < 10: 

     print (x) 

     x = x + 1 

STEP 3
The For loop is another example. For is used to loop 

over a range of data, usually a list stored as variables 

inside square brackets. For example:

words=[“Cat”, “Dog”, “Unicorn”]
for word in words: 

      print (word)

STEP 4
The For loop can also be used in the countdown 

example by using the range function:

for x in range (1, 10): 

   print (x)

The x=x+1 part isn’t needed here because the range function creates a 

list between the first and last numbers used.

STEP 2
The difference between if and while is when while gets 
to the end of the indented code, it goes back and checks 

the statement is still true. In our example x is less than 10. With each 

loop it prints the current value of x, then adds one to that value. When x 

does eventually equal 10 it stops.

LOOPS

A loop looks quite similar to a condition but they are somewhat different in their operation. A loop will run through the same block of code 
a number of times, usually with the support of a condition.

Conditions and Loops

STEP 5
Press F5 and save the code to execute it. Enter a 

four-letter word in the Shell to begin with, you should 

have the returned message that it’s the word is four letters. Now press 

F5 again  and rerun the program but this time enter a five-letter word. 
The Shell will display that it’s not a four-letter word.

STEP 6
Now expand the code to include another conditions. 

Eventually, it could become quite complex. We’ve 

added a condition for three-letter words:

word=input(“Please enter a four-letter word: “) 

word_length=len(word) 

if word_length == 4: 

       print (word, “is a four-letter word. Well done.”) 

elif word_length == 3: 

       print (word, “is a three-letter word. Try again.”) 

else: 

       print (word, “is not a four-letter word.”) 
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MASTERING MODULES

Think of modules as an extension that’s imported into your Python code to enhance and extend its capabilities. There are countless modules 
available and as we’ve seen, you can even make your own.

Python Modules
We’ve mentioned modules previously, (the Math module) but as modules are such a large 
part of getting the most from Python, it’s worth dedicating a little more time to them. In this 
instance we’re using the Windows version of Python 3.

STEP 1
Although good, the built-in functions within Python 

are limited. The use of modules, however, allows us to 

make more sophisticated programs. As you are aware, modules are 

Python scripts that are imported, such as import math.

STEP 3
The result is an error in the IDLE Shell, as the Pygame 

module isn’t recognised or installed in Python. To 

install a module we can use PIP (Pip Installs Packages). Close down the 
IDLE Shell and drop into a command prompt or Terminal session. At an 

elevated admin command prompt, enter:

pip install pygame

STEP 2
Some modules, especially on the Raspberry Pi, are 

included by default, the Math module being a prime 

example. Sadly, other modules aren’t always available. A good 

example on non-Pi platforms is the Pygame module, which contains 

many functions to help create games. Try: import pygame.

STEP 4
The PIP installation requires an elevated status due it 

installing components at different locations. Windows 
users can search for CMD via the Start button and right-click the result 

then click Run as Administrator. Linux and Mac users can use the Sudo 

command, with sudo pip install package. 
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Python Modules

STEP 5
Close the command prompt or Terminal and relaunch 

the IDLE Shell. When you now enter: import 

pygame, the module will be imported into the code without any 

problems. You’ll find that most code downloaded or copied from the 
internet will contain a module, mainstream of unique, these are 

usually the source of errors in execution due to them being missing.

STEP 7
This code, when saved and executed, will display ten 

random numbers from 1 to 25. You can play around 

with the code to display more or less, and from a great or lesser range. 

For example:

import random

for i in range(25): 

    print(random.randint(1, 100))

STEP 6
The modules contain the extra code needed to 

achieve a certain result within your own code, as we’ve 

previously experimented with. For example:

import random 

Brings in the code from the random number generator module. You 

can then use this module to create something like:

for i in range(10): 

    print(random.randint(1, 25))

STEP 8
Multiple modules can be imported within your code. 

To extend our example, use:

import random 

import math

for I in range(5): 

    print(random.randint(1, 25))

print(math.pi)

STEP 10
This helps create a more streamlined approach to 

programming. You can also use import module*, 

which will import everything defined within the named module. 
However, it’s often regarded as a waste of resources but it works 

nonetheless. Finally, modules can be imported as aliases:

import math as m

print(m.pi)

Of course, adding comments helps to tell others what’s going on.

STEP 9
The result is a string of random numbers followed by 

the value of Pi as pulled from the Math module using 

the print(math.pi) function. You can also pull in certain functions from 
a module by using the from and import commands, such as:

from random import randint

for i in range(5): 

    print(randint(1, 25))
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DEBUGGING

Errors in code are called bugs and are perfectly normal. They can often be easily rectified with a little patience. The important thing is to 
keep looking, experimenting and testing. Eventually your code will be bug free. 

Python Errors
It goes without saying that you’ll eventually come across an error in your code, where Python 
declares it’s not able to continue due to something being missed out, wrong or simply 
unknown. Being able to identify these errors makes for a good programmer.

STEP 1
Code isn’t as fluid as the written word, no matter how 
good the programming language is. Python is 

certainly easier than most languages but even it is prone to some 

annoying bugs. The most common are typos by the user and whilst 

easy to find in simple dozen-line code, imagine having to debug 
multi-thousand line code.

STEP 3
Thankfully Python is helpful when it comes to 

displaying error messages. When you receive an error, 

in red text from the IDLE Shell, it will define the error itself along with 
the line number where the error has occurred. Whilst in the IDLE 

Editor this is a little daunting for lots of code; text editors help by 

including line numbering.

STEP 2
The most common of errors is the typo, as we’ve 

mentioned. The typos are often at the command level: 

mistyping the print command for example. However, they also occur 

when you have numerous variables, all of which have lengthy names. 

The best advice is to simply go through the code and check your spelling. 

STEP 4
Syntax errors are probably the second most common 

errors you’ll come across as a programmer. Even if the 

spelling is correct, the actual command itself is wrong. In Python 3 this 

often occurs when Python 2 syntaxes are applied. The most annoying 

of these is the print function. In Python 3 we use print(“words”), 

whereas Python2 uses print “words”. 
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Python Errors

STEP 5
Pesky brackets are also a nuisance in programming 

errors, especially when you have something like:

print(balanced_check(input()))
Remember that for every ‘(‘ there must be an equal number of ‘)’.

STEP 7
Indents are a nasty part of Python programming that a 

lot of beginners fall foul of. Recall the If loop from the 

Conditions and Loops section, where the colon means everything 

indented following the statement is to be executed as long as it’s 

true? Missing the indent, or having too much of indent, will come back 

with an error. 

STEP 6
There are thousands of online Python resources, code 

snippets and lengthy discussions across forums on 

how best to achieve something. Whilst 99 per cent of it is good code, 

don’t always be lured into copying and pasting random code into your 

editor. More often than not, it won’t work and the worst part is that 

you haven’t learnt anything.  

STEP 8
An excellent way to check your code step-by-step  

is to use Python Tutor’s Visualise web page, found at 

www.pythontutor.com/visualize.html#mode=edit. Simply paste your 

code into the editor and click the Visualise Execution button to run the 

code line-by-line. This helps to clear bugs and any misunderstandings. 

STEP 10
Purely out of interest, the word debugging in 

computing terms comes from Admiral Grace Hopper, 

who back in the ‘40s was working on a monolithic Harvard Mark II 

electromechanical computer. According to legend Hopper found a 

moth stuck in a relay, thus stopping the system from working. 

Removal of the moth was hence called debugging. 

STEP 9
Planning makes for good code. Whilst a little old 

school, it’s a good habit to plan what your code will do 

before sitting down to type it out. List the variables that will be used 

and the modules too; then write out a script for any user interaction 

or outputs. 
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GOING GRAPHICAL

You can draw simple graphics, lines, squares and so on, or you can use one of the many Python modules available, to bring out some 
spectacular effects.

Python Graphics
While dealing with text on the screen, either as a game or in a program, is great, there 
will come a time when a bit of graphical representation wouldn’t go amiss. Python 3 has 
numerous ways in which to include graphics and they’re surprisingly powerful too.

STEP 1
One of the best graphical modules to begin learning 

Python graphics is Turtle. The Turtle module is, as the 

name suggests, based on the turtle robots used in many schools, that 

can be programmed to draw something on a large piece of paper on 

the floor. The Turtle module can be imported with: import turtle.

STEP 3
The command turtle.circle(50) is what draws the circle 
on the screen, with 50 being the size. You can play 

around with the sizes if you like, going up to 100, 150 and beyond; you 

can draw an arc by entering: turtle.circle(50, 180), where the 

size is 50, but you’re telling Python to only draw 180° of the circle.

STEP 2
Let’s begin by drawing a simple circle. Start a New File, 

then enter the following code:

import turtle

turtle.circle(50) 

turtle.getscreen()._root.mainloop()
As usual press F5 to save the code and execute it. A new window will 

now open up and the ‘Turtle’ will draw a circle.

STEP 4
The last part of the circle code tells Python to keep the 

window where the drawing is taking place to remain 

open, so the user can click to close it. Now, let’s make a square:

import turtle

print(“Drawing a square…”)
for t in range(4): 

       turtle.forward(100) 

       turtle.left(90) 

turtle.getscreen()._root.mainloop()
You can see that we’ve inserted a loop to draw the sides of the square.
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Python Graphics

STEP 5
You can add a new line to the square code to add 

some colour:

turtle.color(“Red”) 

Then you can even change the character to an actual turtle by 

entering:

turtle.shape(“turtle”)

You can also use the command turtle.begin_fill(), and turtle.

end_fill() to fill in the square with the chosen colours; red outline, 
yellow fill in this case.

STEP 7
Another way in which you can display graphics is by 

using the Pygame module. There are numerous ways 

in which pygame can help you output graphics to the screen  but for 

now let’s look at displaying a predefined image. Start by opening a 
browser and finding an image, then save it to the folder where you 
save your Python code. 

STEP 6
You can see that the Turtle module can draw out some 

pretty good shapes and become a little more complex 

as you begin to master the way it works. Enter this example:

from turtle import * 

color(‘red’, ‘yellow’) 

begin_fill() 

while True: 

    forward(200) 

    left(170) 

    if abs(pos()) < 1: 

        break 

end_fill() 

done()

It’s a different method,  
but very effective.

STEP 8
Now let’s get the code by importing the Pygame 

module:

import pygame 

pygame.init()
img = pygame.image.load(“RPi.png”)
white = (255, 255, 255) 

w = 900 

h = 450 

screen = pygame.display. 

set_mode((w, h)) 

screen.fill((white))
screen.fill((white)) 

screen.blit(img,(0,0)) 

pygame.display.flip()
while True: 

    for event in pygame.event.get(): 

        if event.type == pygame.QUIT: 

            pygame.quit()

STEP 10
Press F5 to save and execute the code and your image 

will be displayed in a new window. Have a play around 

with the colours, sizes and so on and take time to look up the many 

functions within the Pygame module too. 

STEP 9
In the previous step you imported pygame, initiated 

the pygame engine and asked it to import our saved 

Raspberry Pi logo image, saved as RPi.png. Next you defined the 
background colour of the window to display the image and the 

window size as per the actual image dimensions. Finally you have a 

loop to close the window.
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Glossary of Terms
Just like most technology, Python contains many confusing words and acronyms. Here then, 
for your own sanity, is a handy glossary to help you keep on top of what’s being said when 
the conversation turns to Python programming.

Argument
The detailed extra information used by Python to perform more 

detailed commands. Can also be used in the command prompt to 

specify a certain runtime event.

Block
Used to describe a section or sections of code that are 

grouped together.

Break
A command that can be used to exit a for or while loop. For example, 

if a key is pressed to quit the program, Break will exit the loop.

Class
A class provides a means of bundling data and functionality 

together. They are used to encapsulate variables and functions into a 

single entity.

Comments
A comment is a section of real world wording inserted by the 

programmer to help document what’s going on in the code. They 

can be single line or multi-line and are defined by a # or ‘’’.

Debian
A Linux-based distro or distribution that forms the Debian Project. 

This environment offers the user a friendly and stable GUI to 

interact with along with Terminal commands and other forms of 

system level administration.

Def
Used to define a function or method in Python.

Dictionaries
A dictionary in Python is a data structure that consists of key and 

value pairs.

Distro
Also Distribution, an operating system that uses the Linux Kernel 

as its core but offers something different in its presentation to 

the end user.

Editor
An individual program, or a part of the graphical version of Python, 

that enables the user to enter code ready for execution.

Exceptions 
Used as a means of breaking from the normal flow of a code 
block in order to handle any potential errors or exceptional 

conditions within the program.

Expression
Essentially, Python code that produces a value of something.

Float
An immutable floating point number used in Python.

Function
Used in Python to define a sequence of statements that can be 
called or referenced at any time by the programmer.

GitHub
A web-based version control and collaboration portal designed for 

software developers to better manage source code.

Global Variable
A variable that is useable anywhere in the program.

Graphics
The use of visual interaction with a program, game or operating 

system. Designed to make it easier for the user to manage the 

program in question.

GUI
Graphical User Interface. The interface which most modern 

operating systems use to enable the user to interact with the core 

programming of the system. A friendly, easy to use graphical 

desktop environment.

High-Level Language
A programming language that’s designed to be easy for 

people to read.

IDLE
Stands for Integrated Development Environment or Integrated 

Development and Learning Environment.

Immutable
Something that cannot be changed after it is created.

Import
Used in Python to include modules together with all the 

accompanying code, functions and variables they contain.

Indentation
Python uses indentation to delimit blocks of code. The indents 

are four spaces apart, and are often created automatically after a 

colon is used in the code.
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Glossary of Terms

Integer
A number data type that must be a whole number and not 
a decimal.

Interactive Shell
The Python Shell, which is displayed whenever you launch the 
graphical version of Python.

Kernel
The core of an operating system, which handles data processing, 
memory allocation, input and output, and processes information 
between the hardware and programs.

Linux
An open source operating system that’s modelled on UNIX. 
Developed in 1991 by Finnish student Linus Torvalds.

Lists
A Python data type that contains collections of values, which can 
be of any type and can readily be modified.

Local Variable
A variable that’s defined inside a function and is only useable 
inside that function.

Loop
A piece of code that repeats itself until a certain condition is met. 
Loops can encase the entire code or just sections of it.

Module
A Python file that contains various functions that can be used 
within another program to further extend the effectiveness 
of the code.

Operating System
Also OS. The program that’s loaded into the computer after the 
initial boot sequence has completed. The OS manages all the 
other programs, graphical user interface (GUI), input and output 
and physical hardware interactions with the user.

Output
Data that is sent from the program to a screen, printer or other 
external peripheral.

PIP
Pip Installs Packages. A package management system used to 
install and manage modules and other software written in Python.

Print
A function used to display the output of something to the screen.

Prompt
The element of Python, or the Command Line, where the user 
enters their commands. In Python it’s represented as >>> in the 
interactive shell.

Pygame
A Python module that’s designed for writing games. It includes 
graphics and sound libraries and was first developed in 
October 2000.

Python
An awesome programming language that’s easy to learn and use, 
whilst still being powerful enough to enjoy.

Random
A Python module that implements a pseudo-random character 
generator using the Mersenne Twister PRNG.

Range
A function that used to return a list of integers, defined by the 
arguments passed through it.

Root
The bottom level user account used by the system itself. Root is 
the overall system administrator and can go anywhere, and do 
anything, on the system.

Sets
Sets are a collection of unordered but unique data types.

Strings
Strings can store characters that can be modified. The contents of 
a string are alphanumerical and can be enclosed by either single 
or double quote marks.

Terminal
Also Console or Shell. The command line interface to the 
operating system, namely Linux, but also available in macOS. 
From there you can execute code and navigate the filesystem. 

Tkinter
A Python module designed to interact with the graphical 
environment, specifically the tk-GUI (Tool Kit Graphical 
User  Interface).

Try
A try block allows exceptions to be raised, so any errors can be 
caught and handled according to the programmer’s instructions.

Tuples
An immutable Python data type that contains an ordered set of 
either letters or numbers.

UNIX
A multitasking, multiuser operating system designed in 
the ‘70s at the Bell Labs Research Centre. Written in C and 
assembly language

Variables
A data item that has been assigned a storage location in the 
computer’s memory.

X
Also X11 or X-windows. The graphical desktop used in Linux-
based systems, combining visual enhancements and tools to 
manage the core operating system.

Zen of Python
When you enter: import this into the IDLE, the Zen of Python 
is  displayed.
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GET THE CODE

We’ve got a huge repository of code that’s free for you to download, use, insert into your own Python routines and make even better. Here’s 
how to get hold of it.   

BDM’s Code Repository
What better way to learn Python than from playing around with actual code? Back in the 80s, 
we typed in lines of BASIC or Assembler code from the monthly magazines of the time. It was 
laborious, but we hacked the code and made it our own; making us all-round better coders. 

STEP 1
Begin by powering up your Pi and opening a web 

browser. Navigate to the BDM Site at https://

bdmpublications.com/, and then scroll to the bottom of the main 

page and click on the BDM’s Code Portal link. 

STEP 3
Within the file structure of your Raspberry Pi, create a 
new folder called Code; it’s in here that you can create 

your own code, as well as unpack the Code Portal contents. Open the 

downloaded, compressed Code Portal, select all the files within the 
archive, and extract them into the newly created Code folder. 

STEP 2
You will need to register a user account with BDM 

first, before being able to download the code. Simply 
click on the Join Us link, or if you’ve already registered, then click on 

the Login link. Once logged in, you can download the code by clicking 

on the blue Code Portal button at the bottom of the page. 

STEP 4
You are now able to load up any of the code within 

your favourite IDLE, which means you’re free to use 

the code in your scripts and programs. Remember, if you’ve got 

some great code you want to share, then get in contact and tell us 

all about it.  
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Pi Projects: 
Ideas and Code
The Raspberry Pi is all about projects. For 

instance we’ve seen the Pi attached to a 

satellite, taking high-resolution images of the 

Earth while in orbit. Scientists have also used 

a Pi to monitor habitats in some of the most 

extreme places on the planet and enthusiasts 

the world over have used a Raspberry Pi as the 

driving force of their unique projects.
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If you’re looking to add a little something extra to your Python code, then consider including a 
loading screen. The loading screen is a short introduction, or piece of art, that appears before the 
main part of your code.  

LOAD””
Back in the 80s, in the 8-bit 
home computing era, 
loading screens were 
often used to display the 
cover of a game as it 
loaded from tape. The 
image would load itself 
in, usually one-line-at-
a-time, then proceed 
to colour itself in 
while the loading 
raster bars danced 

around in the borders of the screen.

Loading screens were a part of 
the package and often the buy-in 

for the whole game as an experience. Some loading screens 
featured animations, or a countdown for time remaining as the 
game loads, while others even went so far as to include some 
kind of playable game. The point being: a loading screen is not 
just an artistic part of computing history, but an introduction to 
the program that’s about to be run.

While these days loading screens may no longer be with us, in 
terms of modern gaming we can still include them in our own 
Python content. Either just for fun, or to add a little retro-
themed spice to the mix. 

SCREEN$
Creating a loading screen in Python is remarkably easy. You have 
several options to hand: you can create a tkinter window and 
display an image, followed by a brief pause, before starting your 
main code, or you could opt for a console-based ASCII art version 
that loads one-line-at-a-time. Let’s look at the latter and see how 
it works.

First you’ll need some ASCII art, you can look up plenty of 
examples online, or use an image to ASCII Art converter to 
transform any images you have to ASCII. When you have your ASCII 
art, drop it into a newly created folder inside a normal text file.

The code is quite simple: import the OS and Time modules and then 
create a Python function called loading_screen with a (seconds) 
option. Within the function, open the text file with the ASCII art as 
read-only and create a For loop that’ll read the text file one-line-
at-a-time. Next, print the lines – incidentally, the lines, end=’’ 

element will strip the newline from the text document, without it 
you’ll end up with a double-line spaced display. Include the timing 
in seconds and close the text file buffer.

The final part of the code, #Main Code Start, is where you’ll 
clear the screen (CLS for Windows, Clear for Linux (Raspberry 
Pi) and macOS) and call the function, together with the output 
number of seconds to wait for each line to be written to the 
screen – in this case, .5 of a second.

THE CODE
Launch Python and enter the following code to a New File:

import os

import time

def loading_screen(seconds):
    screens=open(“screens.txt”, ‘r’)

    for lines in screens:

        print(lines, end=’’)

        time.sleep(seconds)

    screens.close()

#Main Code Start
os.system(‘cls’ if os.name == ‘nt’ else ‘clear’)

loading_screen(.5)

print (“\nYour code begins here...”)

Save the file, call it screens.txt for now.

Creating a Loading Screen
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Creating a Loading Screen
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Save the code as screens.py, drop into a Command Prompt or 
Terminal and execute it. The screen will clear and your ASCII art 
inside the text file will load in line-by-line, creating a loading 
screen effect. 

LOADING…

Another favourite introduction screen is that of a simple loading 
animation, where the word loading is displayed, followed by 
some characters, and a percentage of the program loaded. While 
it may not take long for your Python code to load, the effect can 
be interesting.

Create a New File in Python and enter the following code:

import os

import time

def loading_bar(seconds):
  for loading in range(0,seconds+1):
    percent = (loading * 100) // seconds
    print(“\n”)

    print(“Loading...”)
    print(“<” + (“-” * loading) + (“ “ * 
(seconds-loading)) + “> “ + str(percent) + “%”)
    print(“\n”)

    time.sleep(1)

    os.system(‘cls’ if os.name == ‘nt’ else 

‘clear’)  

#Main Code Start
loading_bar(10)

print (“\nYour code begins here...”)
The code works in much the same way as the previous, except, 
instead of reading from a text file, it’s running through a For loop 
that prints Loading… followed by an animation of sorts, along with a 
percentage counter; clearing the screen every second and displaying 
the new results. It’s simple, yes, but quite effective in its design. 

COMBINING THE TWO

How about combining the two elements we’ve looked at? Let’s 
begin with a Loading… progress bar, followed by the loading 
screen. After that, you can include your own code and continue 
your program. Here’s the code:

import os

import time

def loading_bar(seconds):
  for loading in range(0,seconds+1):
    percent = (loading * 100) // seconds
    print(“\n”)

    print(“Loading...”)
    print(“<” + (“-” * loading) + (“ “ * 
(seconds-loading)) + “> “ + str(percent) + “%”)
    print(“\n”)

    time.sleep(1)

    os.system(‘cls’ if os.name == ‘nt’ else 

‘clear’)  

def loading_screen(seconds):
    screens=open(“screens.txt”, ‘r’)

    for lines in screens:

        print(lines, end=’’)

        time.sleep(seconds)

    screens.close()

#Main Code Start
loading_bar(10)
os.system(‘cls’ if os.name == ‘nt’ else ‘clear’)

loading_screen(.5)

print (“\nYour code begins here...”) 
You can, of course, pull those functions up wherever and 
whenever you want in your code and they’ll display, as they 
should, at the beginning. Remember to have the ASCII 
text file in the same folder as the Python code, or, at the 
screens=open(“screens.txt”, ‘r’) part of the code, point 
to where the text file is located.

ADVENTURE TIME

A good example of using loading screen, ASCII art text images is when coding 

a text adventure. Once you’ve established your story, created the characters, 

events and so on, you could easily incorporate some excellently designed 

ASCII art to your game.

Imagine coming across a dragon, in game, and displaying its representation 

as ASCII. You can then load up the image lines, one-by-one, and continue with 

the rest of the adventure code. It’s certainly worth having a play around with 

and it’ll definitely add a little something else extra.

b0317180-1dbc-4fe7-b445-0fab5a6a6c7ab0317180-1dbc-4fe7-b445-0fab5a6a6c7a



www.bdmpublications.com120

Pi Projects: Ideas and Code  

Of the many, amazing human achievements over the past decade or so, the International Space 
Station tops the bill. This incredible collaboration between nations sees vital experiments carried 
out in space, as well as observations of our own planet.  

TO BOLDLY GO…

Indeed, the ISS is something most of us consider as a worthy 
example of what can happen when we work together. NASA, 
among other agencies, uses a wealth of Python code onboard the 
ISS to help automate routines, alongside its function as an 
in-between link to translate code from one language 
to another, and then into a human-readable 
format. If you’re considering a career in 
space, then learning Python is a must-
have skill.

While we’re not able to fill 
you in on all the details 
regarding the code 
the ISS utilises, we 
can look at a fun 

Python script that 
will track the ISS, 
display the number 
of astronauts on 

board, and update 
the station’s current 
latitude and longitude 
every five seconds, while 
also displaying your current 
latitude and longitude.

Displaying all that information 
in a single screen can become a 
little cluttered, so in this instance 
we’re going to look at spreading 
all those details over three 
screens: a text document window 
-displaying the astronauts and your 
current latitude and longitude, 
a command line (or Terminal 
window) - displaying the continually 
updating latitude and longitude of 
the ISS as it orbits Earth, and a final, 
large window displaying a map of 
the world, together with an icon 
representing the ISS, that’s updated 
as it orbits. Interested? Read on.

Tracking the ISS with Python
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THE GRAPHICS

Firstly, we need to get hold of a map of the world and an image of the 
ISS, to use as an icon that will be updated according to the position 
of the space station as it travels over the surface. A quick Google of 
World Map will help you out here. Look for one that’s reasonably 
large, the one we used for this example was 1280 x 700, and one 
that has the names of the countries – if you’re using this with young 
people, to help with putting shapes of countries to names.

As we’re going to be using Turtle, a component of tkinter, the 
downloaded images will need to be converted to GIF, since this is the 
default and recommended image format. You can easily look up a 
converter online, but using GIMP, which is cross-platform and therefore 
works on both the Raspberry Pi and a Windows PC, will suffice. Simply 
load the image up in your image editor app and choose Save As, call 
them map and iss respectively, and click GIF as the image format. 
Remember to also resize the ISS image before saving it as a GIF.

Next, look for an ISS icon. As this is going to be a graphical 
representation of the location of the ISS, we need the image to 
be reasonably small so it doesn’t drown out the locations on the 
map, but also prominent enough to see when the map is loaded. 
We opted for an image that’s 32 x 22 pixels in size. Don’t worry 
too much if you’re not able to find one that small, you can always 
resize it in an image-editing app such as GIMP.

THE CODE

The code we’re using here utilises an open source API 
(Application Programming Interface) to retrieve real-time data 
online regarding the status of the ISS. An API enables applications 
to communicate with one another by providing the raw data that 
a programmer can pull out and interact with in their own code. In 
this case, the API in question is a web-based collection of raw data 
that’s stored in a JSON (JavaScript Object Notation) format – an 
accessible and easy to use data-interchange interface.

In order for Python to interact with the 
JSON provided data, it needs to use the 
urllib.request and json modules. We’re 
also going to be using a new module called 
geocoder, which will pull up a users’ current 
latitude and longitude based on their IP 
address. The two JSON APIs can be located 
at: http://api.open-notify.org/astros.
json, and, http://api.open-notify.org/iss-

now.json. One of which contains the data 
regarding the astronauts onboard the ISS, 
and the other contains the data regarding 
the current location of the ISS in longitude 
and latitude.
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Let’s begin by breaking the code into bite-sized chunks:

import json, turtle, urllib.request, time, 
webbrowser

import geocoder # need to pip install geocoder 
for your lat/long to work.
First, we need to import the modules used in the code: json, 
turtle, urlib.request, time, and webbrowser. The json and urlib.
request modules deal with the data being pulled from the APIs, 
turtle will display the graphics, and time you already know. The 
Webbrowser module will open text files in the default browser 
or default text reader application. The geocoder module is a 
new element and you will need to install it with: pip install 
geocoder (or try pip3 install geocoder, if the pip install 
command still won’t load the module). Geocoder can retrieve a 
users’ location based on their IP address, as each ISP will have a 
geo-specific IP.

#Retrieve the names of all the astronauts 

currently on board the ISS, and own lat/long - 
write to a file and display
url = “http://api.open-notify.org/astros.json”
response = urllib.request.urlopen(url)
result = json.loads(response.read())
a=open(“iss.txt”,”w”)

a.write(“There are currently “ + 

str(result[“number”]) + “ astronauts on the 
ISS:\n\n”)

people = result[“people”]

for p in people:

  a.write(p[“name”] + “ - on board” + “\n”)

g=geocoder.ip(‘me’) # need to pip install 
geocoder, and import as in the headers above
a.write(“\nYour current Lat/Long is: “ + str(g.
latlng)) # prints your current lat/long in the 
text file.
a.close()

webbrowser.open(“iss.txt”)  

This section will use the json and urllib.request modules to pull 
the data from the API that contains the names of the astronauts 
onboard the ISS. It then creates a new text file called iss.txt, 
where it’ll write ‘There are currently X astronauts on the ISS…’ 
and list them by name. The second part of this section will then 
use the geocoder module to retrieve your current latitude 
and longitudes, based on your IP address, and also write that 
information to the end of the text file that contains the names 
of the astronauts. The last line, webbrowser.open(“iss.txt”) will 
use the webbroser module to open and display the newly written 
text file in either the system’s default text file reading app or the 
default web browser; either will work just fine.

#Setup world map in Turtle

screen = turtle.Screen()

screen.setup(1280, 720)

screen.setworldcoordinates(-180, -90, 180, 90)

#Load the world map image
screen.bgpic(“map.gif”)

screen.register_shape(“iss.gif”)
iss = turtle.Turtle()

iss.shape(“iss.gif”)
iss.setheading(45)
iss.penup()

This section of the code sets up the graphical window containing 
the world map and the ISS icon. To begin, we set up the turtle 
screen, using the resolution of the world map image we 
downloaded at the start of this tutorial (1280 x 720). The screen.
setworldcoordinates syntax will mark the boundaries of the 
screen, creating the x and y coordinates of the four corners of 
the canvas, so that the ISS icon can freely travel across the map 
of the world and wrap itself back to the opposite side when it 
reaches an edge. The ISS icon is set as the turtle pen shape, giving 
it an angle of 45 degrees when moving.

while True:

  #Load the current status of the ISS in real-

time  

  url = “http://api.open-notify.org/iss-now.json”
  response = urllib.request.urlopen(url)
  result = json.loads(response.read())

  #Extract the ISS location
  location = result[“iss_position”]
  lat = location[“latitude”]
  lon = location[“longitude”]

  #Output Latitude and Longitude to the console
  lat = float(lat)
  lon = float(lon)
  print(“\nLatitude: “ + str(lat))

  print(“Longitude: “ + str(lon))

  #Update the ISS location on the map  
  iss.goto(lon, lat)
  #refresh every 5 seconds

  time.sleep(5)

Now for the final part of the code: Here we collect the location 
data from the ISS status API, pulling out the latitude and 
longitude elements of the JSON file. The code then prints the 
latitude and longitude data to the console/Terminal, transferring 
the data from a float to a string in order to print it correctly. The 
last section will use the latitude and longitude as variables lat 
and lon, to update the ISS icon on the map every five seconds.
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Here’s the code in its entirety:

import json, turtle, urllib.request, time, webbrowser
import geocoder # need to pip install geocoder for 
your lat/long to work.

#Retrieve the names of all the astronauts currently on 

board the ISS, and own lat/long - write to a file and 
display

url = “http://api.open-notify.org/astros.json”
response = urllib.request.urlopen(url)
result = json.loads(response.read())
a=open(“iss.txt”,”w”)

a.write(“There are currently “ + str(result[“number”]) 
+ “ astronauts on the ISS:\n\n”)

people = result[“people”]

for p in people:

  a.write(p[“name”] + “ - on board” + “\n”)

g=geocoder.ip(‘me’) # need to pip install geocoder, 
and import as in the headers above

a.write(“\nYour current Lat/Long is: “ + str(g.
latlng)) # prints your current lat/long in the text 
file.
a.close()

webbrowser.open(“iss.txt”)

#Setup world map in Turtle

screen = turtle.Screen()

screen.setup(1280, 720)

screen.setworldcoordinates(-180, -90, 180, 90)

#Load the world map image
screen.bgpic(“map.gif”)

screen.register_shape(“iss.gif”)
iss = turtle.Turtle()

iss.shape(“iss.gif”)
iss.setheading(45)
iss.penup()

while True:

  #Load the current status of the ISS in real-time

  url = “http://api.open-notify.org/iss-now.json”
  response = urllib.request.urlopen(url)
  result = json.loads(response.read())

  #Extract the ISS location
  location = result[“iss_position”]
  lat = location[“latitude”]
  lon = location[“longitude”]

  #Output Latitude and Longitude to the console
  lat = float(lat)
  lon = float(lon)
  print(“\nLatitude: “ + str(lat))

  print(“Longitude: “ + str(lon))

  #Update the ISS location on the map  
  iss.goto(lon, lat)
  #refresh every 5 seconds

  time.sleep(5)

Create a new folder in your system, called ISSTrack (for example), and 
place the two graphics as well as the Python code itself. 

RUNNING THE CODE

The code is best executed from the command line, or Terminal. 
Clear your desktop, enter your command line, and navigate 
to where you’ve saved the code plus the two graphics. 
Launch the code with either: python3 ISSTrack.py, or, 

python ISSTrack.py (depending on whether you’re using a 
Raspberry Pi/Linux, or a Windows PC, and what you’ve called 
the Python code). 

The code will launch two extra windows together with the 
command line window you already have open. One will be the 
text file, containing the named astronauts, along with your 
current latitude and longitude and the other will be the world 
map with the ISS icon located wherever the ISS is currently 
orbiting. The command line window will start scrolling through 
the changing latitude and longitude of the ISS.
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There’s a remarkable amount you can do with some simple text and a little Python know-how. 
Combining what you’ve already learned, we can create some interesting animation effects from 
the command line.  

THE FINAL COUNTDOWN

Let’s begin with some example code that will display a large 
countdown from ten, then clear the screen and display a message. 
The code itself is quite simple, but lengthy. You will need to start by 
importing the OS and Time modules, then start creating functions 
that display the numbers (see image below) and so on to 10. It’ll 
take some time, but it’s worth it in the end. Of course, you can 
always take a different approach and design the numbers yourself.

The next step of the process is to initialise the code settings and 
start the countdown:

#Initialise settings
start = 10

message = “>      BLAST OFF!!          <”

#Start the countdown

for counter in range(start, 0, -1):
    if counter == 10:

        ten()

    elif counter == 9:

        nine()

    elif counter == 8:

        eight()
    elif counter == 7:

        seven()

    elif counter == 6:

        six()

    elif counter == 5:

        five()
    elif counter == 4:

        four()

    elif counter == 3:

        three()

    elif counter == 2:

        two()

    elif counter == 1:

        one()

    time.sleep(1)

    os.system(‘cls’ if os.name == 

‘nt’ else ‘clear’)

And finally, we can add a display for the message:
This will pull the functions from the imported Count.py and print 
them to the screen.

    elif counter == 3:

        count.three()

    elif counter == 2:

        count.two()

    elif counter == 1:

        count.one()

#Display the message
print(“v^v^v^v^v^v^v^v^v^v^v^v^v^v^v”)

print(“<                           >”)

print(message)
print(“<                           >”)

print(“v^v^v^v^v^v^v^v^v^v^v^v^v^v^v”)

print(“\n\n\n”)

The code in its entirety can be viewed from within our Code Repository: 

https://bdmpublications.com/code-portal, where 
you’re free to copy it to your own Python IDLE and 
use it as you see fit. The end effect is quite good 
and it’ll be worth adding to your own games, or 
presentations, in Python.

To extend the code, or make it easier to use, you 
can always create the number functions in their 
own Python code, call it Count.py for example, then 
import Count at the beginning of a new Python file 
called Countdown.py, along with the OS and Time 
modules:

import os

import time

import count

From there, you will need to specify the imported code in the 
Countdown section:

#Start the countdown

for counter in range(start, 0, -1):
    if counter == 10:

        count.ten()

    elif counter == 9:

        count.nine()

    elif counter == 8:

        count.eight()
    elif counter == 7:

       count.seven()

    elif counter == 6:

        count.six()

    elif counter == 5:

        count.five()
    elif counter == 4:

        count.four()

Text Animations
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ROCKET LAUNCH

Building on the previous 
countdown example, we can 
create an animated rocket that’ll 
launch after the Blast Off!! 
message has been printed. The 
code would look something like:

def Rocket():

  distanceFromTop = 20

  while True:

    os.system(‘cls’ if os.name == ‘nt’ else ‘clear’)  

    print(“\n” * distanceFromTop)

    print(“          /\        “)

    print(“          ||        “)
    print(“          ||        “)
    print(“         /||\       “)
    time.sleep(0.2)

    os.system(‘cls’ if os.name == ‘nt’ else ‘clear’)  

    distanceFromTop -= 1

    if distanceFromTop <0:

      distanceFromTop = 20

#Launch Rocket

Rocket()

Here, we’ve created a new function called Rocket, which produces 
the effect of an ASCII-like rocket taking off and scrolling upwards; 
using the distanceFromTop variable.

To use this, add it to the end of the previous countdown code and, 
at the end of the Blast Off!! message, add the following lines:

print(“\n\n\n\n”)

input(“Press Enter to launch rocket...”
This will allow your message to be displayed and then, when the 
user has hit the Enter button, the rocket will launch.

Again, the code in its entirety can be found in the Code 
Repository at: https://bdmpublications.com/ code-portal.

ROLLING DIE

Aside from the rocket animation, together with its countdown, 
another fun bit of text-based animation is that of a rolling dice.

A rolling dice can be a great animation to include in an adventure 
game, where the player rolls to see what their score is compared 
to that of an enemy. The highest roller wins the round and the 
losers’ health drops as a result. It’s an age-old combat sequence, 
used mainly in the Dungeon and Dragons board games and 
Fighting Fantasy novels, but it works well.

The code you’ll need to animate a dice roll is:

import os

import time

from random import randint

die     = [“   \n O \n   “]   #1
die.append(“  O\n   \nO  “)   #2

die.append(“O  \n O \n  O”)   #3

die.append(“O O\n   \nO O”)   #4

die.append(“O O\n O \nO O”)   #5

die.append(“O O\nO O\nO O”)   #6

def dice():

  for roll in range(0,15):
    os.system(‘cls’ if os.name == ‘nt’ else 

‘clear’)  

    print(“\n”)

    number = randint(0,5)

    print(die[number])
    time.sleep(0.2)

#Main Code Begins
dice()

You may need to tweak the O entries, to line up the dots on the 
virtual dice. Once it’s done, though, you’ll be able to add this 
function to your adventure game code and call it up whenever 
your character, or the situation, requires some element of luck, 
combat, or chance roll of the dice.

DISCOVER ANIMATIONS

The great thing about Python code is that it’s so accessible. These 

few examples will help you add some fun, or something different, 
to your programs, but they’re just the tip of the proverbial iceberg. 

If there’s something you want to include in your code, and you’re at 

a sticking point, then consider heading over to Stack Overflow and 
search for Python 3 content.

Stack Overflow is a great online help and resource portal, where you 
can ask questions and experts will try and help you. It doesn’t always 

work out, but most of the time, you’ll find what you’re looking for 
within this great resource.

Also, if you’re after a simple animation then take to Google and 

spend some time searching for it. While you may not find exactly 
what it is you’re after, you’re bound to come across something very 

like the desired effect; all you need to do is modify it slightly to 
accomplish your own goals.

You’ll find that many professionals will often take to the Internet to 
find content they’re after. True, they’re able to code it themselves, 
but even experts get stuck sometimes, so don’t worry about hunting 

code snippets down; you’re in good company.
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There’s a school of thought, that to master the foundations of good coding skills you need to 
have some experience of how code was written in the past. In the past is a bit of a loose term, but 
mostly, it means coding from the 80s.  

THE GOLDEN ERA OF CODE

While it may seem a little counterproductive to learn how to code 
in a language that’s virtually obsolete, there are some surprising 
benefits to getting your hands dirty with a bit of retro coding. 
Firstly, learning old code will help you build the structure of code 
as, regardless of whether it is a language that was developed 
yesterday, or forty years ago, code still demands strict discipline to 
work correctly. Secondly, everyday coding elements, such as loops, 
sub routines and so on, are a great visual aid to learn in older code, 
especially BASIC. Lastly, it’s simply good fun.

GOING BASIC

The easiest retro language to play around with is, without doubt, 
BASIC. Developed back in the mid-sixties, BASIC (Beginner’s All-
Purpose Symbolic Instruction Code) is a high-level programming 
language whose design was geared toward ease of use. In a time 
when computers were beginning to become more accessible, 
designers John Kemeny and Thomas Kurtz needed a language that 
students could get to grips with, quickly and easily. Think of BASIC 
as a distant relation to Python.

THE BEEB

The problem with BASIC is that there were so many different 
versions available, across multiple 8-bit platforms, with each having 
its own unique elements on top of the core BASIC functions. The 

BASIC that was packaged with the Commodore 64 
was different to that on the ZX Spectrum, 

or the Atari home computers, 
due to the differing hardware 
of each system. However, it’s 

widely recognised that one 
of the ‘best’, and possibly most 

utilised, form of BASIC from the 
80s was that of BBC BASIC.

Once downloaded, launch the executable and follow the on-screen 
instructions to install it. MacOS users can get everything they need 
from: http://www.g7jjf.com/. However, Raspberry Pi and Linux users 
will have to do a little nifty keyboard work before they can enjoy the 
benefits of the Beeb on their screens. Here’s how to get it working 
under Linux:

BBC BASIC was used on the Acorn BBC Micro range of computers, 
utilising the MOS 6502-based processor technologies. It was one of 
the quickest examples of BASIC and, thanks to an inline assembler, 
it was also capable of allowing the developers of the time to write 
code for different processor types, such as the Zilog Z80 – a CPU 
present in the ZX Spectrum, as well as many arcade machines.

The BBC Micro was designed and built by Acorn Computers – a 
company that is historically responsible for the creation of the ARM 
CPU - the processor that’s used in virtually every Android phone and 
tablet, smart TV, set top box and so on, as well as the Raspberry Pi – 
so essentially, the BBC Micro is the grandfather of the Raspberry Pi. 

The BBC Micro was born in a time when the UK government 
was looking for a countrywide computer platform to be used 
throughout education. Different companies bid, but it was the 
BBC’s Computer Literacy Project (the BBC Micro) that was chosen, 
due to its ruggedness, upgradability, and potential for education. 
As a result, the BBC Micro, or the Beeb as it’s affectionately known, 
became the dominant educational computer throughout the 80s. 

BEEBEM

Naturally, you could scour eBay and look for a working BBC Micro to 
play around on, and it’ll be a lot of fun. However, for the sake of just 
getting hands-on with some retro code, we’ll use one of the best BBC 
Micro emulators available: BeebEm.

BeebEm was originally developed for UNIX in 1994 by Dave Gilbert and 
later ported to Windows. It is now developed by Mike Wyatt and Jon 
Welch, who maintain the Mac port of the emulator, and is therefore 
available for Windows 10, Linux and macOS, as well as other platforms.

If you’re using Windows 10, simply navigate to http://www.mkw.

me.uk/beebem/index.html, and download the BeebEM414.exe that’s 
displayed in the main screen.

Retro Coding
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First, drop to a Terminal and enter:

sudo apt-get update && upgrade
wget http://beebem-unix.bbcmicro.com/download/
beebem-0.0.13.tar.gz
Then, extract the compressed files with:

tar zxvf beebem-0.0.13.tar.gz, then enter the newly 
created Beebem folder with: cd beebem-0.0.13/.

Now enter the following lines, hitting Enter and answering Y to 
accept any changes:

sudo apt-get install libgtk2.0-dev libsdl1.2-dev
./configure
make

sudo make install

This may take some time, but when it’s all done, simply enter: 
beebem, to start the BBC Micro emulator.

BBC BASIC

Once installed and powered up, BeebEm will display the default BBC 
system start-up, along with a couple 
of beeps. Those of you old enough to 
have been in a UK school in the 80s will 
certainly recall this setup.

In BASIC, we use line numbers to 
determine which lines of code run in 
sequence. For example, to print something to screen we’d enter:

10 print “hello”

Once you’ve typed the above in, press 
Enter and then type:

run

We can of course expand the code 
to include variables, multi-line print 
statements, and so on:

1 CLS
10 Input “Hello, what’s your name? “ n$

20 print

30 print “Hi, “ n$ “ I hope you’re well today.”

Type RUN to execute the code, you can also type LIST to view the 
code you’ve entered.

As you can see, variables are handled in much the same way as 
Python, a print statement on its own displays a blank line, and CLS 
clears the screen; although the Pi uses Clear instead of CLS. We’re 
also able to do some maths work, and play around with variables too:
1 CLS
10 input “how old are you? “ a

20 print

30 if a > 40 print “You’re over 40 years old.”

40 if a < 40 print “You’re under 40 years old.”

50 print

BBC BASIC also has some interesting built-in features, such as the 
value of PI:

1 REM Area of a circle
2 CLS
20 Input “Enter the radius: “ r
30 let area = PI*r*r

40 print “The area of your circle is: “; area

50 print ‘’’

As you’ll notice, variables with a dollar 
($) represent strings, nothing after the 
variable, or a hash (#) represent floating 
point decimals; a whole integer has a % 
character, and a byte has an ampersand 
(&). The single quotes after the Print on 
line 50 indicate a blank line, one for each 
tick, while REM on line 1 is a comment, 
and thus ignored by the BASIC compiler.

Needless to say, there’s a lot you can learn, as well as having fun, with 
BBC BASIC. It’s a rainy day project and something that’s interesting 
to show the kids – this is how we rolled back in the 80s, kids! 

There are a number of sites you can visit to learn BBC BASIC, such as 
http://archive.retro-kit.co.uk/bbc.nvg.org/docs.php3.html. See what 
you can come up with using BBC BASIC, or other BASIC types for 
different systems, and let us know what you’ve created.

OTHER SYSTEMS

Naturally, you don’t have to look 

to the BBC Micro to play around 
with some retro code. If you 
grew up with a Commodore 64, 
then you can always try VICE, 
the C64 emulator. Likewise, the 
ZX Spectrum has a slew of great 
emulators available for every 
modern system to play around 
on. In fact, you can probably 
find an emulator for virtually 
every 8-bit or 16-bit machine 
that was produced over the 
years. Each has their own 
unique perspective and coding 
nuances, so find a few and see 
what you can create.

b0317180-1dbc-4fe7-b445-0fab5a6a6c7ab0317180-1dbc-4fe7-b445-0fab5a6a6c7a



STEP 1
First we need to create some ASCII-like text, head over 

to http://patorjk.com/software/taag. This is an online 

Text to ASCII generator, created by Patrick Gillespie. Start by entering 

Happy into the text box, the result will be displayed in the main 

window. You can change the font with the drop-down menu to the 

side of the text box; we’ve opted for Big.

STEP 3
Save the text file as 1.txt (you can call it anything, but 
now for ease of use 1.txt will suffice) and save the file 

in the newly created Test folder. When it’s saved, do exactly the same 

for the word Birthday. You can select a new font from the ASCII 

Generator, or add extra characters, and when you’re ready save the 

file as 2.txt.  

STEP 2
Now, on your computer create a folder in your Python 

code directory (call it Test, for now) and open either 
Leafpad for the Raspberry Pi or, if you’re using Windows 10, then 

Notepad. Click on the Select & Copy button, at the bottom of the 

ASCII Generator webpage, and paste the contents into the text editor. 

STEP 4
Open up Python and create a New File. We’re going 

to need to import the OS and Time modules for this 

example, followed by a line to clear the screen of any content. If 

you’re using Windows, then you’ll use the CLS command, whereas it’s 

Clear for the Raspberry Pi’s Linux OS. We can create a simple if/else 

statement to handle the command. 

Animation in Python can be handled with the likes of the Tkinter and Pygame modules, however, 
there’s more than one way to achieve a decent end result. Using some clever, text file reading 
code, we can create command-line animations.  

ASCII ANIMATION

Let’s assume you wanted to create an animated ASCII Happy Birthday Python script, with the words Happy and Birthday alternating in 
appearance. Here’s how it’s done.    
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Using Text Files 
for Animation
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STEP 5
Next we need to create a list with the names of the 

text files we want to open, and then we need to open 
them for display in the Terminal.

filenames = [“1.txt”, “2.txt”]
frames = []

for name in filenames:
    with open(name, “r”, encoding=”utf8”) as f:
        frames.append(f.readlines()) 

STEP 7
Save the Python code in the same folder as the text 

files and drop into a Terminal or Command Prompt. 
Navigate to the folder in question, and enter the command:

python3 NAME.py  

Where NAME is whatever you called your saved Python code.

STEP 6  We’ve used the UTF8 standard when opening the text 

files, as ASCII art as text, within a text file, often 
requires you to save the file as UTF compliant – due to the characters 
used. Now we can add a loop to display the files as 1.txt, then 2.txt, 
creating the illusion of animation while clearing the screen after each 

file is displayed. 

STEP 8  Here’s the code in full:

import os, time

os.system(‘cls’ if os.name == ‘nt’ else ‘clear’)

filenames = [“1.txt”, “2.txt”]
frames = []

for name in filenames:
    with open(name, “r”, encoding=”utf8”) as f:
        frames.append(f.readlines())

for i in range(10):
    for frame in frames:

        print(“”.join(frame))     
        time.sleep(1)

        os.system(‘cls’ if os.name == ‘nt’ else 

‘clear’) 

STEP 10
You can spice things up a little by adding system/

Terminal colours. You’ll need to Google the system 

codes for the colours you want. The code in our example turns the 

Raspberry Pi Terminal to green text on a black background, then 

changes it back to white on black at the end of the code. Either way, it’s 

a fun addition to your Python code.  

STEP 9
Note, from the loop, within the code, we’ve used the 

same CLS and Clear if/else statement as before. Again, 

if you’re running on Windows then the OS module will use the CLS 

command, ‘ELSE’ if you’re using Linux or a Mac, the Clear command 

will work correctly. If you want, you could use a Try/Except 

statement instead. 

Using Text Files for Animation
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STEP 1
The Raspberry Pi TV HAT is compatible with the Pi 

Zero, Pi 3 A+ and B+ models. The kit comes with 

everything you need to connect the HAT to your RPi, including spacers, 

screws and the 40-pin header. Begin by opening the box and spreading 

the contents out on a clear area. 

STEP 3
With the spacers attached to the Raspberry Pi, line up 

the TV HAT with the 40-pin header, ensuring that the 

side of the HAT with the Pi logo is facing up and the HAT’s gold 

coloured coaxial attachment is on the side of the SD card. When in 

place, screw the HAT to its spacers. 

STEP 2
Start by connecting the 40-pin header to the 40-pin 

GPIO on top of your Raspberry Pi. Now take the 

spacers and screws and fit them to the corresponding holes in the 
corners of the main Raspberry Pi and the TV HAT; use three spacers 

and screws for the Pi Zero and two for the Pi 3 Models A+/B+. 

STEP 4
Now attach the coaxial adapter to the gold-coloured 

pin at the side of the TV HAT. It may need a firm push 
to lock into place, it will ‘click’ when fully inserted and in position. Now 

you will need to connect the TV HAT to your TV aerial and provide 

power to the Raspberry Pi.

A HAT, in case you’re wondering, is a Hardware Attached on Top add-on board that connects to 
a Raspberry Pi’s 40-pin GPIO. They can extend the capabilities of a Pi by adding motors, LCDs, 
sensors, controllers and more. In addition, they can be programmed via the Pi and Python.  

TV HAT

In this tutorial, we’re using the Raspberry Pi TV HAT as sold by The Pi Hut (https://thepihut.com/products/raspberry-pi-tv-
hat?variant=13539182673982). It’s a Sony CXD2880 TV Tuner supporting DVB-T and 2nd-gen DVB-T2 standards. 
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STEP 5
You can use the HDMI port to connect your Pi and its 

TV HAT to the TV/monitor, or you can just power the 

Pi (the TV HAT gets its power from the Pi) and connect remotely. The 
most important element is to ensure that the TV HAT is connected to 

an aerial that you know can receive a TV signal.  

STEP 7
Press Enter and allow the Pi to run through the update 

process. If you have any significant updates, you may 
need to answer ‘Y’ to any questions the Pi asks regarding these. 

Answering yes will replace the older software with the newer versions 

and is necessary for a smoothly running Pi.  

STEP 6  Power up your Raspberry Pi and when you get to the 

Raspbian desktop, open up the Terminal app. When at 

the Terminal, enter the following to ensure the Pi is up to date and 

running the latest versions of its software and system:

sudo apt-get update && sudo apt-get upgrade

STEP 8  If you haven’t used your Raspberry Pi since, at least, 

November 2018, then you may need to upgrade the 

core OS and synchronise the version of Raspbian with what’s currently 

available from the Pi Foundation’s downloads page. It’s not totally 

necessary, but if you choose to, enter:

sudo apt-get dist-upgrade 
Press Enter and follow the on-screen instructions.

STEP 10
At this point, it’s worth noting that in the UK it’s 

necessary to have a valid TV License in order to watch 

or record programmes as they are being shown on TV or live via an 

online service. It is an offence under Section 363 of the Communications 
Act 2003 to use a TV receiving device without a valid TV License. 

STEP 9
When the updates are complete, there’s a good 

chance you’ve got some leftover, older setup files and 
packages in the system. To save space, use the following commands:

sudo apt-get autoclean
and:

sudo apt-get autoremove  

Answer ‘Y’ to clear the system of the unnecessary packages and files.

Stream Digital TV with a HAT - Part 1
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STEP 1
To use the TV tuner, we need to install the TVheadend 

software. Open a Terminal session and enter 

the following:
sudo apt-get install tvheadend
Press Enter and ‘Y’ if necessary to confirm the installation. 

STEP 3
The remainder of the setup will now continue. It’ll take 

around three minutes to complete, depending on 

which model Raspberry Pi you’re using. When the setup has finished, 
you can exit the Terminal session. 

STEP 2
As the installation continues, you will be presented 

with a configuration screen. Enter a username and 
password to enable access to the TVheadend server. Once entered, 

make a note of the web address access for the server. When accessing 

on the TV Pi, it’ll be http://localhost:9981/. If accessing from another 

computer on the network, use the Pi’s IP address. For example: 

http://192.168.1.223:9981/.  

STEP 4
You can now either open the web browser on the Pi, if 

you’re connected to the TV through the Pi, or, if 

you’re connecting remotely, open any web browser on your computer 

with the address from Step 2. If you don’t know the Pi’s IP address 

enter:

ifconfig
in the Terminal on the Pi. The inet entry is the Pi’s IP address. Here, 

the example is: 192.168.1.238.  

In part 1 of this tutorial, we set up the Raspberry Pi and the TV HAT. The core Pi software and 
system should now be up to date and the TV Hat connected to an aerial. You should also ensure 
you have a valid UK TV Licence. 

TURN ON, TUNE IN
With the hardware ready, it’s now time to begin the TV tuning software installation and setup. If you haven’t already, reboot the Raspberry 
Pi and enter the Terminal for this next part.  

Stream Digital TV with a 
HAT - Part 2
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STEP 5  For this example, we will assume you’re connecting 

remotely (from another computer on the home 
network). Enter the Pi’s IP address with the port 9981, e.g.: 
http://192.168.1.238:9981/. To start the Configuration Wizard: enter 
the username and password you set up from Step 2 and log in to the 

TVheadend Server, then set the Language and Language 1 options to 

your preference. 

STEP 7
For the Network Settings page, leave the first three 
fields blank, but use the pull-down menu to select 

DVB-T Network. The TVheadend server will already have pre-selected 

the Sony CXD2880 tuner (the TV HAT) from its available choices. Click 
the Save & Next button when ready. 

STEP 6  Click the Save & Next button to continue. You will 

need to enable network access to the server. Leave 

the Allowed Network field blank, but add an asterisk (*) in each of the 
other fields. Click Save & Next for the next step in the setup process. 

STEP 8
For this next step you need to select the transmitter 

closest to your location. You can find the closest 
transmitter by entering your details at: http://www.digitaluk.co.uk/

coveragechecker/. Simply choose the transmitter from the pull-down 

list. When ready, click on the Save & Next button. The TV HAT will now 

scan for all available TV signals from the chosen transmitter. 

STEP 10
The TVheadend server webpage will now display the list 

of available channels. After picking one, either click the 

title of the programme showing to expand the details, then click the 

Play Programme button to view its content, or click the small TV icon in 

the details column of the channel. You can now watch live TV across 

your home network. 

STEP 9
On the next screen, tick all three of the available 

boxes. Click the Save & Next box followed by the 

Finish button on the next screen; It’s recommended that you now 

reboot the Pi and when it’s fully rebooted, navigate back to the 

TVheadend server webpage.

Stream Digital TV with a HAT - Part 2
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As you are now no doubt aware, the Raspberry Pi is certainly a versatile little piece of technology. 
Let’s look at some of the popular projects you can apply to your Pi, starting with one that’s not 
only the easiest, but also one of the best. 

COMPUTER PI

First and foremost, the Raspberry Pi is a computer. It has an 
operating system, built-in productivity apps, the ability to 
connect to both a home network and the Internet (either 
wirelessly or through Ethernet), and you can connect a mouse, 
keyboard, and monitor. It stands to reason, then, that it makes for 
a remarkably cheap desktop computer.

The obvious advantage of using the Raspberry Pi as a desktop 
computer though, is the fact that it’s so cheap. For around £100 
you could easily purchase the Pi, monitor, keyboard and mouse, 
providing you with a fully-functional computer capable of doing 
most, if not all, of the things you would do on a computer that 
costs ten times that amount. However, there are ways in which 
you can further enhance the desktop Pi project.

CASES

To begin with, you will need the Raspbian 

Stretch with desktop and recommended 

software OS version from the Raspberry 

Pi Foundation page, www.raspberrypi.org/

downloads/raspbian. Once you’ve installed 

that to your Pi, booted it, and logged in with a 

personal user account, you can then start looking 

at one of the many colourful, and functional, cases 

available for the Pi.

The Pi Hut offers a superb selection of cases for the 
various versions of the Raspberry Pi, for this project, we’d 

recommend the Raspberry Pi 3 Model B+, as it’s the fastest and 

most capable of the current models. For just £6, you can have a 

colourful – white and red – official Raspberry Pi case, with pre-
formed holes that line up perfectly with the ports on the Pi. For 

around ten pound more, there’s also the FLIRC case, an impressive 

design that’s finished in brushed aluminium. On the 
other hand, if you want something a little different 
from the norm, then how about a case that’s designed 

to look like a Nintendo Entertainment System, a SNES, 

or even a SEGA Megadrive?

Pi Projects: Desktop Pi

b0317180-1dbc-4fe7-b445-0fab5a6a6c7ab0317180-1dbc-4fe7-b445-0fab5a6a6c7a



135www.bdmpublications.com

Pi Projects: Desktop Pi

COOLING

Another thing to consider, if you’re going to be using your Pi as a 

desktop computer, is cooling. While the Pi’s low use of resources 

means that its internals don’t get too hot, prolonged and intense 

use may see your Pi getting a little warm, especially if it’s inside 

a case and the ambient temperature of the environment is also 

warm. There are options available to help cool your Pi down, chiefly 
the Raspberry Pi Heatsink. This is a high-quality aluminium 

heat dispersing element that fits on top of the Pi’s 
processor, leeching heat away from the vital circuit 

board and out into the surrounding air. However, 

bigger and more effective heatsinks are available, as 
well as fans, and even a water-cooling kit. These are a 

little extreme though, and only necessary if your Pi is doing 

some serious number crunching for an extended period of time.

PERIPHERALS

To cut down on the 

amount of cable 

clutter on your 

desktop, you could 

consider opting 

for a Bluetooth 

keyboard and mouse. 

The Pi 3 Model B+ offers Bluetooth 
connectivity alongside its Wi-Fi capabilities, 

so effectively you’re able to use any recently purchased 
Bluetooth keyboard and mouse kit available. The major advantage 

here is that the Pi can be mounted to the rear of your monitor and, 

together with connecting to your home network via Wi-Fi, the only 

cables involved would be the power and the HDMI cable to the 

monitor, both of which could be neatly tucked away.

DON’T THROW AWAY YOUR PC YET

While the Raspberry Pi is a great little desktop computer, it does 

have its limitations. If you’re accustomed to using a reasonably 

powerful Windows PC, or Mac, then you may find that, while being 
efficient, cheap and offering more space on your desk, the Pi does 
tend to struggle from time to time.

This is purely down to the fact that the Raspberry Pi isn’t the 

most powerful computing device available today. It won’t be able 

to handle the latest, triple-A games, intense graphics, Virtual 

Reality, or even some of the higher definition media content. You 
may find it stuttering when trying to playback fast moving 1080HD 
scenes, and true 4K playback isn’t an option. 

However, if you’re looking to substitute your day-to-day 

workstation with something cheaper and smaller, and you’re not 

going to push the Pi’s processor too much, then you’ll find the Pi to 
be a wonderful desktop computer. If you want more, though, hang 

on to that more powerful PC for the moment.

STORAGE

While the Raspberry Pi desktop project is a great idea, the sad 

fact of the matter is that the Pi doesn’t exactly offer the user a 
wealth of storage; compared to a Windows or Mac desktop, that is. 

Naturally, you can use a larger capacity SD card on which to install 

Raspbian, and utilise the remaining space as your Home folder, 

but again you’re limited. Thankfully, it’s not too much expense to 

include an external hard drive. A portable, USB connected, slimline 

2TB hard drive can cost in the region of £60 and give you as much 

storage capacity as one of the more traditional desktop computers. 

One thing worth noting with regards to using an external hard 

drive, make sure you always have a backup of what’s on there.

There are many options available to you if you decide to go 

down the Raspberry Pi desktop computer project route; there’s 

even a Pi laptop kit available called Pi-Top. Needless to say, with 

this amount of choice you’re able to customise your desktop and its 

setup in a more personal way than on a  Windows PC, or a Mac. 
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Those of you old enough to recall the golden era of the home computer, the 80s, will have fond 
memories of playing on a Commodore 64, ZX Spectrum, Amiga, Atari ST, and the countless 
wonderful arcade machines that consumed more than their fair share of our pocket money. Hold 
on, because you’re in luck.  

GOING RETRO

The Raspberry Pi makes for an amazing retro gaming 
computer. With it you’re able to emulate and play the classic 
home computers, consoles and arcade machines that brought 
us so much joy back in the day.

Thankfully, the processing power of most of the systems of 
the past is well within the capabilities of the Raspberry Pi’s 
processor. There are a few examples that don’t run too well, 
such as a PS2, or those systems that utilised a specialised 
3D component, but on the whole, there’s likely to be a fully 
working emulator, available for the Pi, that covers the home 
computer, console, or arcade that you remember playing.

RetroPie is the foremost retro gaming project available for the 

Raspberry Pi. It’s a set of modules that are built upon Raspbian, 

an older project called EmulationStation, and Linus distribution 

called RetroArch. It contains built-in emulation that covers dozens 

of systems, from an Amiga through to an Atari 2600, Amstrad 

CPC to SEGA Dreamcast, ZX Spectrum to an Apple II; and the 

list is continually growing thanks to the contributions from 

the community.
RetroPie can work as an installation on top of an existing 

operating system, such as Raspbian, or you can install RetroPie to 

an SD card and boot the Pi directly into it, choosing to add further 

software later if you want. Once installed, you’re able to connect 

USB controllers, or even a PS4 controller via Bluetooth, and if you’re 

feeling up to it, there’s also support for original controllers when 

connected to the Raspberry Pi’s GPIO pins.

If you don’t want to go down the RetroPie route and instead 

you only want one or two systems emulated, then Raspbian has a 

wealth of individual emulators available for you to install. You can 

search for the system via Google, 

or if you already know the name 

of it, simply install it to Raspbian 

through the Terminal. It’s worth 

mentioning that there will often be 

multiple emulators designed for the 

same system. While one may work 

perfectly with the vast majority 

of games, it may struggle with 

some of the better games 

available for that particular 

system. On the other 

Pi Projects: Retro Gaming
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hand, another emulator may play all the games for a system almost 

perfectly, with perhaps a loss of sound in some parts, or a slow 

down in others. It’s therefore up to you what you want. You can 

have multiple emulators installed for a single system and use them 

depending on which game you want to play, based on how well the 

emulator supports them, or you can find the single emulator that 
works reasonably well with everything. It’s trial and error, finding the 
perfect setup.

There are further options you can pursue when building a 

Raspberry Pi retro gaming system. You can encase your Pi inside 

one of the many retro-themed cases, such as the Mega-Pi SEGA 

Megadrive case, or you can build your Raspberry Pi into the Picade 

desktop arcade machine.

Picade is a great project, featuring authentic sticks and buttons, 

and an external speaker. There’s artwork available for the arcade 

cabinet setup, along with full instructions on how to set up the 

Pi and connect everything to the GPIO pins. The 8-inch display is 

perfect for old-school gaming, and you can improve on the visuals by 

adding extra stickers, a different acrylic marquee, and posters. This, 
combined with a RetroPie installation, is an 

excellent project idea that’ll 

keep you entertained 

for hours.

ABOUT ROMs

A ROM is the actual contents of a game, or the BIOS of an old 

system, be that a home computer or a console. These ROMs are 

often ripped from the original tape, cartridge, or chip, and are 

available to download from the Internet.

However, the use of ROMs is a continual legal headache. Most 

ROMs are illegal, meaning that they are available to download 

without the permission of the developer who 

created the game, the publishing house that 

released the game, and the company that owns 

the rights to the system on which the game is 

intended to be played. 

There’s a school of thought that if you 

own the original tape, cartridge and so on, 

of the game then you’re legally allowed to 

obtain a ROM of the same game and play it on 

an emulator, but that’s not always correct. In 

the example of music, it is technically illegal 

to copy music from a CD you own to playback 

on a media device; and in some ways the same 

applies to a ROM. 

There are however, some examples of a 

situation when a title, or a system, has fallen 

out of copyright, or has been abandoned. 

In these instances, it is perfectly legal for 

someone to generate a ROM from the game 

and distribute it on the Internet. Sometimes, 

another developer improves the original game, adding extra levels, 

effects, and so on. Some original developers of older games have 
allowed the use of their game to be distributed as a ROM, and 

therefore it is legal for you to download and play it.

In short, if you download a ROM from the Internet, and it 

doesn’t specify that it’s abandonware or allowed by the developer, 

publishing house, or company, then you’re doing so illegally. It’s 

highly unlikely that the police will drop in through your bedroom 

window and arrest you on the spot – unless you actively host 

illegal content on a website you own – so it’s purely down to your 

own conscious. 

Remember, even if the game is over thirty years old, 

somewhere out there is a developer who spent the time creating 

it, so by playing a pirated version of it - an illegal ROM, you’re taking 

something away from the individual or team that programmed the 

game in the first place.

LEGAL EMULATION

Interestingly, while it’s illegal to download most ROMs, it is not 

illegal to install and use an emulator. In fact there are emulators 

available for the PS4 that allow you play old SEGA Megadrive 

games, so while Sony, or whoever released the emulator for 

the PS4, have paid for the rights to use the ROMs in their 

emulator, it isn’t illegal for them to develop and use the SEGA 

Megadrive emulator.
In the same respect, it’s not illegal for you to download an 

emulator for any of the systems, you will just need to find legal 
ROMs to play on it.
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Of all the Raspberry Pi projects out there, turning the tiny computer into a powerful media 
centre is probably top of the list. And thanks to the Pi’s diminutive dimensions, and reasonable 
processing performance, it is wholly achievable. 

FILM NIGHT

First off, what is a media centre? Basically, a 
media centre, with regards to what we’re talking 
about here, is a computer that’s capable of 
playing, possibly recording, and even sorting a 
media collection made up of videos, music and 
images. It’s a home cinema system, connected to 
a TV that will stream media from online, or from 
a network attached storage device, or storage 
connected directly to the computer itself.

A media centre is often capable of sorting your 
collection of videos, music, and photos into 
a logical order, either by album, genre, year, 
alphabetically, or some custom setup. It can 
connect to the Internet and display information 
regarding the media, such as album cover, movie 
poster, location an image was taken, or even 
connect to an online database such as IMDB and 
provide further information. In short, it’s a one-
stop location for all your content.

KODI

Since the Pi’s first appearance, there has been some form 
of media centre software available for it. Back then, when it 

launched in 2012, the major player was XBMC, Xbox Media 

Centre, and was considered one of the best cross-platform 

media centre applications ever developed. By 2014, though, the 

team behind XBMC decided to change its name to Kodi. 

Kodi itself is an entertainment hub that collates and 

organises all your digital media into a single, user-friendly, and 

beautifully designed user interface. Thanks to its design, Kodi is 

capable of playing all types of music media and video media, as 

well as streaming TV shows (via online, or through a compatible 
TV tuner) and photos, plus you can record live TV through a 
PVR. It’s extraordinarily customisable, allowing you to install 

further add-ons that can connect to other online services like 

SoundCloud, YouTube and so on. 

Pi Projects: Media Centre
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INSTALLING KODI – OPTION 1

Should you want to install Kodi on your Raspberry Pi and use it as an 

all-powerful media centre, there are two options available to you. 

The first is to simply boot up Raspbian, drop into a Terminal session, 
perform an update and upgrade, then enter:

sudo apt-get install kodi

Once the setup is complete, you can start Kodi by entering: kodi, 

into the Terminal.

INSTALLING KODI – OPTION 2

The second option for installing Kodi on the Pi is to use one of the 

Kodi-optimised operating systems suitable for the Raspberry Pi. If 

you recall, from when you first installed Raspbian via NOOBS, there 
are several OS options available to you of which two are LibreELEC 

and OSMC. Both of these operating systems are especially 

designed to work better with Kodi than the fully installed version 

of Raspbian, due to being a more lightweight OS and less system 

resource heavy.

This option is often regarded as the preferred method of 

turning the Pi into a media centre, as both LibreELEC and OSMC are 

much faster operating systems, giving more of the Pi’s resources 

over to Kodi and allowing it to playback content without causing 

too many problems.

OTHER OPTIONS

Of course, you don’t necessarily need to go down the full media centre 

road to utilise the Pi as an excellent media playback device. As you have 

already noticed, the Raspberry Pi comes pre-installed with its own 

specialised version of VLC, a very capable media player. VLC on the Pi 

has been designed to make use of the Pi’s processing power, and has 

some hardware acceleration benefits coded directly into it, making it 
one of the best media players available.

All you need, therefore, is to have a software updated Pi with VLC, 

and access to wherever you’ve stored your media collection. While it 

may not be as graphically impressive as Kodi, you can still playback 

most, if not all, forms of digital media.

AUTO-START KODI

If you want to start Kodi as soon as your Raspberry Pi powers up, 

then you will need to alter one of the configuration files. While in 
the Terminal, after installing Kodi, enter:

sudo nano /etc/default/kodi

Look for the entry ENABLED, and change it to 1:

ENABLED=1

Press Ctrl+Z to save and exit Nano, then reboot your Pi with:

sudo reboot

Your Pi will now reboot and Kodi will start up once the main boot 

sequence has completed.

LIBREELEC VS. OSMC VS. RASPBIAN

Which OS to install? We could argue all day over the benefits, 
advantages, and disadvantages of each available operating system 

and you will probably still be as undecided as when we began. 

In truth, there is no perfect operating system, as each offers its 
own unique way of doing things. In the end, it simply comes down 

to which one do you prefer. Raspbian has everything, yet will be 

slower, LibreELEC and OSMC 

are faster, but aren’t as fully 

featured as Raspbian. What you 

need to do is experiment with 

all three, have a look around to 

see what else is available, and 

then decide on which works 

best for you and your particular 

goals with the Raspberry Pi.
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In a digital world, before the Internet was a common household name, there existed a connected 
community of surfers. These individuals didn’t surf the WWW, instead they dialled up Bulletin 
Board Systems (BBS) and opened a whole new world of content. 

WARGAMES

If you’re old enough to recall, or have since watched, the 
excellent movie Wargames, then you’ll be roughly familiar 
with the way in which a Bulletin Board System works; and if 
you haven’t watched Wargames, then we recommend you get 
hold of it.

In the movie, the young protagonist spends his days at the 
keyboard of his early 80s computer, using his modem to dial into 
remote systems. Once inside these remote systems, he then 
goes about traversing the remote host’s file system looking for 
anything interesting.

The movie plot aside, this, essentially, is how a BBS works. It’s a 
remote computer that runs specialist BBS server software with a 
mix of content either pre-installed, or added by the system admin 
(sysadmin or sysop). A user of the BBS can then dial, in the old 
modem sense, the BBS server’s phone number and gain access to 
the system with a valid username and password; or if they’re new, 
they have the option to create a new user.

These days, of course, the dial-up aspect has pretty much gone the 
way of the Dodo (although there are still some retro stalwarts who 
relish in the chronic noise of a dial-up connection), however, we 
can still enjoy the retro feeling of a traditional BBS using the legacy 
protocol, Telnet.

Pi Projects: BBS Client

WHY?
In a world of Internet snooping, a BBS is probably one of the last bastions of 

digital privacy; to some degree. A private BBS is somewhere you can connect with 

likeminded individuals, to chat, swap code, reminisce, play a text-based adventure, 

or simply just hang out. True, you can get hold of copyrighted or explicit content, 

but that’s only if you connect to those BBSes that serve such content, just as with 

the Internet.
Most BBSes follow a theme, whether that’s old DOS-based adventures, ZX 

Spectrum fans, Commodore 64 gamers, or even something non-techie related, such 

as a Ford Cortina owners club; no doubt swapping owner manuals, old photos of the 

Cortina E and such.

In truth, a modern BBS is a bit of fun. Connecting to a system someone has 

installed and built, set around a particular theme, and designed with fantastic looking 

ANSI graphics, is a great pastime. It’s a form of respect, in some ways, to acknowledge 

the work that’s gone into creating the BBS by connecting to it and you also get to 

learn a little more about how protocols work, and how everything is connected.
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HOW?
Connecting to a BBS via the Raspberry Pi is quite easy, but to get the 

most from it you will need to get your hands dirty in the Terminal.

As mentioned, we’re going to be using a form of the protocol 

Telnet, in this instance specifically the program SyncTERM, to 
emulate the old-style Terminals that support ANSI art and IBM fonts, 

while connecting to the remote BBS with the Telnet protocol. You 

can simply use telnet under the Terminal (once you’ve installed it), 
but you’ll miss some of the glorious artwork displayed within the 

majority of the BBSes.

To begin with, drop into a Terminal session on your Pi. When 

the Terminal is fired up, enter sudo apt-get update && sudo apt-
get upgrade to ensure your system is up to date. If everything 

is okay, enter: sudo apt-get install telnet. While this stage isn’t 

strictly necessary, it’s always a good idea to have the base protocol 

client installed.

When telnet is installed, you can then start the procedure of 

installing SyncTERM. In order to get SyncTERM working, you’ll need 

to build it from source. By now, you should be a dab hand at this, but 

here’s the process in case you’ve forgotten (along with some added 
elements to help everything go to plan).

Begin by changing directory to the Downloads folder and 

downloading the source code:  

cd Downloads\

wget http://syncterm.bbsdev.net/syncterm-src.tgz
ls 

With ls entered, you should see the newly downloaded tgz file. 
To unpack the downloaded file, enter: 

tar -xf syncterm-src.tgz 

This will create a new syncterm-(DATE) folder, where DATE is the 
current date when you’ve unpacked the contents of the tgz file.

You will now need to change directories to:  

cd syncterm-(DATE)
cd src

cd syncterm 

You can mesh these directories together, but, for the sake 

of keeping things simple, we’ll stick to one folder at a time. 

Also, remember you can hit the Tab key to auto-complete a 

directory name.

Once in the syncterm directory, you can begin to build from 

source. However, before you do that, it’s worth installing a couple 

of extras to ensure the BBS session works to perfection. Start by 

installing the following: 

sudo apt-get install libncurses5-dev
sudo apt-get install libsdl1.2-dev 

Once these two are installed, start the build process by entering: 

sudo make 

Followed by: 

sudo make install

The process may take a few minutes, so be patient. When 

everything is installed, you can enter the command: syncterm, 

to start the program and change the screen settings, if you wish. 

However, to get straight into connecting to a BBS, try one of 

these commands: 

syncterm dura-bbs.net: 6359

syncterm bbs.kernelerror.com: 10023

syncterm particlebbs.dyndns.org: 6400
syncterm heatwave.ddns.net: 9640

syncterm sysgod.org:23000 

Naturally, some, or even all, of these BBSes may be offline 
when you come to test them; they are, after all, being operated by 

individuals like you and I. If they are offline, you can always get hold 
of a comprehensive list of active servers by visiting https://www.

telnetbbsguide.com/bbs/list/brief/. 

GET CONNECTED

It’s worth spending some time finding the sort of BBS that suits your 
tastes. As you’ll see by visiting the aforementioned website, there’s 

over 500 BBSes currently listed, so somewhere in there a BBS could 

be your new online haunt.
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The Raspberry Pi has offered its userbase a superb platform to science. There are Raspberry Pi 
projects that involve the International Space Station, alongside NASA and ESA-led applications. 
However, it’s an Earth-based project that’s taken the community by storm. 

IT’S RAINING PI, HALLELUJAH!
Weather stations have been available to the project-
minded public since long before the Raspberry Pi entered 
the scene, but thanks to the Pi’s unique specifications, 
a new generation of weather station has emerged; and 
they’re really quite remarkable.

As with a lot of Raspberry Pi projects, the market has 
become flooded with various hardware, kits, and HATs 
that will enable you to set up a simple, or complex, 
weather station. The more experienced weather station 
and Raspberry Pi user will probably lean toward buying in 
the components individually, as opposed to an entire kit, 
but for the rest of us the kit-form versions are an excellent 
start to a project that can quickly grow over time.

Pi Projects: Weather Station

WHY?
With our smart devices connected to 

everything around us all the time, having 

a multi-limbed weather station, perched 

precariously on the end of the garden 

shed, measuring the amount of rainfall 

and in what direction the wind is blowing, 

may seem a little unnecessary; since 

your phone could tell you all that already 

with just a swipe or two. However, that 

discounts the pleasure of creating your 

own project and measuring the results as 

they change from one day to the next.

Any project, regardless of whether it’s on a Raspberry Pi or not, 

is something from which to learn. In the case of a Raspberry Pi driven 

weather station, the user can learn about all manner of electronics, 

connectivity, some simple engineering, and coding, even before we 

get onto the varying aspects of meteorology. 

The weather station project doesn’t necessarily need to be 

an all-powerful outdoor 

contraption either. Basically, 

there are two routes you 

can opt to take: the outdoor 

model, measuring wind speed/

direction, precipitation and so 

on, and an indoor model that 

measures ambient temperature, pressure and humidity. 

Why indoors? There are a number of reasons. Perhaps you’re in 

charge of a collection of servers, and while the company you work 

for may not be able to stretch to a fully sealed environment machine 

room, you could fill the gap with a great collection of sensors 
attached to a Raspberry Pi. You may have some from of allergy, 

where precise control of your indoor environment is important. 

Maybe you look after some exotic animals, in a room a where 

air pressure, humidity and such are vital to the creature’s health. 

Needless to say, there are plenty more examples.

In short, setting up a 

weather station is simply a 

fun project. Setting aside 

the things you’ll learn from 

getting one up and running, 

you’ll eventually have a 

physical piece of hardware 

that can, with moderate 

accuracy, measure your 

environment and display 

that data in a number of 

graphs and charts. It’s quite 

cool, when you stop to think 

about it. 
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Weather Station

WHERE NEXT?
As you can imagine, it’ll take some time to get everything together, program the components, and collate the data you want to view. Once all 

that’s gathered, though, what next?

There are some websites available that display localised weather from independent sources such as a back garden weather station, so when 

you’ve got everything up and running, try looking out for such projects and start collaborating. Also, consider creating a Twitter account for 

the Raspberry Pi weather station and Tweeting the local weather.

SOME OPTIONS?
To go into all the currently available Raspberry Pi weather station 

options will take more space than we’re currently able to offer 
here, but let’s have a quick look at some of the best selling kits 

and components.

Pimoroni Enviro Phat – The 

Enviro pHAT is an add-on sensor 

for the Raspberry Pi that includes 

four different sensors to monitor 
temperature, pressure, light 

levels, and motion. It’s ideal for 

indoor environment monitoring 

and, thanks to some nifty Python 

libraries and code, you’re able to display the data via a web page 

and view the variables remotely.

Velleman WS3080 Weather Station – The 

Velleman WS3080 Weather Station is one 

of the higher-end products that can interact 

with the Raspberry Pi. This outdoor mounted 

station is capable of monitoring rainfall, 

wind speed and wind direction, air pressure, 

wind chill temperatures, air temperature, 

and UV light levels. It features alarms for 

temperature, humidity, wind chill, dew point, 

wind speed, air pressure and storms, and 

comes with a separate LCD transmitter.

Cyntech WeatherHAT – The 

WeatherHAT from Cyntech can turn 

the Raspberry Pi into a weather 

display station. While not obtaining 

data directly from an external 

source (instead using one of the 
many localised, weather monitoring 

stations), it does offer seven RGB LEDs to highlight the current 
and upcoming weather. Controlled via Python, the HAT can help 

provide a good coding base for future weather station projects.

WeeWX – When you collect the 

necessary hardware together (the 
various sensors you’ll need and so 

on), you’ll need a good piece of 
software to help collate all that data 

and display it in a readable fashion; 

this is where WeeWX comes in. 

WeeWX is a Python-based program 

that can interact with many different weather stations to produce 
graphs and reports, and even publish the data to HTML on a web site. 

Weather Meter Kit – For outdoor 

weather monitoring, we have the 

Weather Meter Kit as sold by CPC for 

around £77. The kit comprises of three 

main component sensors that measure 

wind speed, wind direction, and rainfall. 

The rain gauge is a self-emptying bucket 

that’s capable of activating for each 

0.011-inch of rainfall collected, while the 

anemometer activates a closure switch 

every 1.492mph once per second. The 

wind direction module can display up to 

sixteen different positions, and the kit 
comes complete with full assembly instructions.
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1 flash:  Possibly you have a RPi from Micron. 
Take a good look at the processor if it 
says M with an orbit round it. Using the 
latest software will solve your problem; 
also make sure you have a 4Gb SD card, 
as a 2Gb doesn’t work.

2 flashes:  The SD Card cannot be read. A solution 
could be to forma the card and flash 
Raspbian with Pi Installer from Terminal.

3 flashes:  Start.elf not found.

4 flashes:  Start.elf not launched.

7 flashes:  Kernel.img not found.

8 flashes:  SDRAM not recognised. You need newer 
bootcode.bin/start.elf firmware.

GREEN LED BLINKS IN A SPECIFIC PATTERN

Common Raspberry Pi 
Problems
The Raspberry Pi hardware and software is pretty reliable and problems are more often due 
to set up errors rather than anything to do with the hardware. However, there are times when 
hardware can seem to be at fault, so here are a few of the more common issues you might 
encounter when using your Raspberry Pi.

COLOURED SPLASH SCREEN With the current 

firmware, a 
coloured splash screen is displayed after GPU firmware (start.
elf) is loaded. This should be replaced by Linux console a 
second later. However if the coloured screen remains, it 

suggests the kernel.img file is failing to boot. Try replacing it 
with a known good one.

Immediately after displaying the splash screen, the Pi starts 

consuming a little more current. If the Pi resets at that 

moment, it is an indication that the power supply isn’t able 

to deliver the full current that your Pi requires but dips its 

output voltage below a minimum when loaded with the full 

current the Pi needs.

RED POWER LED IS BLINKING A blinking red power LED indicates 

problems with the power supply. 

On model A and B, it is hard-wired to the 3.3V power supply rail. If it is blinking, 

it means the 5V power supply is dropping out. Use a different power supply. 
On the model B+ and also the A+, the circuit has been improved to give a much 

more reliable warning of poor power quality. The red power LED is wired to an 

APX803 supervisor which kicks in when the 5V power supply drops below 

4.63V. If it does, the LED will blink. Check your connections, cable and 

power supply.

TROUBLESHOOTING YOUR RPI

The Raspberry Pi is a surprisingly stable bit of kit, but there is always the chance of encountering problems. If you’re really stuck there are 
apps available which can help diagnose problems on the RPi.
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If you have problems, check you have the latest firmware version 
first. If that is not the problem, try the following. 

• Some SD cards do not work on the Pi, so check the list of known 
SD cards on the official Pi website.

• If you are having problems setting up your SD card you might 
want to start by erasing it completely, especially if it has been 
used elsewhere and still contains data or partitions.

• Windows and Mac users can download a formatting tool from 
the SD Association: https://www.sdcard.org/downloads/
formatter_3/

• Reformatting cards is also easy to do in a digital camera.

• After writing the image to the SD card, verify that you can see the 
boot partition when you insert the SD card into your computer. 
The partition should contain a number of files, including start.elf 
and kernel.img. If you do not see these files on the SD card, you 
have made an error writing the image file.

• If you are manually preparing your SD card on Linux or macOS 
using the dd command, this operation will completely erase any 
existing data and partitions. Make sure you write to the whole 
card (e.g. /dev/sdd) and not to an existing partition (e.g. /dev/
sdd1).

• If you put the SD card into your PC in an attempt to write the Pi 
operating system onto it and the PC tells you the card is write-
protected, even with the write-protect tab in the correct forward 
position you may have a faulty SD-card rewriter.

NO USB DEVICE WORKS

SD CARD PROBLEMS

Common Raspberry Pi Problems

RASPBERRY PI NOT RESPONDING TO KEY PRESSES
This is most often caused by inadequate power. Use a good power 

supply and a good power cable. Some cheap cables that work with a 

mobile phone, cannot fully power the Pi. Some USB devices require a 

lot of power; most will have a label showing 

the voltage and mA requirements. 

Each one should be 5v 100mA max. 

Any more than this and they must 

be used with a powered USB hub. 

Try unplugging every USB device 

except the keyboard. You should 

also note that some keyboards 

have built in hubs and can try to 

draw 150mA; Pi can only handle 

100mA per USB slot without a 

hub. Use the latest software too. 

KEYBOARD OR MOUSE INTERFERES 
WITH A USB WI-FI DEVICE

Connecting a 

keyboard 

and or 

mouse while a USB Wi-Fi device is connected, may cause 

one or both devices to malfunction. Tests point to 

interferences in the 2.4 GHz frequency band in 

which both Wi-Fi sticks, as well as USB 

keyboards transmit data. Changing 

the channel on the wireless 

access point should fix the 
problem completely. 

The most common cause of USB devices working is low power 

supply voltage from a bad PSU, cable or USB hub; but it could 

also be that no clock signal is present. Return the board for a 

replacement if you think this is the case but before coming to this 

conclusion, confirm known good peripherals. A significant number 
of USB keyboards are not compatible with Raspberry so make sure 

you are using one made for Pi. 
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